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INTRODUCTION

CONGRATULATIONS! By picking up this book you have made the first step in your voyage toward
learning Java. Java is a programming language with a long history, starting with its inception in
1991, when it was still named “Oak,” through the first public release (Java 1.0) in 1995 and the
newly released Java 8. Its “write once, run anywhere” approach, together with robust language fea-
tures and numerous libraries led to a spectacular adoption rate. Java is one of the most popular lan-
guages in use today, and has been especially successful in enterprise and business environments.

Note, however, that Java is not without its criticism (no programming language is). You might have
picked upon the often-repeated criticism that Java is verbose, unsecure, suffering from a slow release
cycle, and that it is fading in popularity compared to the interest in new, more exciting languages
(Ruby, Erlang, and Haskell, to name a few) by the computer science and programmer communities.
The reality, however, tells a different story. Java remains widely taught in schools and universities
and is regarded as the language of choice in many organizations. The introduction of Java 7 in 2011
made many tasks simpler, and the availability of many seasoned and stable libraries, tools, and
feature-complete IDEs is unmatched by the ecosystem found around other languages. In 2014, Java
8 introduced lambda expressions to streamline code and a reengineered date and time interface that
simplifies and improves the internationalization of applications. Java’s strong architectural founda-
tions make the language ideally suited for both newcomers and experienced programmers who want
to expand their knowledge of Object-Oriented Programming.

Before reaching the end of this book, you will agree that being proficient in Java is a strong skill to
possess indeed. We aim to get you started and up to speed as quickly as possible, without making
sacrifices in terms of depth and breadth of topics. The goal is not to guide you in simply adding
yet another (or first) language to your repertoire, but also to familiarize you with Java’s underlying
approach toward robust and structured Object-Oriented Programming. As you will see, Java’s
“verbosity” makes it ideally suited to teach programming best practices in an explicit manner.
Providing step-by-step explanations together with many examples—inspired by real-life environ-
ments rather than toy exercises—will help you quickly appreciate Java’s design and usefulness, and
learn that programming in Java can even be great fun!

WHO THIS BOOK IS FOR

Java is a great language to learn for both new and experienced programmers. As such, this book
is geared towards a broad audience, including practitioners, analysts, programmers, and students
wanting to apply Java in a pragmatic context. It doesn’t matter whether you are new to program-
ming and have chosen Java as a place to start or whether you come in from another programming
language; Java is a great choice. Many books exist on the topic of Java (just look at the shelf where
you found this book!), but we feel that existing offerings reuse the same approach to demonstrate
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concepts. Therefore, you will not find the archetypical (and honestly, completely useless) “Hello
World” example in this book. Instead, we delve into concrete, thought-out examples that illustrate
how Java can be useful and used in real life. Whether you are an analyst struggling with spreadsheet
formulas to perform a somewhat advanced calculation (there has to be a smarter way, right?), a stu-
dent wondering how your future employer is using Java, or a hobbyist programmer trying to keep
track of stock quotes or a book database, this book aims to familiarize you with all the necessary
concepts.

TOPICS COVERED IN THIS BOOK

The topics discussed in this book can, broadly speaking, be outlined in the following three
categories. First is a general introduction to programming and Java. The first chapters briefly
discuss programming in general, before moving on to a high-level description of Java’s history and
language features. We also make sure to set up everything you need to get started with Java.

The second part deals with Object-Oriented Programming in Java. The goal is to help readers acquire a
strong knowledge of how Object-Oriented Programming works and how Java programs are structured.

The third part is more focused and practical, and shows how you can leverage Java to talk to data
sources (such as files, databases, and even web services) and how you can create a graphical user
interface around your program logic.

Note that we have not structured the book around the aforementioned three parts. Instead of split-
ting the book into “theoretical” and “practical” parts, we chose to introduce new concepts step-by-
step as they are needed so that you can quickly move on to examples and exercises. The best way to
learn is by doing, and this saying particularly holds true when learning to program.

In Chapter 1, we provide a brief general introduction to programming geared toward newcomers
and novice programmers. In Chapter 2, we start introducing Java by providing an overview of the
language’s history, the different technological components that make up the language, the general
language structure, and data types. At that point, you will know enough to get started, so that in
Chapter 3, we will guide you toward setting up your development environment and trying out some
basic examples and exercises. In Chapter 4, we introduce Object-Oriented Programming basics;
flow-control statements are covered in Chapter 5. At that point, you will be able to create simple
but functional programs. Chapter 6 explains how to catch errors and debug your programs, which
will come in handy as you start using resources and coding more advanced programs. At this point,
you will have all the necessary components to start looking at some more advanced Object-Oriented
Programming concepts in Chapter 7. After this, you’ll be ready to tackle more complex interactions
with files, external sources, and users. In Chapter 8 you will look at dealing with file-based input
and output, including how to load files, perform basic operations, and save the results back to disk.
Chapters 9 and 10 build on this by explaining how to interact with databases and web sources. At
this point, you will be itching to move away from command-line based applications, and Chapter
11 explains in-depth how to build graphical user interfaces. Chapter 12 concludes the theory by
providing an overview of some common architectural patterns (best practices, if you will) used by
seasoned Java developers.

xXiii
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By the end of this book, you will have gained a strong knowledge of Java’s internals, you will know
what is meant by Object-Oriented Programming, know how to debug and deal with errors in your pro-
grams, know how to handle file-based input and output, talk to databases, talk to web services, make
a full-fledged graphical application, and be familiar with some common and well-known programming
“patterns,” which are best practices to structure and organize a program’s architectural setup.

TOPICS NOT COVERED IN THIS BOOK

This book is not a reference manual. The goal is to get readers acquainted with the basics of Java
and Object-Oriented Programming to use within practical applications, not to provide a full over-
view of Java’s API. As such, given the scope of this book, there are some concepts that are not dis-
cussed in detail. However, we have taken care to avoid elements you can live without at this point in
your Java career.

Working with generics in Java, for example, is not discussed explicitly, but instead explained briefly
where needed (when we talk about collections in Java, such as lists or sets, for example). Working
with generic classes can be daunting for novice Java programmers, and the Object-Oriented
Programming concepts discussed suffice to cover the multitude of use cases. That said, familiarizing
yourself with generic types after going through this book should not prove difficult.

Other topics that are not discussed in-depth include networking in Java (socket programming), multi-
threaded and concurrent programming, reflection, and the lambda expressions introduced with Java
8. Networking aspects, however, are dealt with from a “higher-level” view. We discuss how to interact
with web services, which provides a great starting point for practitioners to load data coming from
the web. Concurrent, multi-threaded programming is a beneficial practice when performance and
speed becomes an issue in applications, but for most use cases in a practical context, Java performs
just fine without having to deal with multi-threading. Additionally, programming in a concurrent
fashion introduces some particular challenges and “gotchas” that are unfit for beginning Java pro-
grammers to deal with. Reflection is a part of the Java API that allows programmers to examine and
“reflect” on Java programs while they are running and perform changes to programs while they are
being executed. While very helpful in some cases, it also is out of scope for a beginner’s book on Java.
Finally, the recently released Java 8 introduces some new concepts, most notably lambda expressions.
Java 7 also provides functionality to work with so-called “anonymous classes,” which are ad hoc
implementations of a base class without a specific name or definition. Other than the fact that these
classes can appear somewhat verbose, they are perfectly fine to use instead of lambda expressions
(which provide the same functionality in a more concise manner) and are still widely used. We do,
however, provide short notes on developments within Java 8 whenever appropriate.

Finally, Java is composed of a certain number of “technologies” (also called platform compo-

nents). The “standard” Java is denoted as “Standard Edition” (SE), and is the one we tackle here.

An Enterprise Edition (EE) also exists, as well as a number of extensions to develop embedded and
mobile applications (Embedded Java and Java ME), applications for smart TVs (Java TV), and
graphic-intensive applications (Java FX and Java 2D). We do not discuss these extensions in this book,
as they have no place in a beginner’s book on Java. Readers wanting to apply Java in these specific
areas should, however, be ready to move on to these more focused topics after reading this book.

XXiv
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CONVENTIONS

This book applies a number of styles and layout conventions to differentiate between the different
types of information.

What Are They?

This book comes with many code examples and exercises that introduce and explain new concepts
step-by-step. These are called “Try It Outs” and can be executed directly while reading the chapters or
revisited at a later time. Each Try It Out is followed by a How It Works, which is designed to help you
understand exactly what’s happening in the Try It Out exercise.

In addition to providing extensive examples in the form of Try It Outs, you will also encounter frequent
tips, hints, advice, and background information, which are formatted like this:

NOTE Tips, hints, advice, and background information are formatted like this.
Reading these segments can help to make concepts clearer. You may also
notice a Warning or Common Mistakes heading on these boxes to bring your
attention to particular things you should avoid.

Discussions that extend beyond a short tip or note will look a little bit different.

SIDEBAR

We use this format to explain concepts that require more than a simple note.
The details are not necessary to the understanding of the book but offer a more
complete discussion on a particular topic.

Finally, program code within this book is formatted in two ways. The first way is as code type:
(/* Like this comment */). Variables (like iamAvariable) appear in italic code type.

Larger code blocks look like the following:

public class NoHelloWorld {
public static void main(String[] args)
System.out.println("This is not an Hello World program...");
}

NOTE Eclipse is the Integrated Development Environment (IDE) we will be
using throughout this book. Don’t worry what this means for now. Everything
you need to set up in order to follow along is explained in Chapter 3.

XXV
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All these styles are designed to make sure it’s easy for you to know what you’re looking at while you
read.

SOURCE CODE

As you work through the examples in this book, you may choose either to type in all the code
manually or to use the source-code files that accompany the book. All of the source code used in
this book is available for download at www.wrox.com. Once at the site, simply locate the book’s title
(either by using the Search box or by using one of the title lists) and click the Download Code link
on the book’s detail page to obtain all the source code for the book.

NOTE Because many books have similar titles, you may find it easiest to
search by ISBN; this book’s ISBN is 978-1-118-73949-5.

Once you download the code, just decompress it with your favorite compression tool. Alternately,
you can go to the main Wrox code download page at www.wrox.com/dynamic/books/download
.aspx to see the code available for this book and all other Wrox books.

ERRATA

We make every effort to ensure that there are no errors in the text or in the code. However, no one
is perfect, and mistakes do occur. If you find an error in one of our books, like a spelling mistake
or faulty piece of code, we would be very grateful for your feedback. By sending in errata, you may
save another reader hours of frustration, and at the same time you will be helping us provide even
higher-quality information.

To find the errata page for this book, go to www.wrox.com and locate the title using the Search box
or one of the title lists. Then, on the book details page, click the Book Errata link. On this page you
can view all errata that have been submitted for this book and posted by Wrox editors. A complete
book list, including links to each book’s errata, is also available at www.wrox.com/misc-pages/
booklist.shtml.

If you don’t spot “your” error on the Book Errata page, go to www.wrox.com/contact/
techsupport . shtml and complete the form there to send us the error you have found. We’ll check
the information and, if appropriate, post a message to the book’s errata page and fix the problem in
subsequent editions of the book.

P2P.WROX.COM

For author and peer discussion, join the P2P forums at p2p . wrox.com. The forums are a web-based
system on which you can post messages relating to Wrox books and related technologies and inter-
act with other readers and technology users. The forums offer a subscription feature to e-mail you
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topics of interest of your choosing when new posts are made to the forums. Wrox authors, editors,
other industry experts, and your fellow readers are present on these forums.

At http://p2p.wrox.com you will find a number of different forums that will help you not only as
you read this book, but also as you develop your own applications. To join the forums, just follow
these steps:

1. Go to p2p.wrox.com and click the Register link.
2. Read the terms of use and click Agree.

3.  Complete the required information to join as well as any optional information you wish to
provide, and click Submit.

4.  You will receive an e-mail with information describing how to verify your account and
complete the joining process.

NOTE You can read messages in the forums without joining P2P, but in order
to post your own messages, you must join.

Once you join, you can post new messages and respond to messages other users post. You can read
messages at any time on the Web. If you would like to have new messages from a particular forum
e-mailed to you, click the Subscribe to this Forum icon by the forum name in the forum listing.

For more information about how to use the Wrox P2P, be sure to read the P2P FAQs for answers to
questions about how the forum software works, as well as many common questions specific to P2P
and Wrox books. To read the FAQs, click the FAQ link on any P2P page.

HOW TO READ THIS BOOK

This book is mostly designed as a hands-on tutorial and tries to keep you practicing and trying
out new concepts as quickly and often as possible. As mentioned before, you will find Try It Outs
throughout this book where you will find step-by-step instructions for working with Java.

You will notice that we alternate between chapters that are more theoretical in nature (such as
what Object-Oriented Programming is) and chapters that are more practical (such as how to

read in a file and do something with it). As such, the preferred way to go through this book when
you’re reading it the first time is to work your way from beginning to end. Think of this book as

a tour through Java. We do not visit every nook and cranny—you don’t need to examine each and
every small detail—but you do want to get the big picture, enabling you to get proficient with Java
as quickly as possible without taking dangerous shortcuts by explaining concepts in a haphazardly
manner. Whenever you encounter a practical chapter that seems less useful, however, you are

free to skip it and return to it later. That said, we have clearly separated the chapters to match a
specific set of topics, so readers revisiting this book will have no trouble immediately navigating
to the right spot.
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Given the nature of programming, it is unavoidable that you will run across some examples in
earlier chapters that includes a concept that will be explained in a later section. We always indicate
these forward references in a clear manner and tell you “not to worry about this until Chapter X.”
Trust us on this; these elements will be covered later.

As you proceed, remember the best way to learn is to try out things on your own, extend projects,
and create new ones. The Try It Out exercises provide examples throughout the text for you to
start programming with a lot of guidance. As your knowledge and confidence build, try creating
your own simple programs to complete tasks that are interesting for you. This way, you will put the
concepts you’ve learned to use and start to see how Java can work for you.

GET IN TOUCH

We have tried to make this book as complete, accurate, and enjoyable as possible. Of course, what
really matters is what you, as the reader, think of it. Please let us know your views by getting in
touch. The authors welcome all feedback and comments.

Bart Baesens
Aimée Backiel
Seppe vanden Broucke

January, 2015
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A General Introduction to
Programming

WHAT YOU WILL LEARN IN THIS CHAPTER:

> The key steps in a programming process

The different types of programming errors

>

> The key principles of software testing

> The different types of software maintenance
>

The key principles of structured programming

WROX.COM CODE DOWNLOADS FOR THIS CHAPTER

The wrox.com code downloads for this chapter are found at www.wrox.com/go/
beginningjavaprogramming on the Download Code tab. The code is in the Chapter 1
download and individually named according to the names throughout the chapter.

Developing good and correct software is a very important challenge in today’s business
environment. Given the ubiquity and pervasiveness of software programs into our daily
lives, the impact of faulty software is now bigger than ever. Software errors have caused
flight crashes, rocket launch errors, and power blackouts, to name a few examples. Hence,

it is important to design high-quality, error-free software programs. This chapter covers the
fundamental concepts of programming. First, it elaborates on the programming process. The
next section provides a sneak preview of object-oriented programming. This is followed by a
short discussion on programming errors. The basic principles of software testing and software
maintenance are also discussed. The chapter concludes by giving some recommendations
relating to structured programming. You will revisit many of these ideas in future chapters,
with a more hands-on approach.
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THE PROGRAMMING PROCESS

A program (also referred to as an application) is a set of instructions targeted to solve a particular
problem that can be unambiguously understood by a computer. To this end, the computer will
translate the program to the language it understands, which is machine language consisting

of 0s and 1s. Computers execute a program literally as it was programmed, nothing more and
nothing less. Programming is the activity of writing or coding a program in a particular pro-
gramming language. This is a language that has strict grammar and syntax rules, symbols, and
special keywords. People who write programs are commonly referred to as programmers or
application developers. The term software then refers to a set of programs within a particular
business context.

An example of a programming exercise is a program that calculates the body mass index (BMI) of

a person. The BMI is calculated by dividing a person’s weight in kilograms by the square of his or

her height in meters. A person is con-

sidered overweight if his or her BMI

is over 25. A BMI calculator program

then requires the weight and height as Height

inputs and calculates the associated \

BMI as the output. This is illustrated in

Figure 1-1. This BMI example is used _ /
Weight

to demonstrate the steps in the software
development cycle. FIGURE 1-1

Inputs Output

PROGRAM ——» BMI

Programs are typically written using a
step-by-step approach, as follows:

1. Requirements gathering and analysis

Program design

3. Program coding
4. Translation to machine language
5.

Testing and debugging
Requirements
6. Deployment P
7. Maintenance
. . . . Maintenance
Because our environment is continuously evolving,

software, too, is often continually reviewed and

adapted. Therefore, these steps are often represented x
as a cycle, as shown in Figure 1-2, rather than as a Deployment Coding
ladder.

The first step is to make sure you understand the problem

in sufficient detail. This means analyzing the problem

statement carefully so you fully grasp all the require- Testing | g | Translation
ments that need to be fulfilled by the software program.

This may involve Q&A sessions, interviews, and surveys  FIGURE 1-2
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with business experts who have the necessary subject matter expertise. Even if you are programming
for yourself, taking the time upfront to consider all the demands you want your program to meet will
limit the amount of changes required later in the process. At the end of this step, it is important to know
what the input to the program will receive and what output it should give. In the BMI example, you will
need to know whether the height will be measured in meters or feet and the weight in kilos or pounds.
You would also want to determine whether the output should be just the BMI results or also a message
stating whether or not the person is overweight.

Once you have a thorough understanding of the business problem, you can start thinking about
ways to solve it using a computer program. In other words, which processing steps should take
place on the input(s) in order to give the desired output(s)? The procedure needed to solve the
problem is also often referred to as the algorithm. When working out an algorithm, common sense
and creativity both play an important role. A first useful step in designing an algorithm is plan-
ning the application logic using pseudo-code or flowcharts. Pseudo-code is a type of structured
English but without strict grammar rules. It is a user-friendly way of representing application
logic in a sequential, readable format. It allows the problem statement to be broken into manage-
able pieces in order to reduce its complexity. Following is an example of pseudo-code for the BMI
case. A flowchart represents the application in a diagram, whereby the boxes show the activities
and the arrows the sequences between them. Table 1-1 presents an overview of the most important
flowchart construction concepts. Figure 1-3 then gives an example of a flowchart for the BMI case.
Both pseudo-code and flowcharts can be used concurrently to facilitate the programming exercise.
A key advantage of flowcharts when compared to pseudo-code is that they are visual and thus
easier to interpret.

ask user: height

ask user: weight

if height = 0 or weight = 0:

error: "Incorrect input values"

return to beginning (ask height and weight)
end if

x = weight / (height * height)

message: "Your BMI is ",x

Table 1-1 is an overview of the most important flowchart modeling concepts.

TABLE 1-1: Key Flowchart Modeling Concepts
FLOWCHART SYMBOL MEANING

A terminator shows the start and stopping points of
the program.

v

An arrow shows the direction of the process flow.

A rectangle represents a process step or activity.

continues
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TABLE 1-1: (continued)
FLOWCHART SYMBOL MEANING

A diamond indicates a decision point in the process.

|\j| This symbol represents a document or report.

This rhombus represents data used as inputs/outputs
to/from a process.

This cylinder represents a database.

A next step is to code the program in a particular programming language. The choice of the lan-
guage will depend on the programming paradigm and the platform adopted (such as hardware,
operating system, or network).

Once the source code of the program has been written, it will be given to a translator to translate it
to machine language (0s and 1s) so that it can be executed and solve the business problem.

Ask user height |

Display error
message

A

A

Compute Display
BMI BMI Stop

During application development, it is important that every program is intensively tested to avoid any
errors. Often, in programming, errors are called bugs. Various types of errors exist and an entire
chapter is devoted to this topic. Programming tools frequently have debugging facilities built in to

FIGURE 1-3
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easily track bugs down and correct them. It is possible to debug your program without the use of
such tools, but in either case, you should follow a structured and systematic review to be sure you’ve
identified any bugs before your program is deployed.

Once a program has been thoroughly tested, it can be deployed. This means that the program will
be brought into production and actively used to solve the business problem. Remember, users of
your software don’t usually understand as much about programming as you. Try to keep them in
mind throughout the process to make this deployment step as seamless as possible.

Finally, programs should be maintained on an ongoing basis. There are many reasons for regular
maintenance, namely correcting newly discovered bugs, accommodating changing user needs, pre-
venting erroneous user input, or adding new features to existing programs.

It is important to note that programming is not a strict, sequential, step-by-step process. Quite to
the contrary, it often occurs as an iterative process, whereby the original business problem is refined
or even reformulated during the coding process.

OBJECT-ORIENTED PROGRAMMING: A SNEAK PREVIEW

In object-oriented (OO) programming, an application consists of a series of objects that ask services
from each other. Each object is an instance of a class that contains a blueprint description of all the
object’s characteristics. Contrary to procedural programming, an object bundles both its data (which
determines its state) and its procedures (which determines its behavior) in a coherent way. An example
of this could be a student object having data elements such as ID, name, date of birth, email address,
and so on, and procedures such as registerForCourse, isPassed, and so on. A key difference
between OO and procedural programming is that OO uses local data stored in objects, whereas pro-
cedural programming uses global shared data that the various procedures can access directly. This has
substantial implications from a maintenance viewpoint. Imagine that you want to change a particular
data element (rename it or remove it). In a procedural programming environment, you would have

to look up all procedures that make use of the data element and adapt them accordingly. For huge
programs, this can be a very tedious maintenance exercise. When you’re using an OO programming
paradigm, you only need to change the data element in the object’s definition and the other objects can
keep on interacting with it like they did before, minimizing the maintenance.

OO programming is the most popular programming paradigm currently in use. Some examples of
object-oriented programming languages are Eiffel, Smalltalk, C++, and Java.

The following code example demonstrates how to implement the BMI example in Java. Contrary to
the procedural programming example, it can be clearly seen that the data (weight, height, and
BMI) is bundled together with the procedures (BMICalculator, calculate, and isOverweight)
into one coherent class definition.

public class BMICalculator {
private double weight, height, BMI;

public BMICalculator( double weight, double height ) {
this.weight = weight;
this.height = height;

}
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public void calculate() {
BMI = weight / (height*height) ;

}

public boolean isOverweight () {
return (BMI > 25);

}
}

PROGRAMMING ERRORS

A programming error is also referred to as a bug, and the procedure for removing programming
errors is called debugging. Debugging usually has the following three steps:

1. Detect that there is an error.

2.  Locate the error. This can be quite time consuming for big programs.

3. Solve the error.

Different types of programming errors exist and are explored in the following sections.

Syntax/Compilation Errors

A syntax or compilation error refers to a grammatical mistake in the program. Examples are a
punctuation error or misspelling of a keyword. These types of errors are typically caught by the
compiler or interpreter, which will generate an error message. Consider the following Java example:

public void calculate() {
BMI = weight / (height*height),

}

The statement that calculates the BMI should end with a semicolon (;) instead of a comma (, ),
according to the Java syntax rules. Hence, a syntax error will be generated and displayed. Syntax
errors are usually easy to detect and solve.

Runtime Errors

A runtime error is an error that occurs during the execution of the program. Consider the following
piece of Java code to calculate the BMI:

public void calculate() {
BMI = weight / (height*height);

}

If the user enters a value of 0 for height, a division by zero occurs. This creates a runtime error
and will likely crash during execution. Another example of a runtime error is an infinite loop into
which the program enters at execution. During the design of the program, it is important to think
about possible runtime errors that might occur due to bad user input, which is where the majority
of bugs will originate. These errors should be anticipated as much as possible using appropriate
error-handling routines, as we will discuss later.
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Logic/Semantic Errors

Logic or semantic errors are the hardest to detect since the program will give an output and not
generate an error. However, the output that is given is incorrect due to a formula being incorrectly
programmed. Consider the BMI example again:

public void calculate () {
BMI = (weight*weight) / height;

}

This routine is clearly erroneous since it calculates the BMI as (weight*weight)/height instead of
weight/(height*height). These errors cannot be detected by compilers or interpreters.

PRINCIPLES OF SOFTWARE TESTING

In order to avoid software errors (and their impact), a program should be thoroughly tested for

any remaining errors before it is brought into production. The main purpose of testing is verifica-
tion and validation of the software build. Verification aims at answering the question as to whether
the system was built correctly, whereas validation tries to determine whether the right system was
built. The quicker an error is found during development, the cheaper it is to correct it. As illustrated
in Figure 1-4, the cost of testing typically increases exponentially, whereas the cost of missed bugs
decreases exponentially with the amount of testing conducted. The optimum testing resources can
then be found where both curves intersect.

Cost of missed
bugs

Cost of testing

Undertesting Overtesting

v

Optimum Amount of testing

FIGURE 1-4

A first basic way of testing is to desk-check the program by using paper and pencil. The manual
calculations and output can then be contrasted with the program calculations and output. It is
especially important to consider extreme cases and see how the program behaves. Of course, this
only works for small-scale programs; more sophisticated procedures might be needed for bigger
programs.
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Static testing procedures test the program not by executing it, but by inspecting and reviewing the
code and performing detailed walk-throughs. It is aimed at verification. On the other hand, dynamic
testing procedures test the program by executing it with carefully selected test cases. It is thus more
related to validation. The test cases can be chosen according to a white box or black box strategy.
In white box testing, they are selected by thorough inspection of the source code of the program;
for example, by making sure all the branches in an if-then-else selection are covered, boundary
conditions for loops are verified, and so on. One popular approach is to intentionally inject faults
in the source code, which then need to be tracked down in a follow-up step. Black box testing con-
siders the program as a black box and does not inspect its internal source code. One example is a
procedure that tries to test all possible input parameter combinations. It is especially important to
also test what happens when impossible values are entered (such as a negative value for weight and
height, value of 0 for height, missing value for gender, and so on). Obviously, this becomes compu-
tationally infeasible in case many inputs are present and intelligent sampling procedures could be
adopted to test as many useful input combinations as possible.

Software development typically has two phases of testing. Alpha testing is done internally by the
application developers before the software is brought to the market. In beta testing, the software is
given to a selected target audience and errors are reported back to the development team.

SOFTWARE MAINTENANCE

Software is always dynamically evolving, even after delivery. Maintenance is the activity of adjusting
the program after it has been taken into production. This is done to boost its performance, solve any
remaining errors, and/or accommodate new user requirements. Maintenance typically consumes a large
part of the overall software development costs (up to 70% or more according to some estimates). This
can be partly explained by the fact that much of the software people work with today is relatively old
(legacy software) and has been maintained on an ongoing basis. This section covers the four main types
of maintenance. They are categorized according to their intended goals.

Adaptive Maintenance

Adaptive software maintenance refers to modifying a program to accommodate changes in the envi-
ronment (both hardware and software). An example of this is a new Windows release with new fea-
tures added (which can also be used by the program) and old features removed (which can no longer
be used by the program).

Perfective Maintenance

This refers to enhancing a program to support new or changed user requirements. Consider again
the BMI example. When the user wants to be able to enter height in feet units and weight in pound
units, this is a perfective maintenance operation.

Corrective Maintenance

Corrective maintenance aims at finding errors during runtime and fixing them. A further distinction
can be made here between emergency fixes (which need to be solved as quickly as possible due to
their critical relevance) and routine debugging (which is less urgent).

vww.allitebooks.cond
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Preventive Maintenance

Preventive maintenance aims at increasing software maintainability in order to prevent future
errors. A popular example here was the Y2K problem, where companies massively anticipated date
calculation errors in their software programs at the end of the previous century. Another example
concerns the transition of many countries from their own independent currency toward the Euro.
One important activity to facilitate preventive maintenance is documentation. This means that

the application is extended with various comments that are not executed by the compiler, but that
indicate the meaning of the various data elements, procedures, and operations in order to facilitate
future maintenance.

Among the four types of maintenance, perfective maintenance typically takes the main share of all
maintenance efforts (it can even be more than 50%), followed by adaptive, corrective, and preven-
tive maintenance.

The major causes of maintenance problems are unstructured code, lack of documentation, excessive
user demand for changes, lack of user training and understanding, and high user turnover. Many
organizations have standard procedures for maintenance, which typically start with the formal fil-
ing of a change request specifying the modifications needed to the software. Depending on the sever-
ity of the request and the change management strategy adopted by the organization, these change
requests can be grouped and dealt with at fixed time stamps, or treated immediately.

PRINCIPLES OF STRUCTURED PROGRAMMING

To finish this introductory chapter, this section discusses some of the basic principles of structured
programming.

A first important concept is stepwise refinement. Programs should be designed using a top-down
strategy where the problem statement is subdivided into smaller, more manageable subproblems.
These subproblems can be further broken down into smaller subproblems until each piece becomes
easy to solve. This strategy should decrease the program development time and its maintenance
cost.

Documentation is another important concept. It provides invaluable clarification for complex pro-
gramming statements, which will again facilitate future maintenance operations. Every program-
ming language offers facilities to include documentation lines that are ignored by the compiler or
interpreter but can be easily read and understood by programmers.

Also of key importance is to assign meaningful names to programming concepts such as variables.
Instead of naming a variable i or j without any explicit interpretation, it is much better to use stu-
dent or course, which immediately indicate their meanings.

By incorporating these principles into your programs, you will improve your own work and at the
same time make it possible for others (or even yourself—it’s not always easy to remember what you
meant by varx months later) to update and continue using your software. After all, the goal is to
create something useful that people will want to keep using.

That being said, let’s immerse ourselves further into the wonderful world of Java programming and
continue with the next chapter!
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Getting to Know Java

WHAT YOU WILL LEARN IN THIS CHAPTER:

The history of Java
The key features of Java

How the Java technology works

Y Y VY Y

The key components of the Java Runtime Environment (JRE) and
how they collaborate

The different types of Java platforms and applications
The relationship between Java and JavaScript

The basic concepts of the Java language structure

Y Y VY Y

The primitive Java data types and how they are used

WROX.COM CODE DOWNLOADS FOR THIS CHAPTER

The wrox.com code downloads for this chapter are found at www.wrox.com/go/
beginningjavaprogramming on the Download Code tab. The code is in the Chapter 2
download and individually named according to the names throughout the chapter.

Before you get your hands wet trying your first Java program, you need to learn some basic
concepts relating to the Java architecture and language semantics. The chapter starts by pro-
viding a bird’s eye overview of Java’s history, its key features, and the underlying technology.
The chapter then zooms into the Java Runtime Environment (JRE), which is the software
environment in which Java programs are executed. This will be followed by a discussion of
various types of Java applications, such as standalone applications, applets, servlets, and
Java beans.
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The chapter then covers the basic concepts of the Java language structure. You will read about vari-
ous concepts such as classes, identifiers, Java keywords, variables, methods, comments, and naming
conventions in depth. After that, you’ll learn about Java data types. First, the various primitive data
types will be covered, followed by a discussion of literals, operators, arrays, and type casting. The
BMI example introduced in Chapter 1 is used to demonstrate and clarify the new concepts. This
chapter is a very important one because it lays the foundation for all subsequent chapters. Many of
the concepts that are introduced here will be elaborated on in later chapters.

A SHORT JAVA HISTORY

In 1991, Sun Microsystems funded the research project called “Green” to design a program-
ming language to be used in intelligent consumer electronic devices, like televisions, VCRs, and
washing machines. Since home appliance processor chips change on a continuous basis, the
programming language used needed to be extremely portable. Existing programming languages
such as C++ were clearly not suitable. Often, the embedded language was tied closely to the
appliance processor, and a new language needed to be developed. This new language was origi-
nally termed Oak (referring to the tree that was outside the main developer’s, James Gosling’s,
window), but was quickly renamed Java. The use of Java for home appliance applications turned
out to be initially unsuccessful, but the emergence of the Web gave it a new future. In 1994, the
first Java-enabled web browser HotJava was developed. A year later, Netscape incorporated Java
support into its web browser. Other companies quickly followed and Java’s popularity rapidly
rose. Sun released Java 1.0 to the public in 1995. In 2007, Sun made Java’s core code available
as open source under the terms of the GNU General Public License (GPL). In 2009, Sun was
acquired by Oracle, which is currently continuing the development of Java. Table 2-1 gives an
overview of the major releases, together with some key characteristics. Note that the versions
were originally referred to as JDKs (Java Development Kits) and later rebranded into J2SE

(Java 2 Platform, Standard Edition).

TABLE 2-1: Characteristics of Major Java Releases

MAJOR RELEASE DATE KEY CHARACTERISTICS

JDK 1.0 1996 First stable version of Java

JDK 1.1 1997 Inner classes; Java beans; JDBC; RMI; Just in Time (JIT) compiler for
Windows platforms

J2SE 1.2 1998 Swing classes; Java IDL; Collections

J2SE 1.3 2000 Java platform debugger architecture (JPDA); JavaSound; HotSpot JVM

J2SE 1.4 2002 Regular expressions; IPv6 support; image I/O API; non-blocking I/O
(nio); XML parser and XSLT processor

J2SE 5.0 2004 Generics; annotations; autoboxing; enumerations; varargs; for each
loop

Java SE 6 2006 Improved GUI support; improved web service support
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Java SE7 2011 New file I/O capabilities; support for new network protocols
Java SE 8 2014 Lambda expressions; new date and time API
Java SE 9 2016 Money and currency API

(expected)

FEATURES OF JAVA

The key characteristics of the Java programming language that have made it so popular include the
following:

> Simple: Java omits some of the vaguely defined features of C++. It has facilities for
automatic garbage collection to automatically release unused memory while a program
is running. It also includes a rich predefined set of packages (such as for mathematics,
statistics, database access, GUI design, and so on) that can be easily reused by application
developers. Its syntax looks very similar to C/C++, making it easy for experienced pro-
grammers to learn and use.

> Platform independent and portable: By using a hybrid compilation/interpretation approach,
Java programs can be executed in a networked environment with different hardware plat-
forms and architectures. This also makes Java applications extremely portable, effectively
realizing the “write once, run everywhere” philosophy.

> Object-oriented: Java implements the object-oriented programming paradigm by grouping
data and operations into classes and/or objects.

> Secure: Java has many facilities to guarantee security in a networked environment. It
imposes various types of access restrictions to (networked) resources and carefully super-
vises memory allocation. It allows code to be downloaded over a network and executed
safely in the confined spaces of memory. It also foresees extensive capabilities for configur-
ing security levels.

> Multi-threaded: Java delivers the power of advanced multi-threaded capabilities to the devel-
oper in an environment without complexity. More specifically, Java code can be run concur-
rently as multiple threads in a process, in order to improve its execution performance.

> Dynamic: Java allows code to be added to libraries dynamically and then can determine
which code should run at execution time. It also foresees a strict separation between interface
and implementation.

The remainder of this book explores each of these features in much greater detail.

LOOKING UNDER THE HOOD

In this section, we will take a look under the hood of Java. We will discuss Java bytecode, the Java
Runtime Environment (JRE), and Java platforms and applications.
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Bytecode

Given the proliferation of hardware platforms and/or machine architectures available in today’s net-
worked environment, the Java developers aimed at coming up with a cross-platform solution that
would not require developing expensive compilers to compile Java source code to machine code for
every possible target platform. In order to accomplish this goal, Java introduced a hybrid approach

to run programs by combining both compiler and interpreter technology. First, every Java source
program (BMlI.java) is compiled into an intermediate language called bytecode (BMI.class), which is
platform independent. During this compilation step, errors in the code can be reported. Java bytecode
is not native machine code, so it cannot be run as such on a host computer. Instead, the bytecode will
be parsed by a platform-specific interpreter in order to run it on a particular architecture, such as

on Windows, Linux, Mac OS, Sun Solaris, and so on. Interpreters have been developed for various
platforms. All of them are implementations of the Java virtual machine (JVM). The bytecode can then
be considered as machine code for the JVM. The JVM is basically a virtual CPU complete with its
own operation codes. Irrespective of which platform you are on, the bytecode is the exact same. The
JVM is then a separate process that runs on top of a native processor. Figure 2-1 illustrates the byte-
code for a Windows 8 platform generated for a Java program based on the BMI calculator example.

static double BMI;

public BMIcalculator();

Code:
0: aload 0
1: invokespecial #12 // Method java/lang/Object."<init>":()V

4: return

public static void main(java.lang.Stringl]);

Code:
0: ldc2 w #20 // double 60.0d
3: putstatic #22 // Field weight:D
6: ldc2 w #24 // double 1.7d
9: putstatic #26 // Field height:D
12: invokestatic #28 // Method calculateBMI: ()V
15: getstatic #31 // Field java/lang/System.out:Ljava/io/PrintStream;
18: new #37 // class java/lang/StringBuilder
21: dup
22: ldc #39 // String Your BMI is
24: invokespecial #41 // Method java/lang/
// StringBuilder.
// "<init>":(Ljava/lang/String;)V
27: getstatic #44 // Field BMI:D
30: invokevirtual #46 // Method java/lang/StringBuilder.append:
(D)Ljava/lang/StringBuilder;
33: ldc #50 // String .
35: invokevirtual #52 // Method java/lang/StringBuilder.append:
(Ljava/lang/String;)Ljava/lang/StringBuilder;
38: invokevirtual #55 // Method java/lang/StringBuilder.toString:
()Ljava/lang/String;
41: invokevirtual #59 // Method java/io/PrintStream.println:

(Ljava/lang/String;)V
44: return
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public static void calculateBMI () ;

Code:
0: getstatic #22 // Field weight:D
3: getstatic #26 // Field height:D
6: getstatic  #26 // Field height:D
9: dmul

10: ddiv

11: putstatic #44 // Field BMI:D

14: return

}

When compared to a pure interpreter technology, errors are detected during compilation time
instead of during execution time. When compared to a pure compiler technology, the portability
is better since this setup essentially implements a “write once, compile, run everywhere” strat-
egy so that every platform with a Java Virtual Machine can run Java bytecode. This is espe-
cially relevant in a networked (Internet) environment with many host systems having their own
specific platform.

Windows

Interpreter

BMI.java BMI.class

public class BMIcalculator {
double weight;
double height; Interpreter
double BMI;
; Interpreter
Compiler
FIGURE 21

Java Runtime Environment (JRE)

The Java Runtime Environment (JRE) is the software environment in which Java programs run. It
consists of various components, as depicted in Figure 2-2.

The next subsections elaborate on the following components:
> Java API (Application Programming Interface)
> Class loader
> Bytecode verifier
>

Java Virtual Machine (JVM)
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Java Runtime Environment (JRE)

Java APl
Java.applet
Class loader Java.io
Bytecode verifier C— jgxg.umtﬁth

Java Virtual Machine (JVM)
v T~

Interpreter

A

Just in Time (JIT) compiler

Garbage collector Threads and synchronization

FIGURE 2-2

Java Application Programming Interface (API)

The Java Application Programming Interface (API) is the set of prepackaged, ready-made Java com-
ponents grouped into libraries. It provides programmers with many useful capabilities. Some popu-
lar API libraries are listed in Table 2-2.

TABLE 2-2: Example Libraries from the Java API

JAVA LIBRARY FUNCTIONALITY

Java.awt; Java.swing Support for creating graphical user interfaces (GUIs)
Java.applet Functionality to create applets

Java.beans Functionality to create Java beans

Java.io Support for I/0O through files, keyboard, network, and so on
Java.lang Functionality fundamental to the Java programming language
Java.math Mathematical routines

Java.security Security functions

Java.sqgl Support for accessing relational databases by means of SQL
Java.text Text support

Java.util Various programming utilities

Javax.imageIO Support for image I/O

Javax.xml Support for XML handling
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Many of these libraries are discussed and used in later chapters of this book. When developing new
Java applications, it is important to consider the API to see if you can use some of the functionalities
that are already implemented. This saves you from having to program every aspect yourself, and it
can also make your program more recognizable and usable to other programmers. The API is flex-
ible and open, which means that new packages or libraries can be added to it on an ongoing basis.

Class Loader

The class loader locates and reads the *.class files needed to execute the Java program and loads
the bytecodes into memory. To safeguard a secure execution, it can assign different portions
(namespaces) of memory to locally versus remotely obtained classes. Classes are typically assembled
into libraries that are stored physically in JAR (Java Archive) files. The libraries may have been writ-
ten by the user or obtained externally. In order to locate the classes, the class loader will first find
the corresponding libraries and then load the classes as they are needed by the program (called on-
demand loading). The class loader basically has three subcomponents:

> Bootstrap class loader
> Extensions class loader
> System class loader

The bootstrap class loader loads the core Java libraries located in <JAVA HOME>/jre/1ib. The con-
tents of this directory in the JRE7 environment are shown in Figure 2-3.

f (=] © [
@Qv' |« Java » jre7 » lib » vl‘,ll Search lib ,O‘
Organize ¥ (%) Open ~ Burn New folder ey 0 @

. amd64 .. applet

.. cmm .. deploy

| ext .. fonts

| images L ifr

| management | security

Lz |_|fontconfig.bfc
| currency.data | alt-rt.jar
|« charsets.jar |« deploy.jar
| javaws.jar | jee.jar
| jfr.jar | ifxrtjar
|| jsse.jar | management-agent.jar
|« plugin.jar || resources.jar
] rtjar || drassiist
|| meta-index |_|tzmappings
__|psfont.properties.ja |_|accessibility.properties
|_|calendars.properties |_|content-types.properties
|_|flavormap.properties |_|javafx.properties
__|logging.properties |_|net.properties
| psfontj2d.properties |_|sound.properties
|_|fontconfig.properties.src __|ivm.hprof.txt

FIGURE 2-3
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You can clearly see the different *.jar files [ =S =)
that will be considered (charsets.jar,
deploy.jar, and so on).

@Qv’ L.« Java » jre7 » lib » ext v |‘,H Search ext p\

Organize v Include in library v Sharewith v » e~ 0 @
The extensions class loader loads the B e idoc- 8 Sy
classes from the extensions directory [ jaccess jar (4] tocaledata.jar
<JAVA HOME>/jre/lib/ext. Figure 2-4 I metaindex i Ainecar
shows the contents of the extensions direc- f:::j:;mm"'w e
tory in a JRE7 environment. -
Again, you can clearly see the different FIGURE 2-4 :
JAR files available: access-bridge-64.
jar, localedata.jar, and so on.
Finally, the system class loader loads the code from Envionmont Vorlsiies )
the locations specified in the CLASSPATH environment {jser:variables forn 3063
variable, which is defined by the operating system. — o
The latter provides the path to all physical directories

where the system class loader can look for Java files. had PR EEE L

It can be found in Windows 7 and Windows 8 by
going to the Control Panel » System and Security » ([ new.. J[ Edte. ) [ peet= )
System, Advanced System Settings » Advanced tab >

Environment Variables. Figure 2-5 shows the window ystem verities
. . . Variable Value o
from a Windows 7 operating system, but Windows 8 e o o e i e
looks very much the same. DEFLOGDIR C:\ProgramData\Mchfee \DesktopProtec...
FP_NO_HOST_C... NO
ofe NUMBER_OF P... 8 -
Bytecode Verifier e r—
The bytecode verifier checks to make sure the byte-
codes are valid without breaching any of Java’s secu- o ]
rity rules. It pays special attention to type checking all 4
FIGURE 2-5

the variables and expressions in the code and ensures
that there is no unauthorized access to memory. Note
that when a Java program is invoked, you can choose to disable the bytecode verifier (which will
make it run slightly faster), enable it only for code that was downloaded remotely from the network,
or enable it for all the code. Once the code is verified, it will be offered to the Java Virtual Machine
(JVM) for interpretation.

Java Virtual Machine (JVM)

The Java Virtual Machine (JVM) can be considered an abstract computer machine capable of execut-
ing bytecode on a particular hardware platform. It constitutes the heart of the “write once, run every-
where” philosophy. Various JVM implementations have been provided for various hardware and/or
operating system environments. The most popular JVM is HotSpot produced by Oracle. It is available
for Windows, Linux, Solaris, and Mac OS X. A key component of the JVM is the interpreter respon-
sible for interpreting the bytecode instructions. The garbage collector cleans up unused memory to
improve the efficiency of the program. The JVM typically also includes facilities for multithreading
and synchronization, whereby a Java program can be executed in one or more parallel execution paths
(threads) scheduled on one or more CPUs, hereby significantly accelerating its execution time.

vww.allitebooks.cond
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The interpreter may monitor how often each bytecode instruction is executed and hand over the
frequently executed instructions (also called hot spots) to the Just in Time (JIT) compiler, which is
also an environment-specific component. The JIT compiler will then compile the bytecode of these
hot spots into native, more efficient machine code so they can be executed by the JVM directly (just
in time) instead of having to interpret them. In this way, frequent code will be compiled and less fre-
quent code will be interpreted. The user can set the threshold to determine whether a piece of code
is considered frequent or not. This feature substantially improves the execution time of the program
at runtime, especially when it is executed multiple times. Although this is not recommended, the JIT
compiler option can also be turned off.

Java Platforms

A Java platform or edition consists of a JRE with a specific set of libraries for a specific application
environment. Table 2-3 gives an overview of the most important Java platforms.

TABLE 2-3: Java Platforms

PLATFORM KEY CHARACTERISTICS

J2SE (Java 2 Platform, Standard Core Java platform designed for applications running on
Edition) desktop PCs

J2EE (Java 2 Platform, Enterprise Design, development, assembly, and deployment of busi-
Edition) ness applications

J2ME (Java 2 Platform, Micro Design of small, embedded applications in consumer
Edition) devices (such as mobile phones)

Java Card Design of small Java applications that run on smart cards
JavaFX Design of Rich Internet Applications (RIAs)

As discussed, this book predominantly focuses on the J2SE platform.

Java Applications

In this section, we will discuss various types of Java applications such as standalone applications,
Java applets, Java servlets, and Java beans.

&8 Command Prompt =G
. . c:\myJava\BMI>java BMIproject
Standalone App|lcatlons Please enter your weight [kg]
o5
A standalone application is one that can run Please enter your height [m]
. . . 1.88
on its own without needing to be embed- vour BMI ic 24 049343564386603.

ded in a particular host environment (such

as a web browser). Standalone applications
only need a JVM to execute. They can be
command-line applications or graphical user
interface (GUI) applications. A command-
line application uses the command prompt
for the input and output. This is illustrated in |
Figure 2-6. FIGURE 2-6

c : \myJava\BMI>
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A GUI application uses graphical components to facili- V@l BMI Calculator =)
tate the input and output of the program. An example
GUI for calculating BMI is shown in Figure 2-7. Height: |1.88 m
Weight: |85 kg
Java Applets

An applet is a Java application that’s typically embed-

ded in an HTML page and run by the client web
browser. Applets run in a sandbox, which is a con-
fined space in memory that guarantees their execution
is secure. Applets can make use of the full expres- BMI:| 24.05
sive power of the Java language. They are defined in
HTML by means of the <applets> tag, as follows:

FIGURE 2-7
<Applet>

</Applet)

They were typically used for graphics and rich interfaces but are not that popular anymore due to
some recent security exploits. Their functionality has been replaced more and more by JavaScript
and HTML 5. In fact, applets are no longer supported by many tablets or other mobile devices.

Java Servlets

Servlets are part of the J2EE platform and are small Java applications that run on a Java-enabled
Application server. Servlets can read and process data (originated from, for example, an HTML form)
sent by the client browser through HTTP. They can interact with a server database, invoke web services,
or call other servlets or server-side functionality. The results can then be communicated back to the client
browser in a variety of formats (such as in HTML, XML, Word, and so on). Servlets are used in an envi-
ronment where they may process multiple requests simultaneously. This is visualized in Figure 2-8.

Client

Databases

Web server

=

ST

FIGURE 2-8
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Java Beans

A Java bean is a reusable software component that can be visually manipulated in a builder tool.
These tools allow beans to be customized by setting their properties and specifying how they react

to events.

JAVA LANGUAGE STRUCTURE

This section provides a brief overview of the Java language structure. Many of the concepts
addressed will then be further elaborated on in subsequent chapters. Let’s consider the following
running example of a Java program calculating BMI to illustrate the discussion.

public class BMICalculator {

// declare variables

double
double
double

public

public

}

BMICalculator (double w, double h) {
weight = w;

= h;

double calculateBMI() {
return weight / (height * height) ;

// This is our main method.

public static void main(String[] args)

BMICalculator calculator = new BMICalculator (60, 1.70);
double bmi = calculator.calculateBMI () ;

// print BMI to screen
System.out.println("Your BMI is " + bmi + ".");

Before you start discussing this example in more detail, let’s quickly note a few things. First, note
that Java is a form-free language and does not require special indentation. Any statement can start
at any place of indentation. Also, extra whitespace, tabs, and new lines are ignored by the compiler.
The program can thus be formatted in many ways. To improve the readability of your code, it is
highly recommended that you use a consistent formatting style. This book always formats the code
according to convention. This makes it easy to read and also helps you get used to a standard for-

matting style.

The program contains several statements, each ending with a semicolon (;). A statement performs
a specific action and can span multiple lines. The bytecode corresponding to this program was
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presented earlier in the “Bytecode” section 3 Command Prompt P
Of thiS chapter. Figure 2-9 ShOWS the output c:\myJava\BMIproject\bin>java BMIcalculator

- ] ’ Your BMI is 20.761245674740486.
after executing this program in Java.

) »

c:\myJava\BMIproject\bin>

Classes

In Java, all code is grouped into classes. A
class is thus a code container. The definition
of the class starts with an access modifier
(public in this case), which specifies which
classes have access to it (you will learn about
this later more extensively). This is followed .
by the keyword class and the name of the FIGURE 2-9

class (BMICalculator). Every class defini-

tion is enclosed within brackets {}. It has both variables (weight, height, and BMI) and methods
(BMICalculator, calculateBMI, and main). The main method is a special method since it is the
entry point of program execution. In other words, when the class BMICalculator is run by the Java
Runtime Environment, it will start by executing the main method. Note that not every Java class
should have a main method.

Identifiers

An identifier is a name of a language element. This can be a class, variable, or method. In the
BMI example, the following are identifiers: BMICalculator, weight, height, BMI, main, and
calculateBMI. Use these naming conventions when defining identifiers:

> In theory, an identifier can have an unlimited length, although practically it needs to be less
than 64k of Unicode characters and digits, but it cannot begin with a digit. Although tech-
nically it is possible to start an identifier with a currency sign ($) or punctuation character
(such as ), it is highly discouraged since it will decrease the readability of the code.

> An identifier cannot be equal to a reserved keyword, null literal, or boolean literal.

Just like C, Java is case sensitive. So the identifiers bmi, Bmi, and BMI are all different according
to Java. Hence, it is important to carefully check your spelling and capitalization. When creating
identifiers, make sure to use full words instead of abbreviations as much as possible, unless the
abbreviations can be unambiguously interpreted. This will facilitate the understanding and future
maintenance of the code. In the BMI example, it’s more intuitive to work with height, weight,
and BMI, rather than h, w, and b. Imagine if you added new functionality to the calculator that
accepted the measurement of a person’s waist. It would be even more difficult to keep track of
what w meant.

Java Keywords

Table 2-4 lists the 50 keywords of Java. All these keywords have a special reserved meaning in Java
and thus cannot be used as identifiers. The BMI example uses the following keywords: public,

class, static, void, and double.
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TABLE 2-4: Java Keywords

abstract
assert
boolean
break
byte
case
catch
char
class

const

Variables

continue
default
do
double
else
enum
extends
final
finally

float

for

goto

if
implements
import
instanceof
int
interface
long

native

new
package
private
protected
public
return
short
static
strictfp

super

switch
synchronized
this

throw

throws
transient
try

void
volatile

while

As stated earlier, every class definition consists of both variables and methods. A variable is a name for a
memory location that stores a specific value. This value may change during program execution, which is
why it’s called a “variable.” The BMICalculator class starts by defining the following variables:

// declare variables

double weight;
double height;
double BMI;

The weight, height, and BMT variables are defined using the data type double, which represents a
floating point number. Other data types exist in Java and will be covered in a subsequent section. In
Java, variables must always be defined in a class.

Methods

As discussed earlier, a method is a piece of code within a class definition, and it performs a specific

kind of functionality. Just as with a class, every method definition is enclosed within brackets {...}.
In the BMICalculator example, three methods have been defined—BMICalculator, CalculateBMI,
and main. Consider the main method:

public static void main(String[] args) {
BMICalculator calculator = new BMICalculator (60, 1.70);

double bmi

// print BMI to screen
System.out.println("Your BMI is " + bmi + ".");

calculator.calculateBMI () ;
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As stated earlier, the main method is the main entry point of program execution. So, it is the first
method that runs when executing the class BMICalculator. The first line, called the method decla-
ration, contains several keywords. We’ll discuss these in much greater length in later chapters, but
for now, we will briefly introduce those you see here.

> public: This method can be accessed by other classes and/or methods without restriction.
>  static: This method does not need an object.
> void: This method does not return any value.
>  (stringl[] args): This is a conventional way to refer to the arguments of the method. In

this case, the method takes an array of strings as its input parameter.

Now you will investigate what is actually happening inside the main method. The method starts

by assigning the values of 60 and 1.70 to the variables of weight and height, respectively. In later
chapters, you will allow the user to interactively enter the weight and height using either the console
or a graphical user interface. It then continues by calculating the BMT by calling another method
called calculateBMI. The calculateBMI method then looks as follows:

// method calculating BMI

public static void calculateBMI () {
BMI = weight/ (height*height) ;
}

It calculates the BMT as BMT = weight/ (height*height). The main method then prints the BMT to
the screen using the following statement:

System.out.println("Your BMI is " + BMI +".");

You will learn the exact meaning of this statement later. To conclude this subsection, remember that
all methods in Java must be defined in a class.

Comments

Java has several ways of adding comments to program code. Remember, comments are needed to
improve code readability and facilitate future maintenance operations. They are not executed when
the Java program runs. One way of including comments is as follows:

// This is our main method.

Using //, you create a line comment that runs until the end of the line. Block comments span mul-
tiple lines and can be defined using the delimiters /* ... */, as follows:

/* Here, we call the method calculateBMI which will
* calculate the BMI
*/

A very handy feature is the Javadoc tool, which is a documentation generator developed by Oracle
and comes as part of the core JDK. It produces HTML documentation from Java source code and
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allows for various pieces of documentation to be hyperlinked together. Reconsider the BMI example
as follows:

/** This class allows you to calculate the <b> <u> BMI </u></b> using the inputs:

*

L R T R

<ul>

<li> weight; </1li>

<li> height. </li>

</ul>

See <a href="http://en.wikipedia.org/wiki/Body mass_ index">Wikipedia</a> for
more information.

@author Bart Baesens

public class BMICalculator {

}

// declare variables
static double weight;
static double height;
static double BMI;

// This is our main method.

public static void main(Stringl[] args) {
weight=60;
height=1.70;

/* Here, we call the method calculateBMI which will
* calculate the BMI

*/

calculateBMI () ;

// print BMI to screen
System.out.println("Your BMI is " + BMI +".");

}

// method calculating BMI

public static void calculateBMI ()
BMI = weight/ (height*height) ;

}

This is essentially the same code as before, except that a header has been added, as follows:

/** This class allows you to calculate the <b> <u> BMI </u></b> using the inputs:

*

E R

<ul>

<li> weight; </1li>

<li> height. </1li>

</ul>

See <a href="http://en.wikipedia.org/wiki/Body mass_index">Wikipedia</a> for
more information.

@author Bart Baesens

This header adds Javadoc HTML documentation to the class definition. Javadoc comments are
enclosed between /** ... and */. Remember the HTML tags <b>... </b>, and <ul>... </ul>
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PrevClass NextClass
‘Summary: Nested | Field | Constr | Method

Frames

Class BMICalculator

Jjavalang.Object
BMICalculator

No Frames All Classes

Detaik Field | Constr | Method

I [ESNEr==)
J, [ BMICalculator x

= = C [ filey//C:/BMICalculator/doc/BMICalculator.html = The HTML tag <uls>. ..
Package CIa88| Use Tree Deprecated Index Help I:

public class BMICalculator
extends java.lang.Object

o weight

« height
See Wikipedia for more information.
Author:

Bart Baesens

Constructor Summary

This class allows to calculate the BMI using the inputs:

Constructor and Description
BMICalculator ()

represent text in bold face and underlined, respectively.
</ul> defines an unordered
list with the items specified as <1i> ... </1i>. You
can add a link to the Wikipedia page with BMI infor-
mation using the HTML tag <a href=“...">... </a>.
You can then use the @author tag to credit the pro-
grammer. Part of the Javadoc generated from this pro-
gram is shown in Figure 2-10.

Note that at the top of the page, you will find the
information included in the program. Next to the
information we added, Javadoc will also generate
some documentation by default, like the fields (vari-
ables) and methods of the class defined. As you will
see later, some integrated development environments
(IDEs) such as Eclipse generate Javadoc HTML doc-

Method Summary

Modifier and Type
static void

FIGURE 2-10

Method and Description
calculateBMI () X

umentation code by default.

It is highly recommended that you use a consistent
documentation style. Consider providing comments
at the top of the class, explaining what the class does
and naming the author, and also adding comments to

each variable and method definition to clarify their
meaning. This is especially important with large-scale projects, where many Java classes are simul-

taneously being programmed by multiple developers.

Naming Conventions

Various Java communities have introduced naming conventions for identifiers. These are not strictly
enforced, so your code will compile successfully even if you don’t comply. However, you will improve
the readability and future maintenance of your Java programs if you follow these conventions. A very
popular naming convention originally suggested by Sun Microsystems is explained in Table 2-5.

TABLE 2-5: Java Naming Convention

IDENTIFIER CONVENTION

GOOD EXAMPLES

BAD EXAMPLES

Class UpperCamelCase: The first letter of each word is BMICalculator  bmiCalculator
capitalized. Student STUDENT
MyProgram myProgram
Variable lowerCamelCase: The first letter is lowercase myHeight; MyHeight;
and the first letters of all following words are myWeight; myheight;
capitalized. height; Height;
weight; WEIGHT;
Method lowerCamelCase: The first letter is lowercase and main Main
the first letters of all following words are capitalized. calculateMyBMI cCalculateBMI
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JAVA DATA TYPES

Java is a strongly typed language. This means that every variable should first be carefully declared
upfront before it can be used. You already saw examples of this in the BMIConstructor class, as
follows:

// declare variables
double weight;
double height;
double BMI;

The data type of a variable specifies the kind of values it can be assigned. For example, the weight,
height, and BMI variables are declared as double variables, so they can only be assigned floating-
point numbers from a specific range. A data type tells the compiler how much memory to allocate
to a variable, the format in which it will be stored, and the operations that can run on it. Although
a variable can change value during program execution, its type always remains fixed. A distinction
can be made between primitive and composite data types. A primitive data type is a basic building
block supported by Java. On the other hand, a composite data type is composed of primitive data
types using a composition construct. The following sections elaborate on both of these data types.

Primitive Data Types

Java supports eight built-in primitive data types. Table 2-6 defines each of these and specifies the
range and default value. If the user has not initialized a variable, the compiler will automatically
assign the default value. Note that the ranges and default values are uniform and do not depend on
the underlying machine architecture on which the Java program runs.

TABLE 2-6: Java Primitive Data Types

TYPE DEFINITION MINIMUM MAXIMUM DEFAULT
byte 8-bit signed integer -128 127 0

short 18-bit signed integer 32,768 32,767 0

int 32-bit signed integer =231 22l 0

long 64-bit signed integer -263 2631 oL
float Single-precision 32-bit IEEE 1.40239846x104° 3.40282347x10%8 0.0f

754 floating point number
double  Double-precision 64-bit IEEE  4.9406564581246544 1.79769313486231570 0.0d

754 floating point number x107324 %10-308
boolean One bit of information; flag false true false
indicator

char Single 16-bit Unicode character “\u0000’ (or 0) \uffff’ (or 65,535) “\u0000’
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NOTE Beginning with Java 8, some changes have been introduced. The data
type int can also be used to define an unsigned integer from 0 to 2°2-1. The
data type long can be used to define an unsigned integer between 0 and 2%4-
1. If your application doesn’t require negative values, this will offer you a larger
range of valid positive numbers.

You may think that strings (such as name = "Bart Baesens") are lacking in Table 2-6. In fact, as
we will discuss later, Java does not have a built-in string type. It offers special facilities to work with
strings. Note that the default value for the 1ong data type is or. The L stands for long and is capital-
ized to avoid confusion with the number one (1 versus 1). Likewise, the default values for float and
double end with £ and 4, respectively.

It is important to define each variable using the appropriate data type. In fact, limiting the range

of a variable can serve as very useful documentation to better understand its meaning during code
inspection and/or maintenance. Furthermore, it can also help save memory if a variable is defined as
byte instead of int (since byte is four times smaller than int).

Literals

A literal is a value assigned to a variable of a specific type. An example of this is:

weight 60;
height = 1.70;

In this example, the equals sign (=) is used as an assignment operator to assign the literals 60 and
1.70 to the variables weight and height, respectively.

Here are some other examples of literals:

boolean overweight = true;
short age = 38;
character initial = 'B';

Note that literals of type 1ong, float, and double can end with the letters /1, F/f, and D/d,
respectively. Floating point literals can also be expressed in scientific notation using E or e. This
is illustrated here:

Double bmi = 24.2;
Double bmi = 24.2d;
Float bmi = 0.242e2;

Character literals (char) are always enclosed in single quotes and may contain any Unicode charac-
ter (see www.unicode.org for more details). An example of this is as follows:

char gbPoundUniSymbol = '\u0O0A3';
char gbPoundSymbol = '£';
char dollarUniSymbol = '\u0024';
char dollarSymbol = 'S';

vww.allitebooks.cond
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There are also some characters, called escape characters, that have a special meaning. They are used
for displaying text in specific ways, either for inserting tabs or enters where desired, or by display-
ing a character that’s normally reserved for code syntax. For example, we just discussed that the
single quote (') indicates the beginning and end of a char literal. But what if you want to use the (')
character in your code? You can do so by putting a backslash (\) before it. Some of the more com-
mon escape characters are listed in Table 2-7.

TABLE 2-7: Escape Characters in Java

SHORTCUT NOTATION MEANING UNICODE
\b Backspace \u0008
\t Tab \u0009
\n Linefeed \uOOOA
\r Carriage return \u000D
\0 0 Quote mark \u0022
\! Apostrophe \u0027
\\ Backslash \u005C

In order to improve code readability, you can use underscores (_) anywhere within literals of a
numeric data type. Just like a space in a sentence, they break up a number into smaller parts to
make it easier to read and verify it. Consider this example:

long creditCardNumber = 1234 4567_8901L;

Operators

Operators perform data manipulations on one or more input variables (called operands). For exam-
ple, in the expression 2+3, the operands are 2 and 3, and the operator is +. In terms of the number
of operands, a distinction can be made among unary operators (one operand), binary operators (two
operands), and fernary operators (three operands). In terms of the operations performed, a distinc-
tion can be made among the following:

> Arithmetic operators
Assignment operators
Bitwise operators

Logical operators

Y Y VY

Relational operators

Arithmetic Operators

Arithmetic operators perform basic mathematical operations on numerical values. The most popular
ones are listed in Table 2-8.
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TABLE 2-8: Arithmetic Operators

ARITHMETIC OPERATOR EXAMPLE MEANING RESULT
+ 4+2 Addition 6
- 4-2 Subtraction 2
* 4*2 Multiplication 8
/ 4/2 Division 2
5 8%3 Modulo (remainder after integer division) 2

Most of these operators are probably very familiar to you already. Addition, subtraction, multiplica-
tion, and division are used in everyday calculations. It is worth noting at this point that while they
operate in the way you understand and expect, the answer is not always exactly what you’re looking
for. In other cases, the way data is stored as binary numbers cannot accurately represent non-whole
numbers. For this reason, operations on floating point numbers often result in a number that’s very
close to what you expect, but with several digits after the decimal point. This is simply due to the
fact that these decimals are approximations. For example, if you multiply 1.3 times 0.01, the answer
would be 0.013. However, when you ask Java to calculate 1.3f*0.01f, the result is 0.12999999. Of
course, this rounds to the 0.013 you are expecting, so the operation is the same.

Sometimes the problem is not with rounding, but due to the data type being used. To illustrate
this, imagine you have two integers, 5 and 2. If you add them together, you expect 7 (and this is
what Java will return as well). However, if you divide 5 by 2, you already know the answer is 2.5.
However, Java is using integers, so the result of integer operations must be an integer. Therefore,
Java evaluates 5/2 = 2. The remainder is not included in the result.

This is where the modulo operator comes in. It will calculate the remainder in division. So, while
5/2 = 2 (and the remainder of 1 was ignored), 5%2 = 1 (here is that remainder of 1). Between the
two operators, you have the complete solution. It’s interesting to note that the modulo operator
is often used to check whether a number is even or odd. For an even number, %2 will result in 0,
whereas for an odd number, %2 will result in 1.

In Java, expressions are evaluated following the usual mathematical order of operations. This means
in terms of precedence, the operators (*), (/), and (%) are processed before the operators (+) and (-).
For example, the expression 4+6*2 will be evaluated to 16. To change the order of processing, you
can use parentheses to indicate which operations should be evaluated first. The expression (4+6)*2
will consequently be evaluated to 20. When you use more than one operator with the same level of
precedence, the expression will be evaluated from left to right. The expression 6+2+4+5%6 will thus
be equivalent to (((6+2) +4)+(5%6)), or 42.

Assignment Operators

The assignment operator assigns values to a variable. In previous examples, you read about the (=)
operator, which assigns a value to a variable. Table 2-9 lists some important assignment operators.
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TABLE 2-9: Assignment Operators

ASSIGNMENT OPERATOR EXAMPLE

= weight =
+= weight +=
-= weight -=
*= weight *=
f= weight /=
%= weight %=
++ weight++;
-- weight--;

Bitwise Operators

MEANING RESULT

85;  Assign the value 85 to the variable weight 85

2; Same as weight = weight + 2; 87

2; Same as weight weight - 2; 85

2; Same as weight weight * 2; 170

2; Same as weight = weight / 2; 85

2; Same as weight weight % 2; 1
Same as weight = weight + 1; 2
Same as weight = weight - 1; 1

Bitwise operators work on bits and perform bit-by-bit operations on the operands. The operands can
be of type long, int, short, char, or byte. To illustrate these operators, consider the following Java
integer variables and their bitwise representation. Note the preceding 1 in int c indicates that it is a

negative number:

> int a = 40; //binary a:
> int b = 122; //binary b:
> int ¢ = -12; //binary c:

0010 1000

0111 1010

1111 0100

Table 2-10 shows the bitwise operators and some examples of how they are used.

TABLE 2-10: Bitwise Operators

BITWISE OPERATOR MEANING

& Bitwise AND operator: Puts a 1 bit in the
result if both input operands have a 1 bit
at the given position.

Bitwise OR operator: Puts a 1 bit in the

result if one of both input operands have a

1 bit at the given position.

EXAMPLES

a&b;

a|b;

RESULT

a: 0010 1000
b: 0111 1010

r: 0010 1000

a: 0010 1000
b: 0111 1010

r: 0111 1010

continues
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TABLE 2-10 (continued)

BITWISE OPERATOR MEANING EXAMPLES RESULT
~ Bitwise exclusive OR (XOR) operator: Puts  a™b; a: 0010 1000
a 1 bit in the result if one of the operands, b: 0111 1010
but not both, has a 1 bit at the given
position.
r: 0101 0010
~ Unary bitwise inverse operator: Changes ~a a: 0010 1000
every 1 bit to 0 and every 0 bit to 1. r- 1101 0111
>> Signed right shift operator: Shifts the left a>>2 a: 0010 1000
operand to the right by the number of bits r- 0000 1010

specified. The left digits of a positive number
are then filled with Os, while the left digits
of a negative number are filled with 1s. This

preserves the original sign of the number, c>>2 c: 1111 0100
hence the name “signed right shift.” 1111 1101
>>> Unsigned right shift operator: Shifts the a>>>3 a: 0010 1000
left operand to the right by the specified r- 0000 0101

number of bits. The left digits are always
filled with Os, regardless of the sign, hence

the name "unsigned right shift.” e>>>3
c: 1111 0100
r: 0001 1110
<< Left shift operator: Shifts the left operand  a<<2 a: 0010 1000
to the left by the number of bits indicated. r- 1010 0000
The right digits are then filled with Os.
Since only the right side is filled, it is not
possible to fill with 1s or Os to ensure a
positive or negative number. Therefore c<<2 c: 1111 0100
there is no distinction between a “signed r- 1101 0000

left shift” and an “unsigned left shift.”

Logical Operators

A logical operator returns a Boolean result based on the Boolean result of one or more expressions.
For this reason, they may also be called Boolean operators. Logical or Boolean operators are always
evaluated from left to right. Consider, for example, the following expressions and their Boolean
results. Table 2-11 then illustrates the evaluation of the logical operators that can be used in Java on
these expressions.

>  A:3>2 (True)
>  B:2 <1 (False)
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TABLE 2-11: Logical Operators
LOGICAL OPERATOR  MEANING EXAMPLES RESULT

&& Conditional AND operator: True if both A && B False
operands are true.

| | Conditional OR operator: True if at least A || B True
one operand is true.

» Bitwise and Logical XOR operator: Trueif A ~ B True
one, and only one, operand is true.
! Unary NOT operator: True if the operand is N False

false.

The truth tables for these Boolean operators are illustrated in Table 2-12. Table 2-12 assumes two
operands that may be either true or false, as indicated by the first and second column.

TABLE 2-12: Truth Table for Logical Operators

OPERAND 1 OPERAND 2 AND OR XOR NOT (OPERAND 1)
True True True True False False
True False False True True False
False True False False True True
False False False False False True

The bitwise AND (&) and OR (|) operators can also be used with Boolean operands. However, there
is a difference between the conditional and bitwise operators. If the first operand evaluates to false,
the conditional AND operator (s&) will not consider the second operand, since it already knows the
outcome will be false. This is often referred to as short-circuiting behavior. The bitwise AND opera-
tor (&) always evaluates both operands. Similarly, if the first operand evaluates to true, the condi-
tional OR operator (| |) will no longer evaluate the second operand, since it already knows that the
outcome will be true. The bitwise OR operator (|) always evaluates both operands.

This means that using the conditional (s&) and (| |) operators can lead to more efficient program
executions. But that is not the only reason to use the conditional operators. If evaluating an expres-
sion may lead to an error, taking advantage of the short-circuiting feature can prevent this by ignor-
ing the error-prone expression in cases where the error would occur. For example, trying to divide
a number by 0 will cause an error. So you could use the conditional AND (&&) to first check if the
number is not zero and then check the result of dividing by it only if it is, in fact, not zero. If it is
zero, the second expression will not be evaluated.
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Relational Operators

Relational operators are usually binary operators. They check the relationship between two oper-
ands that are usually numbers or at least can be represented as numbers. They typically return a
Boolean value. Consider the following variables:

int a=4;

int b=9;
int c=4;

Table 2-13 illustrates the relational operators that can be used in Java.

TABLE 2-13: Relational Operators
RELATIONAL OPERATOR MEANING EXAMPLES  RESULT

> Greater than: Verifies whether operand 1 is strictly a > b False
bigger than operand 2.

>= Greater than or equals: Verifies whether operand b > a True
1 is strictly bigger than or equal to operand 2.

< Less than: Verifies whether operand 1 is strictly c<b True
lesser than operand 2.

<= Less than or equals: Verifies whether operand 1is b < a False
strictly lesser than or equal to operand 2.

== Equal: Verifies whether operand 1 is equal to a ==c¢ True
operand 2.
1= Not equal: Verifies whether operand 1 is notequal a != b True

to operand 2.

Arrays

An array is a composite variable holding a fixed amount of values of a specific type (such as int,
long, char, float, double, and so on). When an array is declared, the data type it will contain is
set. When it is initialized, the number of elements must be set as well. An array has a fixed number
of elements that are accessed by an index, which points to the n' element of the array. It’s important
to note that the first element of the array has an index of 0. To begin working with arrays, consider
the following statement:

float[] weightArray;

This defines a variable called weightarray, which is an array of floating point numbers. Note the
square brackets ([1), which denote that the variable is an array. Although not recommended, an array
can also be declared as follows:

float weightArrayl];
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The array can then be initialized using the new operator, as follows:

weightArray = new float[5];

The array now has space to store five floating numbers—the first num-
ber is stored at index position 0 and the last number is stored at index
position 4. The values stored initially will be the default values for the
data type, which is 0.0 for float. Figure 2-11 gives a visual representa-
tion of the array in this initialized state.

You can now populate the array as follows:

weightArray[0] = 85f;
weightArray[1] = 72f;
weightArray[2] = 68f;
weightArray[3] = 94f;
weightArray[4] = 78f;

Remember the letter £ is added at the end of each of the numbers to
indicate that they are floating point numbers. The weightaArray popu-
lated with the specified floats is visualized in Figure 2-12.

Initializing and populating the array can both be done more concisely,
as follows:

float[] weightArray = {85f, 72f, 68f, 94f, 78f};

weightArray

0 1 2 3 4
index
FIGURE 2-11
weightArray
85 | 72 | 68 | 94 | 78
0 1 2 3 4

index
FIGURE 2-12

This way, the data type is given, the array is indicated with the square brackets ([1), the name is given
as weightArray, and the size is set based on the number of elements given between the brackets ({ }).

The following Java program illustrates how arrays can be used to calculate the BMI for a set of five

people.
public class BMIcalculator {

// This is our main method.
public static void main(String[] args) {

// initialize the three arrays as each having 5 elements

float[] weightArray = new float[5];
float[] heightArray = new float[5];
float[] BMIArray = new float[5];

// assign the values to the weight array

weightArray[0] = 85f;
weightArray[1] = 72f;
weightArray[2] = 68f;
weightArray[3] = 94f;
weightArray[4] = 78f;

//assign the values to the height array
heightArray[0] = 1.74f;



http:///

36 | CHAPTER2 GETTING TO KNOW JAVA

heightArray[1] = 1.80f;
heightArray[2] = 1.90f;
heightArray[3] = 1.84f;
heightArray[4] = 1.88f;

//compute the BMIs and store in the BMIArray
BMIArray[0] = weightArray[0]/ (heightArray[0] *heightArray [0

7

1 1)
BMIArray[l] = weightArray([1l]/ (heightArray[1l]*heightArray[1]);
BMIArray[2] = weightArray([2]/ (heightArray[2] *heightArray[2]);
BMIArray[3] = weightArray([3]/(heightArray[3]*heightArray[3]);
BMIArray[4] = weightArray([4]/ (heightArray[4]*heightArray[4]);

// print the BMIs to the screen

System.out.println("The BMI of person 1 is: " + BMIArrayl[0] + ".");
System.out.println("The BMI of person 2 is: " + BMIArrayl[l] + ".");
System.out.println("The BMI of person 3 is: " + BMIArrayl[2] + ".");
System.out.println("The BMI of person 4 is: " + BMIArrayl[3] + ".");
System.out.println("The BMI of person 5 is: " + BMIArrayl[4] + ".");

}

The output of the Java program is:

is: 28.075043.
is: 22.222223.
is: 18.836565.
is: 27.76465.
is: 22.06881.

The BMI of person
The BMI of person
The BMI of person
The BMI of person
The BMI of person

Ul w N

Multidimensional arrays are arrays where the elements are arrays themselves. A popular example of
this is a matrix. Consider the following Java class:

public class MatrixExample {

// declare and initialize the matrix
// This is our main method.

public static void main(Stringl[] args) {

int[][] matrix={{1, 2, 4},{2, 6, 8},{10, 20, 30}};
// print some of the matrix numbers to the screen

System.out.println("Element at row 0 and column 1 is: " + matrix[0][1] + ".");
System.out.println("Element at row 2 and column 2 is: " + matrix([2] [2] + ".");
System.out.println("Element at row 2 and column 1 is: " + matrix[2][1] + ".");
System.out.println("Element at row 1 and column 0 is: " + matrix[1][0] + ".");

}
}

The matrix variable is an array of an array of integer numbers. It is immediately initialized during
declaration. The output of this program will be as follows:

Element at row 0 and column 1 is: 2.
Element at row 2 and column 2 is: 30.
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Element at row 2 and column 1 is: 20.
Element at row 1 and column 0 is: 2.

Note that the matrix variable is an array of equal size arrays, each having three elements. This does
not necessarily need to be the case. You can also create arrays of unequal sized arrays, as follows:

public class MatrixExample {

// declare and initialize the matrix
static int[][] weirdMatrix={{1, 2},{2, 6, 8},{10}};

// This is our main method.
public static void main(Stringl] args){

// print some of the matrix numbers to the screen

System.out.println("Element at row 0 and column 1 is: " +
weirdMatrix[0] [1] + ".");

System.out.println("Element at row 2 and column 2 is: " +
weirdMatrix[2] [0] + ".");

System.out.println("Element at row 2 and column 1 is: " +

weirdMatrix[1] [2] + ".");
}

The output of this program is now:

Element at row 0 and column 1 is: 2.
Element at row 2 and column 2 is: 10.
Element at row 2 and column 1 is: 8.

Here, you are accessing each element directly using the weirdmatrix[1] [2] notation, but there are
also loop structures that are often used to iterate through the elements of an array somewhat auto-
matically. These are discussed in Chapter 5, and arrays will be revisited there.

Type Casting

Type casting refers to converting a value from a specific type to a variable of another type. Booleans
cannot be converted to numeric types. For the other data types, two types of conversion can be con-
sidered: widening conversion (implicit casting) and narrowing conversion (explicit casting). Before
we discuss these further, remember the hierarchy of primitive data types as follows (from high preci-
sion to low precision): double, float, long, int, short, and byte.

A widening conversion is when a value of a narrower (lower precision) data type is converted to a
value of a broader (higher precision) data type. This causes no loss of information and will be per-
formed by the JVM implicitly. An example is as follows:

static int a = 4;
double x = a;

In this example, an integer variable a with value 4 is promoted to a higher-order double data type
without loss of information. Although this code will successfully compile, it is good programming
practice to explicitly mention the casting as follows:
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static int a = 4;
double x = (double) a;

In Java, the following widening conversions are possible:
> From a byte to a short, an int, a long, a float, or a double
From a short to an int, a long, a float, or a double
From a char to an int, a long, a float, or a double
From an int to a long, a float, or a double

From a long to a float or a double

Y Y Y VY Y

From a float to a double

A narrowing conversion is when a value of a broader (higher precision) data type is converted to a
value of a narrower (lower precision) data type. This will typically involve loss of information. An
example of this is as follows:

static float b = 6.82f;
int y = b;

Because of Java’s strict type checking, this code will not compile and an error will be generated, as
follows:

Type mismatch: cannot convert from float to int

Here, the casting is not done implicitly by the JVM and should be made explicit by the programmer
using the following statement:

int v = (int) b;

In Java, the following narrowing conversions are possible:
> From a byte to a char

From a short to a byte or a char

From a char to a byte or a short

From an int to a byte, a short, or a char

From a long to a byte, a short, a char, or an int

From a float to a byte, a short, a char, an int, or a long

Y YV VYV VY Y Y

From a double to a byte, a short, a char, an int, a long, or a float

5 :
To conclude, consider the following TypeCastingExample class in Java
public class TypeCastingExample {
// This is our main method.

public static void main (String[] args) {
int intA = 4;

vww.allitebooks.cond
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float floatB = 6.82f;
//Widening conversion
double doubleX = (double) intA;

//Narrowing conversion
int intY = (int) floatB;

// print out the values

System.out.println("The value of intA is: " + intA +".");
System.out.println("The value of floatB is: " + floatB +".");
System.out.println("The value of doubleX is: " + doubleX +".");
System.out.println("The value of intY is: " + intY +".");

The output of this program is:
The value of intA is: 4.
The value of floatB is: 6.82.

The value of doubleX is: 4.0.
The value of intY is: 6.

Observe how narrowing the conversion of the floating point number 6. 82 caused the floating point
to be dismissed. Consider the following example:

public class AnotherTypeCastingExample {

public static void main(Stringl[] args) {

float x = 3/9;

float y = (float) 3/(float) 9;

float z = (float) 3/9;

System.out.println("The value of x is: " + x +".");
System.out.println("The value of y is: " + y +".");
System.out.println("The value of z is: " + z +".");

}

The output of this program is:

The value of x is: 0.0.
The value of y is: 0.33333334.
The value of z is: 0.33333334.

Let’s now discuss why Java gives this output. For the first expression, float x = 3/9;, Java con-
siders both operands as integers and thus uses integer division. The result of this is zero, and Java
will then do the widening conversion to £loat, yielding a zero floating number. For the second
expression, float y = (float) 3/(float) 9;,Java will first perform the widening conversion
for the values 3 and 9, and then do the floating point division and assign the result to the floating
point variable y. For the third expression, float z = (float) 3/9;, Java will first do a widening
conversion to the value 3, and then do an (implicit) widening conversion to the value 9. It will then
perform the floating point division and assign the desired value to the floating point variable z.
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SUMMARY

This finishes this introductory chapter on getting to know Java. Remember, we started by discussing
the history of Java, its key features, and how the Java technology works. This was followed by an
overview of the key components of the Java Runtime Environment (JRE) and how they collaborate.
Also the different types of Java platforms and applications were highlighted. The chapter was con-
cluded by discussing the basic concepts of the Java language structure, together with the primitive
data types.
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Setting Up Your Development
Environment

WHAT YOU WILL LEARN IN THIS CHAPTER:

How and where to start programming
What Integrated Development Environments are

How to install Eclipse IDE for your own use

Y Y VY Y

How to begin using Eclipse for Java programming

WROX.COM CODE DOWNLOADS FOR THIS CHAPTER

The wrox.com code downloads for this chapter are found at www.wrox.com/go/
beginningjavaprogramming on the Download Code tab. The code is in the Chapter 3
download and individually named according to the names throughout the chapter.

The first two chapters provided you with some background and a theoretical foundation
for basic programming in Java. So that you can get started programming right away, this
third chapter takes a short detour from Java concepts to give you a development environ-
ment to start coding. In this book, Eclipse is the development environment used. However,
it is by no means the only or even the best environment. This chapter covers some of

the most commonly used development platforms, so you’ll be familiar with them if you
encounter a different environment in use on a project you join in the future. You may also
like to try the different options to see which is most comfortable for your personal use. In
order to provide consistency throughout this book, the following chapters assume you are
using Eclipse when giving directions related to the environment. There is no reason the
concepts you read in the later chapters cannot be implemented in the environment of your
choice.
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Because of the focus, this chapter is more technical, as it includes download and installation instruc-
tions and far less concept or theory about Java or basic programming. If you have been program-
ming in Java or another language, you probably already have a preferred development environment.
It should not be difficult for you to continue using that while following the exercises in this book,
even if it is not Eclipse. Just note that the figures and instructions are based on how Eclipse looks
and functions.

This chapter is organized in two main sections: introduction to Integrated Development Environments
and installing Eclipse. In the introduction, you’ll look at programming in basic text editors and
command-line execution and in more advanced Integrated Development Environments (IDE), such
as Eclipse, NetBeans, and Intelli] IDEA. The second section focuses on one commonly used IDE,
Eclipse, including how to download and install it and set it up for the first time. At the end of the
installation section, you will practice using Eclipse by creating a small program, so you can compare
programming in an IDE to programming with text editors and the command line. If you already
have a development environment, and do not need or want to investigate others, you can skip this
chapter. If you are brand new to programming, this chapter should help you get started with your
first coding experience.

INTEGRATED DEVELOPMENT ENVIRONMENTS

Integrated Development Environments (IDEs) are applications that offer programmers facilities for
developing software. IDEs include tools that support all aspects of software development, including
creating, debugging, compiling, and running the code. Typically, IDEs check your code for syntax
errors, as you type not so different from how spelling and grammar check works in word processing
programs. Debugging support allows you to move slowly and methodically through your program
to find errors. IDEs also keep track of your many projects and programs, and the files associated
with them, so you can easily organize your work.

Most of the features provided by IDEs are available as stand-alone tools, but IDEs integrate several
programming components into one user-friendly interface. An Integrated Development Environment
is not required for programming. However, in order to create and compile Java programs of your
own, you need the Java Development Kit (JDK). If you don’t have it already, you can download

the latest version from Oracle’s website at http://www.oracle.com/technetwork/java/javase/
downloads/index.html. Make sure you choose the most recent release of the JDK that is appropri-
ate for your operating system. Oracle offers the JDK for Linux (32 or 64 bit), Mac OS, Solaris, and
Windows (32- or 64-bit). If you’re using a Windows machine and aren’t sure if it’s 32-bit or 64-bit,
you can right-click on My Computer and check Properties (or go to Control Panel > System and
Security » System). You should see the system type listed there. The Windows JDK you download
from Oracle includes an installer, which will lead you through the installation step-by-step. If you
need more instructions for another system or want a more detailed explanation, installation guides
are available on the Oracle website.

Coding in Text Editors

Once you have installed the Java Development Kit, you can begin coding with simple text editors,
like Notepad, which you already have on your computer. You will try this as your first exercise,
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before learning about the different IDEs available. You learned in Chapter 1 about source code and
byte code. When you think of programming or coding, you are thinking about writing source code.
Since you’re learning basic programming in Java, you must type statements using the specific lan-
guage and structure that Java prescribes. Source code doesn’t look exactly like writing you’d read in
a newspaper, but it’s relatively readable to humans, particularly those who have learned Java basics.
It’s essentially text, and for that reason, you can write it in a text editor like Notepad or any similar
program.

After you’ve written the source code, a Java compiler can translate what you’ve written into
machine-readable byte code. That’s one of the features that your newly installed JDK offers. Once
your code has been compiled, you can run the program. In the first exercise, you’ll go through these
three steps to create, compile, and run your first Java application.

Creating Your First Java Application in Notepad

In this exercise, you code a very simple Java program in a text editor, then compile and run it from the
command window of your computer.

1. Open Notepad or a similar text editor and start a new text file. On Windows 7 and earlier, you can
open Notepad by opening the Start menu. Then under All Programs, find the Accessories folder.
In Windows 8, you can access the Apps screen by clicking the down arrow at the bottom of your
screen.

2. Enter the following code in your text file:

/**
* This is a simple Java application.
* Tt prints a short statement to the standard output.

*/

class MyFirstApplication {
public static void main(String[] args) {
System.out.println("I've coded, compiled, and run my first Java program!");
}

}

Be aware that Java code is case-sensitive, so pay attention to upper- and lowercase letters as you
type. MyFirstApplication, myfirstapplication, MyFIRSTApplication, and so on are all dif-
ferent names.

3.  Save the file as MyFirstApplication.java (as before, watch for capitalization and be consistent
between the name of your class and the filename). Save your file as a text document with the *.txt
extension. If you do not specify the encoding, the platform default converter is used. For this exer-
cise, save the file in a location that you can easily find. You should end up with something like
Figure 3-1 when you go to save.

4. Close Notepad and open a command window. In Windows 7 and earlier, you can click Start >
Run, then type emd and press Enter. On a Windows 8 machine, you can go back to the Apps screen
and scroll to the Windows System section where you will find the command prompt.
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(o N
| MyFirstApplication.txt - Notepad (=@ = ]
File Edit Format View Help

VA .

* This is a s*imﬁ"le Java application.

*/It prints a short statement to the standard output.

£ 3

class M¥F’irstApp1~ication {
public static void main(string[] args){
System.out.printin("I've created, compiled, and run my first Java program!");

| save As S5

@Ov] |, « (C)OSVolume » Users » n12063 » ~ [ 43 ][ search n12063 Pl

ZICYIeL My FirstApplication.java v

Save as type: [Text Documents (*.txt) ']

¥ Browse Folders Encoding: [ANSI v] [ Save ] [ Cancel ]

@ /

FIGURE 3-1

Note the drive that is shown when the command window opens; this is your current directory. You
can move your new Java file to this location or change your current directory to the location where
you saved your file. To change the current directory, type cd followed by the location path (the
example shown here will not be identical to your own path), and then press Enter:

cd C:\Users\nl2063\MyFiles

You can verify that your file is in the current directory by typing dir and pressing Enter. This will
show you the contents of the current directory. If you can see MyFirstApplication.java in the
list, you’re ready to proceed.

Next, you want to instruct your Java compiler to compile your program. To do so, you need to
point to the compiler’s location and then instruct it to compile your Java file. Your Java compiler
is called javac and is located in the bin folder of your JDK; it depends on where you first installed
the JDK. Navigate to the right folder and find the location path, then enter it exactly in the com-
mand prompt to tell Windows where to find your Java compiler. Start with a quotation mark,
enter the location of the bin folder, then type \javac and another quotation mark. Finally, add a
space and the name of your java file. Press Enter. It should look something like this:

"C:\Program Files\Java\jdkl.8.0 25\bin\javac" MyFirstApplication.java

You can type dir again to see if the newly compiled MyFirstApplication.class file is there. If you
see both MyFirstApplication.java and MyFirstApplication.class, you're ready to continue.
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9. You’re ready to run your program now. Enter the following prompt and press Enter:
java -cp . MyFirstApplication
10. You should end up with something like Figure 3-2 in the end.

[ [ 3 [ |
C:\Windows\system32\cmd.exe =
Microsoft Windows [Uersion 6.1.76011
Copyright (c) 2009 Microsoft Corporation. All rights reserved.
C:\Users\n12863>cd C:\Users\n120863\MyFiles
C:\Users\n120863\MyFiles>dir

Uolume in drive C is 0SUolume
Uolume Serial Number is BEA6-114E
Directory of C:\Users\n12863\MyFiles
11/06,/14 17:03 <DIR> .
11,/06/14 17:03 <DIR> -
11/06/14 16:01 272 MyFirstApplication.java
1 Filed(s)> 272 hytes
2 Dirds> 123.886.653,.440 bytes free
C:\Users\n12063\MyFiles>"C:\Program Files\Java\jdk1l.8.0_25\bin\javac" MyFirstApp
lication. java
C:\Users\n12863\MyFiles>dir
Uolume in drive C is OSUolume
Uolume Serial Number is BEA6-114E
Directory of C:\Users\n12863\MyFiles
11/06,/14 17:85 <DIR> .
11/86,/14 17:85 <DIR> -
11/606/14 17:05 484 MyFirstApplication.class
11/606/14 16:01 272 MyFirstApplication.java
2 Filed(s) 7?56 hytes
2 Dird(s)> 123,886,.940,160 bhytes free
C:\Users\n12063\MyFiles>java —cp . MyFirstApplication
I’ve created, compiled, and r»un my first Java program?
C:\Users\n12063\MyFiles>
A |

FIGURE 3-2

How It Works

Here’s how it works:

1.

In Java, source code is saved in .java files that may contain one or more classes or other types

that you will learn more about later in this book, such as interfaces, enums, and annotations. Each
source code file can contain at most one public access type and any number of non-public types.
When your compilation unit contains a public access type, like the public class in this exercise, both
the type and the .java file must have the same name. You declared a public type with the name
MyFirstApplication and stored it in a .java source code file called MyFirstApplication.java

The first few lines of code start with /** and end with */. These are special symbols that indi-
cate a block comment. Comments are not compiled or executed, so they allow you to provide
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10.

information to humans that can be ignored by the computer. Here, a comment is used to indicate
the purpose of the class. Single-line comments begin with // and function the same way.

Next, you have a class declaration class MyFirstapplication, and you’ll find the body of the class
between curly brackets: { and }.

First in your class is the declaration of your main method: public static void main (String(]
args). Remember from Chapter 2 that the main method is the entry point for execution. When a
program runs, it will start from the main method.

Inside the main method, between an inner set of curly brackets, you find the statements to be
executed. In this small example, there is only one statement: System.out .println("I've coded,
compiled, and run my first Java program!") ;. This statement prints the text you see
between parentheses to the standard output.

The last two lines contain the closing bracket of the main method and the closing bracket of the
class.

Now, the command prompts need to be explained. First, the cd prompt changes the current direc-
tory so the .java file can be located.

The dir prompt simply displays the current contents of the directory. You used it to check if the
.java and .class files were located in the current directory.

Then you pointed Windows to your Java compiler, called javac, and instructed it to com-

pile your .java file. This may be confusing, because you need to first locate your compiler.
However, if the compiler was located in the current directory, you could have just typed javac
MyFirstApplication.java, and it would find both without needing the whole path.

Finally, you used the java -cp prompt to run your program. This executes the program as
explained in Steps 1-6. You should have seen the text I've created, compiled, and run my
first Java program! printed to the command window after you pressed Enter.

You may have already encountered some difficulties in the previous Try It Out. If you typed the
program yourself, it’s possible you introduced some small typos that prevented your code from
properly compiling or running. You may have had trouble accessing the correct directory for reading
or writing your files. Integrated Development Environments can make this easier as they allow you
to write, compile, and run in the same place. They also check for errors as you type and remind you
when you misspell something or forget a punctuation mark. In the next sections, you learn about
some different IDEs and what they offer you as a developer.

Choosing an IDE

IDEs offer many tools and conveniences compared to coding in text editors and compiling from
the command line. Due to the popularity of Java, you can choose from dozens of IDEs. This book
introduces three: Eclipse, NetBeans, and Intelli] IDEA. Why these three? First, they are very popu-
lar, which means it’s easier to find support from online communities. Second, they are all available
as open source software, so you can download and use them for free. (Intelli] IDEA does have a
paid Ultimate Edition, which offers enhanced support for some more advanced features.) Finally,
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all three are available on Windows, Mac OS, Linux, and Solaris, so most readers should be able to
use any of them. In fact, they offer very similar functionality, so your choice may come down to per-
sonal preference or what the people around you are using. In the rest of this section, you look a little
closer at each IDE.

Eclipse
Eclipse Foundation (https://eclipse.org/home/) offers an online cloud-based platform and
the more common desktop version, referred to as a workbench. The workbench contains several
perspectives, each of which offers multiple views and tools to the developer. Eclipse Platform 4.4,
called Luna, was released in 2014 and includes support for Java 8. Platform 4.8 (Mars) is planned
to be released in mid-2015. Eclipse is offered under the open source Eclipse Public License. Eclipse
is associated with IBM, so it was adopted early by a huge IBM community and had the resources of
the computing giant behind its development. These early advantages made it one of the most popu-
lar IDEs available, but others are gaining popularity. Orion is the cloud-based platform that allows
developers access and to edit their code from any browser. Because it is web-based, initial support is
focused on web client languages like JavaScript, CSS, and HTML. Java development is possible, but
you will find better features in Eclipse’s desktop workbench.

NetBeans

NetBeans (https://netbeans.org/) is a modular environment where each module provides some
functionality for the developer. In this way, the environment can be expanded to meet the demands of
each project. Because NetBeans is a part of Oracle, the owner of the Java platform, it is considered the
official IDE for Java 8. NetBeans IDE 8.0 was released in 2014, and the 9.0 release is not yet scheduled,
as of the writing of this book. NetBeans is offered under a dual license of Sun’s Common Development
and Distribution License and the GNU General Public License. Because of its start as an open source Sun
project, NetBeans was more slowly adopted in the beginning; however, that is changing.

IntelliJ IDEA

Intelli] IDEA (https://www.jetbrains.com/idea/), offered by JetBrains, was devel-

oped more recently than Eclipse or NetBeans, first appearing in 2001. The most current

Intelli] IDEA 14 was released in November 2014. One difference with this IDE is they sell an
Ultimate Edition in addition to the open source Community Edition. It is available at vary-

ing prices for different categories of users (you can see the different licensing options at
https://www.jetbrains.com/idea/buy/license-matrix.jsp). For programming beginners, the
premium features are probably not necessary; the Community Edition should be more than suffi-
cient to get you started.

Continuing with One IDE

It’s probably not easy to choose an IDE right now. After all, you’ve only been briefly introduced to
three popular choices, and if you’ve never programmed before, you probably don’t even know what
you’re looking for in a development environment. However, for cohesiveness in this book, from this
point forward only one IDE will be used. All the exercises, figures, and instructions you’ll find in the
other chapters are based on the Eclipse IDE. This is not to say that Eclipse is better than the others,
but it will be easier for you to follow if everything in this book remains consistent.


https://eclipse.org/home/
https://netbeans.org/
https://www.jetbrains.com/idea/
https://www.jetbrains.com/idea/buy/license<2010>matrix.jsp
https://www.jetbrains.com/idea/
https://www.jetbrains.com/idea/buy/license-matrix.jsp
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If you have a preference for one of the other IDEs, already have one installed on your computer, or
work in a company or group that expects you to use their choice, you can still follow along with the
exercises on another platform. Some of the images and instructions won’t entirely match what you
see on your screen, but the code will be the same and the process will be quite similar.

On the other hand, if you proceed with Eclipse now and want to try the others later, they all offer
facilities to transfer projects from one platform to the other. There are many help resources devoted
to assisting users of other environments to quickly learn their way around a new environment. The
skills you develop programming in Eclipse are transferable to other environments.

INSTALLING ECLIPSE ON YOUR COMPUTER

In this second section of this chapter, you learn how to download and install Eclipse. Before finish-
ing, you’ll have a chance to try out the Eclipse environment and compare the experience to coding
in a plain text editor. If you already have Eclipse or another IDE running on your machine, this may
be redundant. In that case, you may want to proceed to the next chapter, where you can start right
away with Object-Oriented Programming.

Earlier in this chapter, there were instructions for downloading and installing the Java Development
Kit (JDK) from Oracle. In order to program in Java, whether compiling code from your text editor
or using an IDE, you need the JDK. Be sure you have installed it before you continue. You need it to
develop Java programs in Eclipse.

Downloading and Installing Eclipse

If you do not have Eclipse on your computer, you can follow these instructions to download and
install it. Eclipse 4.4.1 (Luna release) includes support for Java 8, so it’s recommended that you use
this or a later version. If you have an older version of Eclipse, you can update to Luna by following
these instructions. If you must continue using Eclipse 4.3.2 (Kepler), you can find a Java 8 patch that
offers preliminary Java 8 support. You can download the standard Eclipse platform from Eclipse
packages that bundle some additional components.

The standard Eclipse platform is sufficient to complete the exercises in this book and offers enough func-
tionality for most beginner programmers. You can download it from http://download.eclipse.org/
eclipse/downloads/. Make sure you choose the most recent build date under Latest Release. Click on
the build name, and you should see a list of Eclipse SDK options, as shown in Figure 3-3. As with the
JDK, you’ll have to choose the version that matches your operating system. Click on the corresponding
(http) under the column heading Download to access the download site. Your download may begin auto-
matically, or you may need to press the green arrow to download the compressed file.

If you prefer to download a package, Eclipse IDE for Java Developers offers some extra tools for
developers. You can download a package from http://eclipse.org/downloads/. Figure 3-4
shows you where to look for the Java Developer package. There is a drop-down to select your oper-
ating system. Once you choose the correct platform, click on the link for the correct version.

Once you have downloaded the ZIP (compressed) file, you need to unzip (decompress) it. Inside the
decompressed folder, you should see the icon for starting Eclipse. The icon from the Luna release is
shown in Figure 3-5.


http://download.eclipse.org/eclipse/downloads/
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Eclipse SDK

Platform Download Size File Checksum
Windows (http) 197MB eclipse-SDK-4.4.1-win32zip [SHA512)
Windows (x86_64) (http) 197MB  eclipse-SDK-4.4.1-win32-x86_64zip [SHA512)
Linux (x86/GTK+) (http) 195MB  eclipse-SDK-4.4.1-linux-gtk tar.gz [SHA512)
Linux (x86_B4/GTK+) (http) 195MB eclipse-SDK-4.4.1-linux-gtk-x86_64 tar.gz [SHA512)
Linux (PPCIGTK+) (http) 195MB eclipse-SDK-4.4.1-linux-gtk-ppc.tar.gz [SHA512)
Linux (PPCB4/GTK+) (http) 195MB  eclipse-SDK-4.4.1-linux-gtk-ppe6a.tar.gz [SHA512]
Linux ($3900GTK+) (http) 195MB  eclipse-SDK-4.4.1-linux-gtk-s390x tar.gz [SHA512)
Linux (s390/GTK+) (http) 105MB  eclipse-SDK-4.4.1-linux-gtk-s390.tar. gz [SHA512)
Linux (PPCBALE/GTK+) (Early Access)  (http) 105MB  eclipse-SDK-4.4.1-linux-gtk-ppe6dle tar.gz [SHA512)
Solaris 10 (SPARC/GTK+) (http) 196MB  eclipse-SDK-4.4.1-solaris-gtk zip [SHA512)
Solaris 10 (x86/GTK+) (http) 196MB  eclipse-SDK-4.4.1-solaris-gtk-x86 zip [SHA512)
HP-UX (iaB4/GTK+) (http) 196MB  eclipse-SDK-4.4.1-hpux-gtk-ia64 zip [SHA512)
AIX (PPCIGTK+) (http) 196MB  eclipse-SDK-4.4.1-aix-gtk-ppc zip [SHA512]
AIX (PPCB4/GTK+) (http) 197MB eclipse-SDK-4.4.1-aix-gtk-ppc64.zip [SHA512)
Mac OSX (Mac/Cocoa) (http) 105MB  eclipse-SDK-4.4.1-macosx-cocoatar.gz [SHA512)
Mac OSX (Mac/Cocoalx86_64) (http) 105MB eclipse-SDK-4.4.1-macosx-cocoa-x86_64.tar.gz [SHA512)
FIGURE 3-3

Eclipse Luna (4.4.1) Release for

Windows
. Linux
Eclipse IDE for Java Developers, 152 ve Mac OS X (Cocoa)
Downloaded 3,118,625 Times =
@ ‘ Windows 32
The essential tools for any Java developer, including a Java [ Bit
IDE, a CVS client, Git client, XML Editor, Mylyn, Maven Windows 64
integration... Bit
FIGURE 3-4

% eclipse.exe

FIGURE 3-5

You can create a shortcut to this file on your desktop or in your Start Menu to make it easier to find
and open Eclipse. When you’re ready to proceed, open the eclipse.exe file to start the program.
When you open Eclipse, it will ask you where you want to store your workspace. This is a folder
where all your projects are stored. You can check a box to save that location as the default and not
have to confirm the location every time you open Eclipse. If you work with different workspaces,
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such as one for work and one for personal use, you might want to leave this box unchecked and
select the appropriate workspace each time you open Eclipse.

Using Eclipse

After you choose your workspace, Eclipse opens to the Welcome screen, shown in Figure 3-6, by

default. From here you can link to some introductory materials for Eclipse, including tutorials,

samples, and an overview of features and updates. Take your time exploring. When you’re ready,
[13 »

you can close the Welcome screen by pressing the white “x” next to the Welcome tab or by clicking
the arrow in the top-right corner to proceed to your workbench.

© Java - Eclipse @E@
Eile Edit Navigate Search Project Run Window Help
‘= | @ welcome 52 2 A= e
Cosedpe
Welcome to the Eclipse IDE for Java Developers
4 Overview Tutorials
Q Get an overview of the features w Go through tutorials
©4) Samples /\_ What's New
~ Try out the samples Find out what is new
FIGURE 3-6

Your workbench should look similar to the workbench shown in Figure 3-7, from the Eclipse
IDE for Java Developers of the Luna release. It is divided into several views, which give you
access to different information and tools. The views can be thought of as sub-windows, where
one activity or display is contained. A perspective groups together a particular set of views nec-
essary or helpful for a particular task. By default, you are shown the Java perspective, which is
a collection of views used when programming in Java. In this perspective, you’ll see the Package
Explorer on the left, the Code Editor in the center, the outline of the current class on the right
(with the task list above it if you’re using the Java developer package), and a series of tabs at the
bottom.
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f & Java - Eclipse [E=ET)
File Edit Source Refactor Navigate Search Project Run Window Help
Awhahend SR R R N RS TR R e e auick Access | % | (ET3ava)
[% Package Explorer &2 = 0 = B [ TaskList 2 = 0
B8G|e v rFEEHEIRN

24

Find Q| » Al » Activ..

@ Connect Mylyn b

Connect to your task and
ALM tools or create a
local task.

95 Outline 52 = 8
-

-
An outline is not available.

[®R Problems 52 @ Javadoc [ Declaration ® ven
0items
Description Resource Path Location Type

FIGURE 3-7

In the Window menu, you can change the perspective, for instance the Debug perspective includes the
views linked to the debugging facilities in Eclipse. You can close or minimize views by clicking the x or - in
the top-right corner of each view, similar to how you close and minimize windows in the Windows operat-
ing system. You can add other views by selecting Show View from the Window menu (see Figure 3-8). You
can rearrange the views in your workbench by clicking and dragging on the title bar of the view.

One recommendation for customizing your Java perspective is to remove the Package Explorer and
replace it with a Project Explorer. The two look very similar in that they show you a list of your
projects and the packages and classes included in them. However, the Project Explorer will display
a red “x” on classes that have unresolved errors. This makes it much easier to spot code that needs
your attention, especially when you start working with multiple classes in the same project.

[I3E]

To close the Package Explorer, you can just click the white “x” in the top-right corner of the Package
Explorer tab. You’ll notice when you close it, your Code Editor will stretch to fill the space. To add the
Project Explorer, click Window and choose Show View. If Project Explorer is displayed there, you can
select it. If not, click Other and you’ll find it in the General folder. When you open the Project Explorer, it
will take the place of the Package Explorer, and the Code Editor will shrink back to the center again.

Java programs are organized in a project hierarchy in Eclipse, as depicted in Figure 3-9. Projects

are the top-level folder. You should use one project for each program you are working on. Projects
are divided into packages that keep related Java classes together. Packages are a Java construct that
serves not only to organize your class files, but also allows you to specify a specific class based on its
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package location. You can have several classes with the same name, but by referring to its package,
you can distinctly identify one class. Projects can also contain folders that can be used to store other
non-class files, such as text or image files associated with your program.

R
Y
File Edit Navigate Search Project Run (Window) Help

T New Window pe auick access || g9 | ()
7 Editor »

{2 Package Explorer 7 =48 Hide Toolbar $¢ JavaBrowsing = 8 [@Teskustx’ =D
B&|les - =| §
8% [ Open Perspective » Other... g |@%-|0‘|\“

| Show View »| % Ant )
8 | consote TR » All » Activ..
[@ Declaration Alt+Shift+Q, D
@) Error Log Alt+Shift+Q, L
@_ Javadoc ARESIIEQ.Y @® Connect Mylyn b4
% | Navigator Connect to your task and
2= Outline Alt+Shift+Q, O ALM tools or create a
{2 PackageExplorer  Alt+Shift+Q, P lacal task:
> Palette 2= Outline 53 =8
Problems Alt+Shift+Q, X » v
=g Progress An outline is not available.
[ Project Explorer
4 Search Alt+Shift+Q, S
1 Structure
Task List Alt+Shift+Q, K
& Tasks
&5 Templates
e Type Hierarchy Alt+Shift+Q, T

Alt+Shift+Q, Q

[£2 Problems £ @ Javadoc [ Declaration e TEH
Oitems
ll)oscrwon

7

FIGURE 3-8

Java

Class Files

Project

\ Other

Folder —_ Files

FIGURE 3-9
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You are now ready to start your first project in Eclipse. The following exercise takes you through
the process step-by-step, to help you get acquainted with Eclipse and how its projects are organized.
You’ll follow very similar steps in every exercise that follows in this book.

Creating Your First Java Application in Eclipse

In this exercise, you create a very simple Java program. You will code, compile, and run it all within the
Eclipse development environment.

1.

Open Eclipse and select the workspace you want to use. This is where your project will be saved by

default.
2.

Go to File » New » Java Project to create a new project. You will see a New Java Project window,
like the one shown in Figure 3-10, to input information about the project.

[ S New Java Project | &)
Create a Java Project
Enter a project name.

Project name:

Use default location

Location: | C:\Users\n12063\workspacejava Browse...

JRE

@ Use an execution environment JRE: JavaSE-1.8

v

© Use a project specific JRE: jre1.8.0_25

© Use default JRE (currently ‘jre1.8.0_25") Configure JRES...

Project layout
© Use project folder as root for sources and class files

© Create separate folders for sources and class files Configure default...

Working sets
[T Add project to working sets
Working sets: v Select...
@ < Back Next > Finish
FIGURE 3-10

3. Type myFirstJavaProject for the project name.

4. Leave the default settings for the remaining fields. Check that the execution environment is the
most recent Java. JavaSE-1.8 is the most recent as of the printing of this book.

Click Finish to create your project. You should see the project appear in your Project Explorer (or
Package Explorer if you did not change the view).
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If you double-click on the project name or press the small arrow to the left of the project, you will
see the contents of the project folder. Right now, it contains a folder called src, which stands for
source, and the JRE System Library for the Java release attached to this project, JavaSE-1.8, in the
book examples. The src folder is still empty since you have not created any source files yet.

Create a package to organize your source files. This step is not necessary, as putting class files

directly into the src folder will place them in a default package. However, using this default pack-
age is discouraged. As you develop larger programs, it will become more important to use packages.
Add a package by right-clicking on the project or src folder, as shown in Figure 3-11, or choosing

File » New » Package.

r
£ Java - Eclipse

[ Project Explorer £2 = m

B \):DI v
4 (& myFirstJavaProject

File Edit Navigate Search Project Run Window Help
S S L LR O Qe v G 8 R v e e

-

-

-

Quick Access ‘ = | 45 Debug ) Java Browsing

(=X

New
> = J

Go Into

Open Type Hierarchy
Show In

Copy

Copy Qualified Name
Paste

Delete

Remove from Context
Build Path

Source

Refactor

® B @ @

Import...
Export...

LE

Refresh

£

Debug As

Run As

Validate

Team

Compare With

Restore from Local History...
Maven

< Properties

F4
Alt+Shift+W »

Ctri+C

Ctri+v

Delete

Ctri+Alt+Shift+Down
>
Alt+Shift+S »
Alt+Shift+T »

F5

Alt+Enter

a

20 eRee@ee

Project...
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Class
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Interface
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Source Folder

Example...

Other...
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Declaration

Resource

= B [l TaskList 22 =8
g-I@Bxl ol x®

4

[Fina_ Q] » AN » Activ..

@® Connect Mylyn Py

Connect to your task and
ALM tools or create a
local task.

5= Outline 52 =0
s ©
L
An outline is not available.

Path Location Type

FIGURE 3-11

A New Java Package window, like the one shown in Figure 3-12, will appear. Indicate which
project this package belongs to and the name of the package. The source folder should say
MyFirstProject/src; it may automatically enter this or you may need to enter it yourself. You
can also find the correct project location using the Browse button. Name the package myPackage
and press Finish. You should see the package appear under the src folder in your project. The
square package icon will be white, indicating that it is empty.
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Shewmamenge o)

Java Package
Create a new Java package. i

Creates folders corresponding to packages.
Source folder: MyFirstJavaProject/src l_gu,_|

Name: - myPackage J
Create package-info.java

FIGURE 3-12

Now you need to create a new class. As with the package, you can do this multiple ways. You can
right-click on the project name, the src folder, or package and select New > Class, as shown in
Figure 3-13. You can also choose File » New » Class. In either case, a New Java Class window will
appear, where you enter information about your class, as shown in Figure 3-14.

Swwemee s el
File Edit Navigate Search Project Run Window

auickaccess | g5 | (ET0av) 4 Debug 52 JavaBrowsing
W poctempore 5| =0 =0 Hmms -0
B%le - g-I@el elxn
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»2:"‘"’ » | Project... [[Fina Q] » AN » Activ..
gome @ Amomson
Open Type Hierarchy FA |@ Class
Show In Alt+ShiftsW» | ( Enum @® Connect Mylyn =
& Interface Connect to your task and
Eopy EhRE & Package ALM tools or create a
2 Copy Qualified Name local task.
o Ctrey | 89 Source Folder
* = 5= Outline 52 = 8
B0 Delete Example- o v
2 Remove from Context Ctri+AltsShiftsDown @
= Other... CtrisN
e N [m] An outline is not available.
Source Alt+Shift+S »
Refactor Alt+ShiftsT »
i Import...
i Export..
&) Refresh 5
Debug As »
RunAs * | @ peciaration ® Y=o
Validate
Team v Resource Path Location Type
Compare With »
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Enter MyFirstApplication as the class name. Make sure the source folder refers to the correct proj-
ect and the package refers to the correct package. You can leave the Modifier set to Public and the
Superclass set to java.lang.0Object. None of the checkboxes need to be checked. You will learn
much more about these concepts as you continue through the book. Press Finish to create your class.

You should see some code already written in the Code Editor. Also, the view should now include the
tab MyFirstApplication.java, the source file for your first class. If some of your checkboxes were
checked, you might have more code automatically provided than what is shown in Figure 3-15.

Below the package myPackage; line, type /** and press Enter. You should see a blue comment
block appear with space for you to enter comments about your class. It may include the @author
information if your computer has some user information saved. You can delete or edit this if you
like. Add a comment describing your class after one of the * symbols. It should look something like
this:

/**
* This is a simple Java application.
* Tt prints a short statement to the standard output.

*/

Below this comment, you will see public class MyFirstApplication {, then a blank line and }. In
between the two curly brackets, where the blank line is, you can add the code for your class. This is
a very small program, so you only need a main method. Add it so the class looks like the following:
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public class MyFirstApplication {
public static void main(Stringl[] args) {
System.out.println("I've coded, compiled, and run my first Java program!");
}

(& Java - myFirst. j ge/MyFi ication.java - Eclipse BT
File Edit Source Refactor Navigate Search Project Run Window Help
e @iplsE IRty QO Y Qi @ ri®O B YIS vl Gy

Quick Access | [ | [ Java ] 5 Debug 5 Java Browsing
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FIGURE 3-15

14. Save your files. Again, there are multiple ways of doing this. Choose File > Save or press Ctrl+S to
save the class you are currently working on. Choose File » Save All or press Ctrl+Shift+S to save
all the open classes. Notice that unsaved files have an asterisk (*) next to their name in the Code
Editor tab. Once they are saved, this * will disappear. You can see an example of this in the top-
left corner of Figure 3-16.

15. You’re ready to run your program now. Go to Run > Run to compile and run your application.
If you have not saved your files, Eclipse will warn you and offer to save them for you. You can
check the box to instruct Eclipse to always save your files before running. After the program runs,
you should see a new Console tab displayed in the bottom view. This is where standard output is
printed in Eclipse. The bottom view will look something like Figure 3-17.
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FIGURE 3-17

How It Works

Here’s how it works:

1. In Eclipse, every Java project is stored in its own location, referred to conveniently as a project.
You created your first project called MyFirstJavaProject to store all the components required for
the project in this exercise.

2. Next, you created a package. A package acts as a folder for related class files.

3. You created a class and placed it inside this package. The first line of your class reads package
myPackage; and indicates where the class is located. The word package is a keyword in Java, so it
is shown in a bold purple font to highlight it.

4.  After the package declaration, there are a few lines of code that start with /+* and end with */.
These are special symbols that indicate a block comment. Comments are not compiled or executed,
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10.

1.

so they allow you to provide information to humans that can be ignored by the computer. Here,
comments are used to indicate the purpose of the class. Single-line comments begin with // and
function the same way. In Eclipse, unlike in very basic text editors, comments are colored to set
them apart from other parts of the code. Block comments are displayed in blue while single-line
comments are displayed in green.

Next you have a class declaration public class MyFirstApplication, and you’ll find the body
of the class between curly brackets { and }. The public modifier indicates that classes outside
the package can access this class. This concept was introduced in Chapter 2 but will be covered in
more detail in Chapter 4.

The first statement in your class is the declaration of your main method: public static void
main (String[] args).Remember from Chapter 2 that the main method is the entry point for
execution. When a program runs, it will start from the main method. Sometimes you will see a
notification from Eclipse that it is searching for the main method before it can run a program. You
may also see an error if the main method cannot be found. You should always check to be sure
that your program has a main method (if you want to run it) and that the declaration is correct and
Complete. It should always start: public static void main (Stringl[] args) {.

Inside the main method, between an inner set of curly brackets, you find the statements to be
executed. In this small example, there is only one statement: System.out .println("I've coded,
compiled, and run my first Java program!") ;. This prints the text you see between the
parentheses to the standard output. In Eclipse, the standard output is the console.

The last two lines contain the closing bracket of the main method and the closing bracket of the
class.

Unlike the exercise using the command window, Eclipse manages the compilation and execution
of your program for you. When you click Run, the .java source file is compiled to a .class
machine-readable file. After compilation, the program is executed.

After execution, you should have seen the text I've created, compiled, and run my first
Java program! printed to the Console tab in the bottom view of your workbench.

If there were any errors, you can simply edit the class file in the Code Editor view and re-run the
program. Also, if there were typos or other mistakes, Eclipse can often highlight these the way a
word processing program will show you misspellings and grammatical errors. The code checker
and the seamless integration of coding, compiling, and executing are some of the many benefits a
new programmer will enjoy when using an IDE compared to command-line programming.

In addition to the menu bar and right-click options, Eclipse has a row of buttons you can use for
many common operations. Some of the buttons are shown in the next few figures with a short
description of what they do. The first set of buttons on the far left are from the File menu. The first,
an icon of a window with a yellow plus sign, allows you to create new projects, packages, classes,
and so on. The next looks similar but shows some details inside the window icon; this is for creating
new graphical components. The icon of a single floppy disk is the equivalent of choosing File > Save.
The icon of a stack of three floppy disks is the equivalent of choosing File > Save All. The last one in
this panel, an icon of a printer, is for printing. These icons are shown in Figure 3-18.
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FIGURE 3-18

The second button panel includes some different display options for the Code Editor view. The third
panel includes a bug icon for debugging your programs, a green play button for running your pro-
grams, and one other button for running external tools. The first two, debug and run, are most use-
ful at this point. This panel is shown in Figure 3-19.

5 Qv Q-

FIGURE 3-19

Five more buttons that you might find useful are in the next two panels, shown in Figure 3-20. The
new package button has an icon that matches the package icon in the Project Explorer, which is a
small brown square with a cross through it. Next to it is a green circle with a C and a plus sign; this
is a shortcut to create a new class. You can change it from a class to another type with the drop-
down arrow beside it. The yellow folder with a blue ball and a green ball is for opening classes (or
other types). If you are using the IDE for Java Developers, there’s a yellow folder with a white box
in it; this is for opening a task. Finally, there is an icon of a yellow flashlight, which opens the search
window.

HFEY®@ES 9~
FIGURE 3-20

Now that you’ve had a tour of Eclipse, you’re prepared to continue with the rest of this book. In the
following chapters, there will be many exercises to demonstrate Object-Oriented Programming con-
cepts in Java. They are written with the Eclipse IDE in mind, so you can refer back to this chapter if
you need a refresher on some of the basic technical aspects of creating programs in Eclipse. You can
also find a wealth of resources online from Eclipse if you’re having trouble with something. Also, as
stated earlier, if you prefer to use another development environment, you will still be able to follow
along, but the instructions intended for Eclipse won’t exactly match your IDE. The many platforms
available, including NetBeans and Intellif IDEA as well as many others, are often similar enough
that you can easily adapt from one to the other.
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Moving Toward Object-
Oriented Programming

WHAT YOU WILL LEARN IN THIS CHAPTER:

> What is Object-Oriented Programming and why it is useful

>  How to work with classes and objects and the differences between
them

>  How variables are defined and what is meant by their scope
>  How methods are defined and what is meant by their scope

>  Some of the frequently used standard classes

WROX.COM CODE DOWNLOADS FOR THIS CHAPTER

The wrox.com code downloads for this chapter are found at www.wrox.com/go/
beginningjavaprogramming on the Download Code tab. The code is in the Chapter 4
download and individually named according to the names throughout the chapter.

Now that you’re familiar with programming in general, understand Java’s general concepts, and have
set up your development environment, it’s time you delve into Java for real. Chapter 2 highlighted

the fact that Java is an object-oriented programming language, meaning that objects, with their

data variables and methods, are first-class citizens in Java and that defining a well-thought-out class
architecture is the foundation of any solid program or application you will develop.

This chapter is organized as follows. The first section provides a general overview of the basic
concepts of the object-oriented programming paradigm. Next, it discusses how to work with
classes and objects in Java. This is then further explored in the following sections, which
explain in more detail how to define data (variables) and behaviors (methods) for classes. The
final section in this chapter provides an overview of helpful built-in classes in Java SE, which
will be used throughout this book as well.


www.wrox.com/go/beginningjavaprogramming
www.wrox.com/go/beginningjavaprogramming
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BASIC CONCEPTS OF OBJECT-ORIENTED PROGRAMMING

As you saw in Chapter 1, object-oriented programming is a programming paradigm where concepts
in the program are represented by “objects.” Each object is an instance of a class, which can be seen
as a “blueprint” or template of the object’s characteristics. Contrary to procedural programming,
these characteristics include data—attributes or variables describing the object’s state—and behav-
iors—methods or procedures describing the actions an object can perform.

A simple example can help explain this. Imagine you are developing an application to keep track of
courses and student registrations. In procedural programming, your first task would be to come up
with an appropriate data structure to represent the concepts you are dealing with. You thus might
define two lists—one for holding the students and one for holding the courses. Each list would con-
tain a dictionary of values representing a single student or course. This might look as follows:

STUDENTS = [
{id : 's0001', last: 'Demmick', first: 'Larry', birthdate: '1989-05-13'},
{id : 's0002', last: 'Newandyke', first: 'Freddy', birthdate: '1991-01-05'},

COURSES = [
{id : 'CO0A', name: 'Introduction to Java'},
{id : 'C00B', name: 'Advanced Data Base Management'},

Pay no attention to the syntax being used here—it’s just pseudo-code to illustrate the point. The fol-
lowing step defines a series of operations—procedures—that you want to perform on your concepts.
For example, you’ll need a procedure to add a student:

procedure add_student (i, n, fn, bd) {
STUDENTS += {id : i, name: n, firstname: fn, birthdate: bd}
}

Similar procedures can be created to add courses and to remove or modify students and courses.
You also might want to keep track of which students registered for which courses. Multiple pos-
sibilities exist as to how to approach this: you can either add a list of course IDs to each student
(representing the courses the student registered for), or a list of student IDs to each course (repre-
senting the students registered for this course). Another way to do this is to create an additional data
structure—REGISTRATIONS—to keep track of registrations.

Procedural programming has substantial drawbacks from a maintenance viewpoint. For one, when
the definition of a data structure changes, all procedures using this structure need to be reviewed
and updated accordingly. Second, when data structures are linked, care needs to be taken that the
state of the program is kept valid at all times. When deleting a course in this example, for instance,
youw’ll also need to ensure that all registrations for this course are removed as well. The greatest
drawback comes from the fact that all data is stored in global structures, which are accessible to all
procedures. For large programs, it becomes unwieldy to keep track of which procedures are using
which structures, how they modify them, and what effect a change in one procedure or data struc-
ture will have in other parts of the program.
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When using an object-oriented programming paradigm, objects encapsulate only local data, which
is by default accessible only by the object itself. Rather than having to think about data and code as
two separate concepts, an object-oriented program merges the two in the concept of an object. This
increases understanding (analysts and programmers can consider objects of interest without inter-
nalizing the workings of the complete program) and ease of maintenance.

To realize the latter, object-oriented programming applies two concepts known as encapsulation
and information hiding. One of the greatest sources of errors in programs is when some parts of the
program are interfering with other parts. Indeed, it is easy to see that, in this course administration
example, the addition of more procedures and data will quickly lead to so-called spaghetti code,
where it becomes very complex to follow the trace of execution as data can jump from one part to
another in the program. Object-oriented programming resolves this issue by encapsulating both
data and behavior within an object.

However, this in itself is not sufficient to guarantee maintainable programs, as you also

need to prevent an object’s data from being directly accessible by other objects. Therefore,
object-oriented programming also emphasizes the concept of information hiding, where an
object’s data can by default be accessed only by methods contained in the same object. When
data elements of one object need to be used by another object, the latter must call a publicly
accessible method of the former, basically requesting the “owning object” to perform a change
to its data. As such, object-oriented programming encourages programmers to place data where
it is not directly accessible or modifiable by the rest of the system. Instead, the data is accessible
through methods, which can also include checks and safeguards to make sure the requested
change is permitted by the owning object.

Object-oriented programming also defines concepts to help with structuring programs so that
they can be easily extended and evolved. These concepts are polymorphism, which is the ability
to treat objects of different types in a similar manner, and inheritance, which is a concept to
allow for extending objects and enabling code reuse. You will revisit these concepts in more detail
in Chapter 8, when you delve deeper into object-oriented concepts. For now, you’ll see how the
object-oriented concepts you have seen so far—the classes, objects, variables (data), and methods
(behavior)—are used in Java.

CLASSES AND OBJECTS IN JAVA

Now that you have gained knowledge on the basics of Java, it is time to move on to the topics that
make Java an object-oriented language: classes and objects. The following sections will guide you
through the concept of a class, which serves as a declaration, or blueprint, for objects, which can be
instantiated from classes.

Defining Classes in Java

As discussed in Chapter 2, Java is a “pure” object-oriented programming language, meaning
that there are no standalone constants, variables, or functions. It is not possible to define such
standalone elements, and everything is thus accessed through classes and objects. Before version
5 of Java, primitive types (such as int and double) were not represented as objects, a decision
made by Java’s designers for performance reasons. Due to this, Java was not considered to be a
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pure object-oriented programming language. However, Java 5 introduced a concept called auto-
boxing, where programmers can access primitive types as if they were instances of their wrap-
per class.

AUTOBOXING

Autoboxing is an automatic conversion made by the Java compiler between primi-
tive types and their corresponding wrapper classes. For example, converting a
double to a Double is called boxing, and converting a Double back to a double is
called unboxing.

For each primitive type, there is an associated wrapper class available:
boolean wrapper class: Boolean

byte wrapper class: Byte

char wrapper class: Character

float wrapper class: Float

int wrapper class: Integer

long wrapper class: Long

short wrapper class: Short

double wrapper class: Double

Y Y Y VY Y VY VY VY Y

void wrapper class: Void

The void wrapper class does not actually hold a value but is a representation for
the void return type.

The mechanism of autoboxing entails that it is perfectly fine to write code like this:

Double dl 5.4;
double d2 = new Double(3.3);

You might be wondering if it makes sense to use the primitive types’ wrapper
classes instead of the default keywords. The best practice, however, is simply to
use the primitive keywords and the wrapper classes only when you need to, that
is, when you want to access a primitive variable as an object. Later in this chapter,
when you read about Java’s collection types, you will see a typical use case where
this is necessary.

In Chapter 2, you read an overview on Java’s language structure, including the syntax for classes,
methods, and variables, and the different types in Java. Don’t worry if you don’t recall all the
details, as you will revisit these concepts again in the following sections and learn about them
step-by-step.
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You’ll now convert the example of the course administration system to an object-oriented Java pro-
gram. The first thing you need to do is define the concepts—the blueprints, templates, and types—
that will be used in your application. These are the classes. In this example, you can introduce two
class definitions: one for a course and one for a Student.

A2 ar etk Course and Student Classes

To create some simple Java classes representing students and courses, follow these steps:

1. If you haven’t opened a project in Eclipse, or just prefer to follow along and create a new one, you
should do so by navigating to File » New and then selecting Java Project in Eclipse. A dialog win-
dow will open asking you to fill in a project name. Choose CourseAdministration. You can then
press Finish to create the project.

2. You will create two classes within the src folder: course.java and student .java. You do so by
right-clicking the src folder in the package explorer in Eclipse and then selecting New » Class. A
window will pop up asking you to fill in some details. The number of options offered might seem
a bit daunting at first, but remember that the only necessary element you need to provide is the
class name. All other aspects can be modified directly in the class’ source code, or changed by mov-
ing the class around. Let’s start with the student class. In the wizard screen, you should enter the
class name without the .java suffix, as Eclipse will add this for you (you will receive a warning
when you do add the file suffix). Do not pay attention for now to the "The use of the default
package is discouraged" warning. You’re just starting out, and can thus afford to be a bit
sloppy. You will learn about packages later.

3. The student.java file is created and opened in the Eclipse code editor (if it is not, you can double-
click the file to open it in the Eclipse editor), showing a bare-bones class definition:

public class Student {
}

4. Edit student .qava to look like the following:

class Student {
int id;
String firstName;
String lastName;
int birthYear, birthMonth, birthDay;

}

5. Save your file. You have now created a bare-bones class definition for the student concept,
containing variables for the ID, first name, last name, and date of birth. (For now, you’ll use a
combination of three integers to represent the date of birth. There is also a Date class that will be
discussed later.)

6.  Similarly, create a Course. java class with the following source code:
class Course
int id;
String name;
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How It Works

Now take a look at how it works.

1. InJava, classes are stored in .java files, which should bear the same name as the class that is
defined in them. In the first two steps, you initiate a new Java project in Eclipse and add two class
source files using the wizard: Course.java and Student . java.

2. The student and course classes are defined by declaring some variables, such as id, firstName,
and birthYear. You remove the public declaration Eclipse has automatically added to the class
source, as you will learn about access modifiers (such as public) later.

3. Thisis all you do for now. You’re not actually running or executing anything yet. Feel free to
experiment, however, by adding more variables you can think of using the primitive types you saw
in Chapter 2 to familiarize yourself with the syntax (Eclipse will provide errors or warnings when
you make a mistake).

If you’ve followed along with the Try It Out, you will have noticed that a class definition looks pretty
straightforward at this point:

class CLASSNAME {
// VARIABLE DEFINITIONS
}

That is, class definitions start with the keyword class, followed by the class name. Java imposes
almost no restrictions on which characters or names you can use for class names, except for the fact
that class names should start with a letter, the underscore character (“_”) or a dollar sign (“$”). The
following names can all be valid class names:

> Course
Student
abcde
Number0
$DOLLARS$
2o

nangas

Y Y Y VY Y Y Y

Remember, as discussed in Chapter 2, keywords are not valid class names, meaning that class, true,
null, and so on are not accepted as class names.

In general, however, it is a very good idea not to go overboard when defining classes and to stick to
(western) alphabetical characters only. If you recall the section on naming conventions in Chapter 2,
you will remember that you format class names in UpperCamelCase (meaning that each word in the
class name starts with a capital letter). This is the widely accepted convention in the Java community,
and one this book follows as well.
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NOTE By the way, you might have tried to create a class named "“#/E" in
Eclipse, only to have it show up as an empty file with Eclipse throwing a warn-
ing about character encodings. The reason for this is that Eclipse by default
uses a subset of all possible characters for source code, called cp1252. While
this subset contains most Western characters, it does not contain Chinese,
Japanese, Thai, or other characters found in non-Western languages. This
implies that it is also not possible to include code such as this:

System.out.println("The word for student in " +
"Chinese and Japanese is written in the " +

"same way: SFA4M);

If you want to use all characters in Eclipse source code, you will need to

open the Preferences window, navigate to General » Workspace, and then
select Other: UTF-8 under Text File Encoding. This will ensure that Eclipse
saves your source files with Unicode encoding, and will thus allow you to use
Unicode class names and output. (Unicode is a gigantic character set support-
ing and containing almost all character glyphs in use by humanity today; see
www.unicode .org for more details.)

Before you rush off to the preferences to change this setting, keep in mind,
however, that changing the source file encoding is generally a bad idea. The
reason for this mainly stems from portability and compatibility. Not all oper-
ating systems and Java versions support Unicode equally well, meaning that
Unicode characters that look and open fine on your workstation (with your ver-
sion of Eclipse) might not show up correctly on other people’s machines.

But what if you just came up with a killer application and want to target the
Chinese market? Surely, it should be possible to translate your program? When
that happens, you have two ways to make this work. The first is to change your
source file encoding (and deal with portability issues as they pop up). The sec-
ond way is to use “escape” Unicode characters, like so:

System.out.println("The word for student in " +
"Chinese and Japanese is written in the " +
"same way: \u5B66\u751F") ;

To escape a Unicode character, you write a backslash (\), followed by the low-
ercase letter u, followed by four hexadecimal (0-9, A-F) characters represent-
ing the code point of the character. You can find tables and websites helping
out with this task online. One such example that allows you to look up charac-
ters is: http://www.fileformat.info/info/unicode/char/search.htm

As a final note, you might have tried one of these code samples in Eclipse to
see if the text appears in the output, only to see two question marks (??) or
garbled text appearing where the Unicode characters should be. The reason
behind this is that not only does your editor need to enable support for saving
Unicode files, your console—which runs the program—must also be able to

continues
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continued

show them. By default, neither the Eclipse console nor the Windows console
offers support for this (showing Unicode code characters in GUI applications,
however, will work). On Linux—another operating system—the console does
support Unicode character output.

This all being said, I'm sure you will agree that character encodings,
Internationalization, and Unicode is a complex affair. In fact, this is not a
problem with Java itself. Java actually provides very solid Unicode support
compared to most other programming languages. This problem plagues all
aspects of computing, programming, and software engineering. Computers
in the 80s did not deal with languages other than English and thus supported
only a very small, basic set of characters, the effects of which still have an
impact on programming languages today. As such, | will keep things simple
throughout this book and work with basic Western characters only.

The class’ body is surrounded by curly brackets, { and }. Within this body, you define the variables
(the data) and the methods (the behaviors) of the class. Variable definitions start with a variable
type, followed by one or more variable names, followed by a semicolon (used at the end of each
statement in Java). Here are some examples:

> int id;
> String firstName, lastName;

> double discountPercentage;

Observe the use of the comma (,) as a shorthand to define variables of the same type. That is, you
could also write String firstName, lastName; as:

String firstName;
String lastName;

Recall the naming convention of writing variable names in lowerCamelCase, whereby each word

in the variable name is capitalized, except for the first one, which starts with a lowercase letter.
This convention helps to distinguish variables from class names. Note that this convention is not as
widely adhered to as camelcase for class names. That is, you might find code that uses snake case
(using underscores) as well.

You will learn about variable definitions in a little more detail later. For now, you’ll continue look-
ing into the basic class definition, and seeing how you extend it to add method definitions:

class CLASSNAME
// VARIABLE DEFINITIONS
// METHOD DEFINITIONS

}

The following Try It Out shows you how to add some simple methods to the student and course
classes.
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Adding Methods to the Course and Student Classes

You will use the student class definition to add a number of methods.

1. Open the student.java class you defined in the previous Try It Out in Eclipse, or create a blank
class if you haven’t done so already.

2.  Modify the class definition so that it looks as follows:
class Student {
int id;
String firstName;
String lastName;
int birthYear, birthMonth, birthDay;

boolean isBirthday () {
// Return true if it's the student's birthday today.
return false;

}

void giveWarning (boolean isFinalWarning) {
// You should study harder!
}

int numberOfFriends () {
// Return the number of friends the student has.
return 0;

How It Works

Now take a look at how it works.

1. In the source code of this class, you have now added three method definitions: for isBirthday,
giveWarning,andAnumberOfFriends,reSpeCﬁvehh

2. Each of these methods starts with a return type (boolean, int, or void when no return type is
expected), the name of the method, and a number of arguments the method takes as inputs.

3. The method bodies do not look particularly interesting as of now, and just return a value immedi-
ately or do nothing.

4.  Again, you’re not running this code yet, but feel free to add more method definitions for the student
and Course classes. If you’re up to it, you can also try adding some code to the method bodies.

Again, if you’ve followed along with the Try It Out, you’ll recognize the same pattern showing up
for each method definition. That is, methods start with a return type, followed by the name of the
method, and then a number of arguments the method takes as inputs (for example, the isFinal-
Warning argument for the giveWarning method). Just as with variables, recall that method names
are written in lowerCamelCase. The method’s “body” is surrounded by curly brackets, { and }, just
as for classes. Note that this creates a hierarchy: methods are defined within the class body, and the
code for the method itself is defined within the method body.
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Methods can return any kind of type, meaning that the following can all be valid method definitions:

»  String nickname (){ /* ... */ }

»  int numberOfPartiesWentTo(){ /* ... */ }

»  student bestFriend(){ /* ... */ }

>  String[] listOfFavoriteCountries(){ /* ... */ }

When a method returns something, you need to specify the return value by using a return state-
ment in the method’s body. Even when a method does not return anything, you need to explicitly
specify this fact by using the void keyword in the method’s definition, as shown, for example, in the
giveWarning method in the Try It Out.

A method takes an arbitrary number of arguments. Arguments are separated by commas (, ), and for
each argument, the type needs to be specified. Even when a method takes no arguments, the paren-
theses () need to be added to the method name. Some examples:

»  void drinkBeer (int nrOfGlasses){ /*...*/ }

> int numberOfCoursesPassed (boolean onlyIncludeFirstTry) { /*...*/ }

Take some time to get acquainted with these concepts and familiarize yourself with basic class defi-
nitions. Feel free to add more classes (Teacher and CourseRoom are fine examples) and come up
with some variables and methods for them.

Schematically, a class definition with a variable and methods can be represented as shown in Figure 4-1.

class Student

intid ‘ boolean isBirthDay() ’

String firstName ‘ void giveWarning(Boolean intidWarning) ’

String lastName ‘ int numberOfFriends() ’

int birthYear

int birthMonth

int birthDay

FIGURE 4-1

You now know how to define the “blueprints” for these concepts, but you haven’t seen yet how to
instantiate these blueprints. That is, how do you create objects from the blueprints you defined? The
next section explains how to do so.
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NOTE Recall that the basic class definition, for now, looks as follows:

class CLASSNAME {
// VARIABLE DEFINITIONS
// METHOD DEFINITIONS

}

You might be wondering if this ordering is strict, meaning whether the classes
really have to start with variable definitions first, followed by method defini-
tions. The answer is no. For example, it is perfectly okay (syntactically) to write
a class like the following:

class Student {
boolean isBirthday() {
// Return true if it's the student's birthday today.
return false;

}
int id;

void giveWarning (boolean isFinalWarning)
// You should study harder!
}

String firstName;

int numberOfFriends () {
// Return the number of friends the student has.
return 0;

}

int birthYear, birthMonth, birthDay;
String lastName;

}

While neither Eclipse nor Java will care about this, you—the programmer—
should. Stylistically, this code scores badly. It's hard to follow and will only
serve to confuse you and others later. Therefore, it's best to stick to the
convention of “variables first, methods next.” In addition, keep in mind that
code is read more often than written, no matter the language it is written in.
Therefore, it is always a good idea to keep program code as clean, organized,
structured, and readable as possible, as well as to follow common conventions
and commenting where necessary.

Creating Objects

You have seen how to define simple classes in Java. Remember that classes are like blueprints
or prototypes from which objects are created. For example, you defined the class student as
a concept having a name, an ID, and some methods describing its behavior, but you have not
yet created an actual student. Now that you have defined the class, however, you can create, or
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instantiate, hundreds of students, each with their own properties. In object-oriented programming
terms, you say that you want to create a student object that’s an instance of the class of objects
known as student.

Objects are created using the new keyword. For example, to create a new student, you would simply
write the following statement:

new Student () ;

Of course, just creating a student in itself does not help you much, as you need to have a way to
access this particular object later on. How do you do so? By simply assigning the newly created stu-
dent to a variable, of course:

Student myFirstStudent = new Student () ;

Now you can use the myFirstStudent variable to access the first student later. You might be won-
dering why the parentheses appear at the end of student. It’s not a method definition, right? So, why
not just write:

Student myFirstStudent = new Student; // Incorrect!

The reason is that when you instantiate a class, you are in fact actually calling a special method
of the class called a constructor. Since it is a method, it can take a number of arguments. For
example, you might have defined the class so that you immediately need to pass a name for the
new student:

Student myFirstStudent = new Student ("Sophie", "Last Name") ;

In fact, this is a better way to define the class, as it doesn’t make much sense to allow program-
mers to define students who do not have a name. Since you are just getting started with classes
and objects, however, you can be a bit sloppy in the name of learning. Don’t worry, you will
return to constructors later in this chapter. For now, the classes can be instantiated without any
arguments.

NOTE Observant readers might wonder why the student class definition does
not contain a constructor method to create a new Student, even when this
method does not take any arguments. For all the other methods, you see that
you have written, for example:

int numberOfFriends() {
// Return the number of friends the student has.
return 0;

}

So where is the constructor method? The answer is that you do not have to
define it. When you do not supply any constructor method, Java will be smart
enough to know that it should just create a new student object with all its vari-
ables set to the default values when you write:

Student myFirstStudent = new Student () ;

You will explore constructors in more detail later in this chapter.
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Now that I am talking about constructors and student objects being created without a name, it’s

a good time to emphasize another important aspect, namely the fact that the name you give your
Student variable has nothing to do with the variables of the Student. An example will help to illus-
trate this. Say you define a student as follows:

Student marc = new Student () ;

Even though the variable is named marc, this does not mean that the firstName variable of this
object must be equal to marc. Of course, it makes sense to use marc as a variable name for the
student named Marc, and no one in their right mind would use sophie as a variable name for the
student named Marc, but there is nothing prohibiting you from doing so. The name of the student
variable is just a handle to refer to the student object itself, and has nothing to do with the inter-
nals of that object.

The following Try It Out will show you how to create some students in the example course adminis-
tration program.

Creating Student Objects

You will use the student class definition as a blueprint to create a number of student objects. If you
have not followed along with the previous Try It Outs, you should create a Student class now with the
following content:

class Student {
int id;
String firstName;
String lastName;
int birthYear, birthMonth, birthDay;

boolean isBirthday () {
// Return true if it's the student's birthday today.
return false;

}

void giveWarning (boolean isFinalWarning) {
// You should study harder!
}

int numberOfFriends() {
// Return the number of friends the student has.
return 0;

1. Add the following main method to the student class definition as follows. Note the use of the new
keyword to create objects:

public static void main(String[] args)
Student firstStudent = new Student () ;
Student secondStudent = new Student () ;
firstStudent.id = 1;
firstStudent.firstName = "Marc";
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secondStudent.id = 2;
secondStudent . firstName = "Sophie";

System.out.println("The student object referred to "+
"by the variable secondStudent has the first "+
"name: "+secondStudent) ;

You should now be able to run the student class from Eclipse and observe the output given on the
console.

How It Works

Now take a look at how it works.

1.

2.

The new keyword is used to create objects, which you will use to create a bunch of students. Note the
use of the dot (.) operator in this code to access (read and write) the Student objects’ variables.

As Java is a fully object-oriented program, however, you need to find an appropriate place to create
the students. Loose scripts cannot exist in Java, meaning that you have to create the students inside
a method definition of a class.

To actually execute, that is, run the program, you add a so-called main method to the student class.
As Java has no way of knowing which particular method you want to use as the entry point of the
program, a special method exists—the so-called main method—that serves exactly this purpose.

When running this program from Eclipse, Java will call the class’ main method. The main method
will create some students, set their variables, and print some information to Eclipse’s console.

You might be wondering what the public and static keywords are doing before the main method
definition. Don’t worry about these too much for now. You will see what static does later on in this
chapter and learn about the role of public in Chapter 8. For now, just keep in mind that the main
method must be public, static, return nothing (void), and take a single argument: an array of
strings, String [1. The name of the argument can be changed, but by convention, args is used. The
reason for this is that this method argument will contain the list of arguments that was passed to Java.

Note that, generally speaking, mixing in this main method with the student class definition is not
a good idea. Ask yourself the following: is a student responsible for creating some students? The
answer is, of course, no.

As such, you can also put this program logic somewhere else. The question is then, of course,
where? Think about this, which class of objects should be responsible for the bebhavior of creating
some students? You might come up with different answers. For example, you might say, “I just
want my program to create some students.” So what you can do is add a class, called MyProgram,
to hold a single main method:

class MyProgram {
// I am the program managing your Student and Course objects.

public static void main(String[] args)
Student firstStudent = new Student () ;
Student secondStudent = new Student () ;
firstStudent.id = 1;
firstStudent.firstName = "Marc";
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secondStudent.id = 2;
secondStudent .firstName = "Sophie";

System.out.println("The student object referred to "+
"by the variable secondStudent has the first "+
"name: "+secondStudent.firstName) ;

}

The behavior of managing students is now cleanly separated from the behavior a student itself
exposes. Later, you might want to create an Administrator class to perform this sort of manage-
ment, but for now, all you want to do is run this simple example program, so the current way of
doing things is fine to illustrate the idea.

Figure 4-2 represents the creation of objects from classes, schematically.

class Student Student myFirstStudent
| intid | { boolean isBirthDay() ] | intid = 1 | <—>{ boolean isBirthDay() ]—»
| String | [void giveWarningBoolean } | String | <> { void give\lNaming(Boolean}<—
|

| String lastName

int birthYear

int birthMonth

( int numberofFriends() | new Student() ’|String |astName|<—>{ int numberOffriends() }—»

int birthYear =

int birthMonth

int birthDay int birthDay =

Student mySecondStudent

new Student()

|intid=2 |<—>{ boolean isBirthDay() ]—>

| String | <> [ void giveWarning(BooIean}<—

| String IastName| 4—»[ int numberOfFriends() )—»

int birthYear =
int birthMonth

int birthDay =

FIGURE 4-2

You have now seen how to create simple class definitions in Java, containing variables and methods.
By now, you should grasp the differences between classes and objects, and should be able to define
classes and to instantiate them. You’ve been taken on a quick tour through the concepts of classes
and objects in Java, so now that you get the bigger picture, you can take a step back and learn more
about variables and methods, with all their intricacies, which is exactly what you will do in the fol-
lowing sections.
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STORING DATA: VARIABLES

In the previous section, I defined the simple class outline as follows. A class contains a block of vari-
able definitions (data) and methods (behaviors), like so:

class CLASSNAME {
// VARIABLE DEFINITIONS
// METHOD DEFINITIONS

}

You will now zoom in further on the aspect of defining variables within a class. Specifically, this
section discusses:

> Instance variables: Variables that will be used to hold data of objects.

> Class variables: Variables that are not bound to an object but instead belong to the class as
such, that is, to the blueprint of the object.

> Final variables: Variables that—after their initial assignment—cannot be modified.

Finally, T will also devote some words to the topic of variable scope. A scope of a variable is the
context in which it’s defined. This means that, depending on how you define a variable, it will affect
where and how this variable can be accessed.

Instance Variables

In object-oriented programming, an instance variable is a variable that’s defined in a class (as you
have done before for firstName and lastName in the Student class, for instance). Instance vari-
ables are also commonly referred to as member variables or fields of a class.

Instance variables belong to objects, meaning that each object of the class keeps a separate copy of
this variable. Let’s illustrate this idea with an example: instance variables can be introduced by sim-
ply defining them in the class body. Let’s say you want to create a class for the concept of a book.
The bare-bones class then looks like this:

class Book {

}

(Feel free to follow along in Eclipse.) An empty class it not much fun to work with, so you need to
think of some data. Well, since books have a title and an author, you might want to define some
variables to represent this. Since a book can have multiple authors, you might even want to define
this data aspect as a composite data type. Perhaps something like the following;:

class Book {
String title;
String[] authors;
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NOTE If you were thinking, “Wouldn't it be a good idea to abstract authors
away into a separate class, say, Author?”, you would be absolutely right,
although it depends on the complexity you foresee your program having

to deal with. Can you imagine keeping author information nicely separated
with authors having their own data (first name, last name, and birth date) and
behaviors? Then yes, it makes sense to create an Author class. If you are plan-
ning on keeping a simple string to represent author information for books (like
you are doing here), the simple solution is fine.

To paraphrase the famous quote from Einstein, “Everything should be made as
simple as possible, but no simpler.”

Now, you have already seen how to create some Book objects, that is, some books. For example, you
might write a piece of code doing something like the following;:

Book bookl = new Book() ;
bookl.title = "Beginning Java";
bookl.authors = new String[]{

"Bart Baesens",

"Aimee Backiel",

"Seppe vanden Broucke"

7

Book book2 = new Book () ;
book2.title = "Catcher in the Rye";
book2.authors = new String[]{"J. D. Salinger"};

This code creates two book objects—book1 and book2—and sets their title and author variables.
As you can observe, each book object keeps its own copy of the title and author variables, which
can be accessed and modified independently.

That is all you need to know to get the idea about what instance variables are all about. They are
basically just a part of the class blueprint, and get instantiated for each object you define belonging
to that class.

As a reminder, however, recall that you can define multiple variables of the same type by separating
them with commas, like so:

int a, b, c¢;

In fact, this not only works for instance variables, but works for any variable you define no matter
where and no matter of which type (it does not have to be a primitive type). For example, the code
sample to create the two books could also be rewritten like so:

Book bookl, book2; // Define two empty Book objects
bookl = new Book(); // Set first book

bookl.title = "Beginning Java";
bookl.authors = new String[]{
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"Bart Baesens',
"Aimee Backiel",
"Seppe vanden Broucke"

bi

book2 = new Book(); // Set second book
book2.title = "Catcher in the Rye";
book2.authors = new String[]{"J. D. Salinger"};

Every instance variable you define defaults to a particular value, depending on the variable type. For
instance, you might wonder what happens if you ask for the title of a book, without specifying a title first:

Book book3 = new Book() ;
// Oops, forgot to set title...
System.out.println("Title equals: "+book3.title);

The answer is that “Title equals: null”. For variables with a class type, the default value is a special
keyword representing emptiness, null. Since String is a non-primitive class, its default value is thus
null. Remember, as discussed in Chapter 2, the default values, per data type, are:

>  For boolean: false
For byte: 0

For short: 0

For int: 0

For 1ong: oL

For float: 0.0f
For double: 0.0d

For char: \u0000 (the null character)

Y Y Y Y Y Y VY Y

For string or any object: null

Note that these default values apply only to fields (instance variables). That means if you try to be
clever and add the following to the code snippet:

Book book;

System.out.println("Now, book equals: "+book) ;
book = new Book () ;

System.out.println("And now, book equals: "+book) ;

Eclipse will complain about the book variable not being initialized. This can be fixed like so:

Book book = null;

System.out.println ("Now, book equals: "+book) ;
book = new Book () ;

System.out.println("And now, book equals: "+book) ;

The same applies for other variables you define that are not instance variables:

int a = 0;
System.out.println("int a equals"+a) ;
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NOTE You might have tried to execute this code snippet to see something
like the following appearing on-screen:

Now, book equals: null
And now, book equals: Book@709fal2f

What's going on with this Booke709fa12f (your output will differ and return

a different part after the @)? The reason for this is that all Java objects have

a built-in method to return their so-called “String representation,” which can
be extended by programmers to provide a friendly output for an object, that
is, a String that textually represents the object (don’t worry about the specif-
ics of this too much for now; you will get back to this later). The key aspect to
know here is that, when no extension is provided by the programmer, Java will
just resort to showing the class name (Book), followed by an e, followed by the
hexadecimal representation of the object’s hashcode.

Hashcodes are an advanced Java concept and are used to provide a quick
integer representation for an object, which can be used as a quick check to
see if two objects are equal (they have the same hashcode). Again, the way
a hashcode is calculated can be extended by the programmer. If this is not
done, then the hashcode corresponds to the internal address of the object
in memory, although the particular default behavior may vary from one JVM
implementation to another.

Finally, you might be wondering what happens when you try to access an object'’s
field (instance variable) when an object was not created first, such as done here:

Book book = null;
System.out.println ("Now, book title equals: "+book.title);

Eclipse will allow you to execute this code, but the program will quickly crash
with the following message:

Exception in thread "main" java.lang.NullPointerException
at Book.main (Book.java:XX)

Not surprising, because accessing a variable of something that doesn’t
exist is sure to give problems. In this code sample, it's easy to see where
the problem lies (Eclipse will even put up a warning regarding this foolish
behavior), but in larger programs, it is a common pattern for methods to
create objects, or return null in case something failed. When this object is
then accessed (or passed on to another method, perhaps) without explicitly
checking for null, a NullPointerException error will pop up as soon as
you try to access a variable or method of this object, as the following code
sample illustrates:

Book giveMeABook () {
//return new Book(); --> Sorry, no books available for now
return null; // Return null instead

} continues
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continued

Book myNewbook = giveMeABook () ;

// Forgot the check for null?
System.out.println("Title equals: "+myNewBook.title) ;
// This will give an error

NullPointerException errors are a prevalent problem when programming in
Java, and oftentimes it is hard to track down the root cause behind them as you
have to track down where and why a particular object has not been instantiated
(i.e., the variable equals nu11). Therefore, it is a good idea either to program
defensively and always check for null when retrieving an object and before
moving on with using the object, or to program in such a way that only in a lim-
ited number of cases a null variable is passed from one part of your program to
another.

This code also immediately illustrates that you are not forced to use the default values for instance
variables. For example, you can modify the Book class to assign defaults to the title and author
variables:

class Book {
String title = "Unknown Title";
String[] authors = new Stringl] {"Anonymous"};

}

And, combining this with the knowledge on how to define multiple variables of the same type in one
go, you can add:

class Book {
String title = "Unknown Title";
String[] authors = new Stringl] {"Anonymous"};
int yearReleased = 2014, copiesSold = 0;

}

With this knowledge under your belt, you might be wondering, as each object keeps its own copy of
instance variables, is there also a way to define a common variable, something that’s shared between
all objects belonging to the same class? Indeed there is . . .

Class Variables

In object-oriented programming, a class variable, also denoted as a static variable, is a vari-

able that’s been allocated “statically”—meaning that this variable is shared between all objects
(instances) belonging to this class. Further, since class variables belong to the class blueprint, it is not
necessary to create objects to be able to access and modify class variables. It is sometimes argued
that class variables do not really adhere to “pure” object-oriented programming principles. Other,
stricter programming languages, such as Scala, do not allow them, for instance. That said, this is
not to be regarded as a shortcoming of Java, as we will see that class variables can come in handy in
many cases. However, it is best not to overuse them.
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I’ll explain this by providing an example. Let’s modify the Book class so it looks as follows:

class Book
static int maxAmountOfPages = 500;

String title = "Unknown Title";
String[] authors = new Stringl[] {"Anonymous"};
int yearReleased = 2014, copiesSold = 0, nrOfPages = 1400;

Note the static keyword in front of the maxAmountofPages class variable. This variable denotes
the maximum amount of pages you currently support for books, which could be used in combi-
nation with the nrofPages instance variable to check whether you can publish a given book, for
instance. Although the number of pages is different for each book you define, the maximum amount
of pages the printers support is a global property throughout all Book objects, is defined as a class
variable, and is thus accessible by all Book objects.

A code sample illustrating this concept might look like this:

Book superLargeBook = new Book() ;
superLargeBook.title = "Super Large Boring Book";

System.out.println("I have a book here with the title: "+superLargeBook.title);
System.out.println("Written by: "+superLargeBook.authors) ;
System.out.println("Released in: "+superLargeBook.yearReleased) ;
System.out.println("With number of pages: "+superLargeBook.nrOfPages) ;

System.out.println ("However, we only support books with max. pages: "
+superLargeBook .maxAmountOfPages) ;

Running this code outputs:

I have a book here with the title: Super Large Boring Book
Written by: [Ljava.lang.String;@l271ba

Released in: 2014

With number of pages: 1400

However, we only support books with max. pages: 500

NOTE You might have spotted the following line:

Written by: [Ljava.lang.String;@l271ba

And wondered what’s up with this. This isn’t the default Anonymous author you
set! The reason for this behavior is again due to the way Java derives a string
representation of composite types, which is not very user friendly in this case.
There are two ways to resolve this issue. The first is to loop through the array
and show each element one by one (you will look at looping constructs in the
next chapter). The second way is to use so-called “Collection” classes, which
are similar to arrays in the sense that they hold a bunch of information, but are
also much more flexible and efficient. In addition, their String representation
looks much friendlier. You will learn about collections later in this chapter.
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However, for the last line, when accessing the static variable, Eclipse complains about the fact that
"The static field superLargeBook.maxAmountOfPages should be accessed in a static
way". What is meant by this? Well, it means that it’s generally preferred to access and modify static
variables not by accessing them through an object variable, but by using the class name directly, like
s0:

Book.maxAmountOfPages = 2000; // Let's increase the max amount of pages
System.out.println("We now support books with max. pages: "
+Book .maxAmountOfPages) ;

Accessing and modifying static variables in this manner has two benefits. First, you do not need
to create an object in order to access the static variable. Second, this way makes it clear to
readers that the variable being accessed is a static one, without them needing to read the class
definition. Finally, speaking of class definitions, it’s generally a good idea to define class vari-
ables before defining instance variables when you write classes, just to keep things clean and
readable.

Static variables are oftentimes used to define so-called constants: variables whose values will never
change during the execution of a program. However, as you have seen, it is perfectly okay to change
the maximum amount of pages by setting a new value to Book . maxAmount0OfPages. If you want to
keep variables fixed during the program’s execution, you need to consider another concept: final
variables.

Final Variables

In Java, final variables are variables that can be initialized only once, either directly when defining
the variable, or later in one of the class methods. Once a value has been given to the variable, how-
ever, it cannot be modified any longer.

You can see an example of a final variable by returning to the book class and modifying it a little, so
the complete class looks as follows:

class Book {
final String title = "Unknown Title";
String[] authors = new String[] {"Anonymous"};

int yearReleased = 2014, copiesSold = 0, nrOfPages;

public static void main(String[] args)
Book superLargeBook = new Book () ;
superLargeBook.title = "Super Large Boring Book'";
superLargeBook.nrOfPages = 1400;

Note the change to the title variable, as it now has the £inal property. To keep things simple for
now, I have also removed the static variable and have put some testing code in a main method, so
you can execute this class.
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NOTE The previous testing code snippets can also be placed in the main
method of Book, but remember that it is generally not a good idea to “pollute”
classes representing real-world concepts with main methods. Alternatively,

you may also create a MyProgram class and put the code snippets in its main
method, similar to what you did in the course administration example earlier in
this chapter.

However, Eclipse will refuse to compile this code, as it complains that you cannot give the title
variable a new value (“Super Large Boring Book”), as it has already received its value at the time
of creating the object (“Unknown Title”). To get this code to work, you might be inclined to make
title a blank final variable, like so:

class Book {
final String title;
final Stringl[] authors;

final int yearReleased, nrOfPages;
int copiesSold = 0;

public static void main(Stringl[] args) {
Book superLargeBook = new Book() ;
superLargeBook.title = "Super Large Boring Book";
superLargeBook.nrOfPages = 1400;

Note that I have also reworked some other variables, as it makes sense that the title, authors, num-
ber of pages, and the release date never change for a book (not taking into account reprints and
other such intricacies at the moment). Hence, it makes sense to set these to read-only.

However, you will notice that Java will still complain about the title and nrofPages assignments
and refuse to compile this code fragment. Why? Especially when the following code (you can put
this somewhere in the main method) does in fact work:

final int a;
a=>5;

The reason lies in the fact that title, authors, yearReleased, and so on are class variables,
whereas the a integer is just a local variable. Remember that when you initialize an object, Java will
assign default values to the instance and class variables for which no value was set. For final vari-
ables, on the other hand, Java will not set an initial value and will force you, the programmer, to
explicitly provide an initial value. For local variables inside our main method, we can define a blank
variable and initialize it later (before using it), as seen above, but for instance and class variables,
this remark entails that we cannot do the following:

class Book {
final String title;
}
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If we try to do this, Java will warn that we have not initialized the title variable.

Given this point, it might occur to you that final class variables are, for now, pretty useless. You

have found no way to create books with a given initial title that’s kept as a read-only variable. To
resolve this, you need to understand another concept: object constructors. Don’t worry, you will
learn about these a few pages later, and you will revisit final class variables there as well.

There is, however, another way that final variables come in handy, and that is when you use them in
combination with static variables. Change the Book class again to look like the following:

class Book {
final static int MAX AMOUNT OF PAGES 500;
final static int MIN_AMOUNT OF PAGES = 50;

String title;
String[] authors;

int yearReleased, nrOfPages;
int copiesSold = 0;

public static void main(String[] args)
Book superLargeBook = new Book () ;
superLargeBook.title = "Super Large Boring Book'";
superLargeBook.nrOfPages = 1400;

System.out.println("Check if your book has a correct amount of pages...");

(
System.out.println("- Minimum amount: "+Book.MIN_ AMOUNT OF_PAGES) ;
System.out.println("- Maximum amount: "+Book.MAX AMOUNT OF PAGES) ;
System.out.println("- Your book: "+superLargeBook.nrOfPages) ;

Note the two final static variables at the top of the class body. This pattern is very heavily used
by Java programmers to define constants, meaning that you desire to set the maximum and mini-
mum amount of pages only once (they are final), and also to keep them shared by all objects (they
are part of the class blueprint). Note by the way that Java has a const keyword, but it currently
remains unused.

Also observe the change in naming convention when declaring constants with final static vari-
ables. Instead of writing in lowerCamelCase, you name them using CAPITALIZED UNDERSCORE
SEPARATED form. Again, this is not required, but it’s a widely followed convention by Java
programmers to indicate constant variables.

There is one final (no pun intended) important remark I need to make regarding final variables.
Remember that I have stated that final variables can only be initialized once, and then keep their
value. For primitive types, the effects of this are easy to grasp—a final integer set to the number
five remains five for the remainder of its life. However, for more complex types, such as objects, the
story is a little more complicated. Consider the following example:

class Book {
final static int MAX AMOUNT OF PAGES = 500;
final static int MIN AMOUNT OF PAGES = 50;
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String title;
String[] authors;

int yearReleased, nrOfPages;
int copiesSold = 0;

public static void main(String[] args) {
final Book superLargeBook = new Book() ;
superLargeBook.title = "Super Large Boring Book";
superLargeBook.nrOfPages = 1400;

// Change the amount of copies sold
superLargeBook.copiesSold += 1000;

Note how superLargeBook is final. However, later on, you have to modify the number of copies
sold for this object. How is this possible when the code declared this object as final? After all, you
should not be able to change it, right? The reasoning here is that final affects the number of times a
variable may be initialized, or set. It does not mean that all the fields of an object (when the variable

represents an object) will become “frozen” as well.

To illustrate the difference, the following code shows what you cannot do:

class Book {
final static int MAX AMOUNT OF PAGES = 500;
final static int MIN_AMOUNT OF PAGES = 50;

String title;
String[] authors;

int yearReleased, nrOfPages;
int copiesSold = 0;

public static void main(Stringl[] args) {
final Book superLargeBook = new Book() ;
superLargeBook.title = "Super Large Boring Book";
superLargeBook.nrOfPages = 1400;
// Change the amount of copies sold

superLargeBook.copiesSold += 1000;

// Assign a new book
superLargeBook = new Book(); // EEK!

Eclipse throws an error, telling you that you are not allowed to assign a new book (or any other

existing book) to the superLargeBook variable.

The same reasoning holds for composite types (arrays). The following code again shows an example:

final int[] numbers = new int[]{1,2,3};
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numbers[0] = 10; // This is okay

int [] newNumbers = new int[]{10,20,30};
numbers = newNumbers; // This is not okay

There is one case, however, that’s a little bit special, namely Strings. As you have seen, Strings are
not a primitive type in Java, and are, in fact, objects like any other. You might thus try something
like the following:

final String myString = "Hi there";
myString = "bye";

However, this approach will not work, as this is actually a shorthand notation for the following:

final String myString = new String("Hi there");
myString = new String("bye");

When writing this piece of code, it becomes clear why you cannot do it this way. However, when
you are particularly observant, you might say, since String is a class and I create string objects,
surely the actual value of the string object must be stored somewhere, probably as an array of
char’s. The answer is that, indeed, a string object keeps an internal representation of the actual
textual value, but it cannot be publicly accessed or modified. This is done for performance reasons.
But wait—why then can you execute the following:

String myString = "a";

myString = "b";
myString += "cde";

Again, the reason is that this is shorthand and Java helps you out. In fact, this code actually corre-
sponds to:
String myString = new String("a");

myString = new String("b");
myString = new String(myString + "cde");

This immediately provides you with the reasoning behind the fact that changing Strings in Java are
an intensive, relatively slow operation. For a few modifications, this does not matter, but when you
have to modify a String many thousands of times, it is advisable to look at other text-representing
classes, such as StringBuilder—more about this later.

NOTE Variables are not the only elements that can be defined as being final.
Methods can also be set as being final—meaning that they cannot be over-
ridden or hidden by subclasses. Classes can also be set to final, meaning that
they cannot be subclassed at all.

Don’t worry about what subclassing and subclasses mean at this point, as |
will explain them when we talk about advanced object-oriented concepts in
Chapter 8. Just remember for now that “final” can serve as a way to allow for

continues
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continued

stricter and more secure coding (in fact, many of Java’s built-in classes are final
so they cannot be tampered with).

A common misconception exists that says that declaring classes or methods as
final helps to speed up execution. The explanation behind this oftentimes follows
a reasoning such as, “Well, since the compiler knows this method will never be
modified or extended by subclasses, it must be able to optimize on this.” This
perception, however, is incorrect, as the Java JIT compiler does no such thing. In
fact, declaring classes and methods final can be a great burden when program-
ming, as they limit the options for code reuse and extending functionality of exist-
ing classes. Of course, there are good reasons to declare a class or method final,
when you want to guarantee that classes and methods remain immutable (mean-
ing that they cannot be extended or modified by other classes).

For instance variables, however (as seen here), the reasoning is so dissimilar
that it's almost confusing that we use the same £inal keyword. Not only is set-
ting a variable to final a great way to enforce a read-only variable, which occurs
more often than you might think (many variables are read-only), it also does
help the compiler to optimize your program. As a final variable keeps the same
value after initialization, the compiler is able to cache (store) this value to per-
form quick checks on this variable whenever it's asked to.

Variable Scope

A very important aspect when working with variables in Java—and, in fact, other programming
languages as well—is their scope. Without knowing anything about variable scope, trying to access
variables can get confusing once the compiler starts yelling at you for making a mistake. Consider
the following simple class with two methods:

class ScopeTest {
void makeA() {
int a = 5;

}

void readA() {
System.out.println("The value of a is: "+a);
}

}

If you try to enter this in Eclipse, you’ll get an error telling you that the variable a cannot be
resolved. The reason for this is scope. A variable’s scope is basically the context in which the vari-
able is known. Depending on where a variable is declared, you will be able or unable to access this
variable. The following “levels” of scope can be defined:

>  Local variables: Variables that are declared inside a method or block.

> Parameter variables: Variables that are declared as a method argument or a loop variable.

> Instance variables: Variables that are declared in the class definition.
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These levels of scope are ordered so that variables that are defined in a higher level can be accessed from
lower-level locations. To give the simplest example, instance variables (highest level) can be accessed

by all methods inside the class. Method arguments (a parameter variable) can only be accessed by that
method, but not by other methods. This is exactly why the previous example doesn’t work.

Figure 4-3 graphically illustrates the scope of an instance variable (instancevar), a parameter vari-
able (paramvar), and a local variable (Localvara).

class ScopeTest {

int instancevar;

int localvarA = 5;

System.out.println(“The value of instancevar is: “ + instancevar):;
System.out.println(“The value of paramVar is: “ + paramvar);
System.out.println(“The value of localvarA is: “ + localVara);

}

FIGURE 4-3

As the example in Figure 4-3 shows, the instance variable (instancevar) is accessible by each
method in the class. Parameter variables are accessible only within their methods, and can thus re-
use the same name throughout different method definitions. Finally, locally declared variables (such
as localvara) are accessible only within their method, meaning that method makeB will not be able
to access localVarA.

Note that parameter variables are accessible only within their method or loop. What do I mean by
their loop? I will leave the main explanation regarding loops for the next chapter, but the following
example provides a sneak preview:
class ScopeTest {
void doTheLoop ()
String[] names = new Stringl[]{"Alice", "Bob", "Mia", "Marcus"};
for (int i = 0; i < names.length; i++) {
System.out.println("Name number "+i+" equals: "+names[i]);
1

System.out.println("The value of i is now: "+i); // Will not work

}

Again, you have one class definition, with one method, taking no arguments this time. Inside the
method, you have one local variable (names) followed by a so-called for loop. Don’t concern your-
self with the specifics of this construct for now, just understand that this code basically says, “For an
integer i going from 0 but not including the number of names. That is, for i equal to 0, 1, 2, and 3,
do whatever’s inside this block.” What is important to know, however, is that the variable i is only
available within the for block, which is why the last print1n statement in the previous code snippet
will throw an error in Eclipse, as 1 is no longer accessible at this point. Another point to note is that
the names variable is also accessible from within the loop block. Again, this illustrates the basic rule
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saying that variables that are declared at a higher level (locally in the method) can be accessed by a
lower level (a loop block within the method).

I close this section on variable scope—and variables in general—with a number of important remarks.
First, you might be wondering what happens whenever variables defined in different locations (that is,
at a different level of scope) clash in terms of naming. For example, consider the following example:

class ScopeTest {
int a = 5;
void printA() {
int a = 10;
System.out.println("The value of a is now: "+a);

}

What will show up when the method printa is called? Again, remembering that rule that higher-
level variables can be accessed from lower-level locations provides some guidance here, as accessing
a variable will “bubble up” from the current scope. This means that Java will first try to access the
variable locally, and then move outward until looking for instance variables or static class variables
bearing the requested name. This means that in the previous example, the local variable gets pre-
cedence and the result displaying on the screen will thus be 10. This concept is known as “variable
shadowing” (consider the local variable to overshadow the higher-level ones). Keep this in mind
when naming variables. Note also that Eclipse will provide subtle formatting and coloring hints to
indicate which variable is being accessed.

NOTE Wheat if you really wanted to access the instance variable and not the local
variable in this example, without renaming one of them? In that case, you have to
explicitly tell Java you want the instance variable, using the keyword this, like so:

class ScopeTest {
int a = 5;
void printA() {
int a = 10;
System.out.println("The value of INSTANCE VARIABLE " +
"a 1s now: "+this.a);

}

And when a is a class variable, remember to use the class name:

class ScopeTest {
static int a = 5;
void printA() {
int a = 10;
System.out.println("The value of INSTANCE VARIABLE " +
"a is now: "+ScopeTest.a);

}

For now, it is best to stick to clear, unambiguous naming; you will return to
learn about the keyword this in-depth in a later chapter.
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Another important remark concerns the fact that local and parameter variables are forgotten once
their scope is exited, meaning that method arguments will disappear once you exit the method (this
allows you to use the same variable name for arguments throughout different methods), just as local
variables will be discarded once the compiler steps out of its block (a method or loop body). To illus-
trate this once more, consider the following:

class ScopeTest {
void scopeTest (int a) {
int b = a + 10;
for (int ¢ = 0; ¢ < 10; c++) {
int d = ¢ + 3;
b=Db+ 1;

}

Try to work out what is happening here. Variable d (local variable) is only accessible within the loop
block. Variable ¢ (parameter variable) is initialized for each iteration of the loop and is only acces-
sible within the loop body. Variable b (local variable) is discarded after the method is exited but is
accessible in the whole method. Variable a (parameter variable) is also discarded after the method is
exited and is accessible in the whole method, but it’s passed as a method argument.

NOTE If you want to do so, note that you can also arbitrarily create your own
scope blocks, different from class, method, or loop bodies. This is done simply
by wrapping a piece—a block—of code in curly brackets: { and }. For example,
the previous code snippet can be extended as such:

class ScopeTest {
void scopeTest (int a) {
int b = a + 10;
for (int ¢ = 0; ¢ < 10; c++) {
int d = ¢ + 3;

{
}

// e not accessible here
b=Db+ 1;

int e = d + 3;

}

// c not accessible here

{
}

// ¢ also not accessible here

int ¢ = 3;

}

While this is an often forgotten tidbit of Java that can come in handy to struc-
ture complex pieces of code, it's best not to rely on this feature too much.
When you find yourself putting large amounts of code in blocks like this, it is
probably a good idea to try to separate some behavior into multiple methods
or classes to split things up.
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This concludes the discussion of scope and the overview of different types of variables. You now
know how to declare instance variables (member variables or fields), class (static) variables, and final
variables, and are aware that variables are defined within a specific scope or context, which deter-
mines how they can be accessed.

The next section turns your attention to the other big part of classes: behavior as defined through
methods. Just as with variables, there are different types of methods, but many of the aspects you
learned here will return.

DEFINING BEHAVIOR: METHODS

Recall once more the simple class outline as follows. A class contains a block of variable definitions
(data) and methods (behavior), like so:

class CLASSNAME {
// VARIABLE DEFINITIONS
// METHOD DEFINITIONS

}

Or, to be more specific:

class CLASSNAME {
// FINAL CLASS VARIABLE DEFINITIONS
// CLASS VARIABLE DEFINITIONS
// FINAL INSTANCE VARIABLE DEFINITIONS
// INSTANCE VARIABLE DEFINITIONS

// METHOD DEFINITIONS

}

This section discusses in full the concept of class behavior, as defined through its methods.
Specifically, you will see:

> Instance methods: Methods that are accessible by objects.

> Class methods: Methods that are not bound to an object but instead belong to the class as
such, that is, to the blueprint of the object.

> Constructors: A special method that governs how a class is instantiated; you have already
read about this method.

»  The main method: A special method definition that can be used to run your application.

Finally, you will also learn about argument passing. You have seen how methods can take argument
variables to use within the method’s body. The way variables are passed to methods can be a little
bit daunting in Java at first—and can introduce subtle bugs when you’re not aware—so it makes
sense to learn about this in a separate section.

Instance Methods

Just as with instance variables, an instance method (or a member method) is a method that’s acces-
sible only through objects belonging to that class—meaning that they can be accessed only through
an initialized object.
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A simple example can help to explain this. Suppose you create a Dog class with one method, bark,
like so:
class Dog

void bark() { // Instance method
System.out.println("Woof!") ;
}

Since bark is an instance method, you first need to create an object to call it, like so:

Dog myDog = new Dog() ;
// Call the instance method on the object myDog:
myDog.bark () ;

That’s all there is to defining instance methods. As a reminder, however, recall that methods always
return a type or void if they don’t return anything. The following example modifies the Dog class to
illustrate this once again:

class Dog {
boolean isSitting;

String getBarkSound () {

return "Woof!";

boolean isSitting()
return isSitting;

void sit() {
isSitting = true;
}

void stand() {
isSitting = false;
}

NOTE Note that the sit, stand, and isSitting methods neatly illustrate the
concept of encapsulation, meaning that data in a class (the isSitting vari-
able) should be accessed through instance methods (myDog.sit ()), instead
of directly accessing its variables (myDog.issitting = true). When you learn
about advanced object-oriented programming concepts in Chapter 8, you
will see how to effectively block accessing instance variables directly, forcing
the use of methods.

Recall that methods returning something (that is, methods that do not return void) always need to
include a reachable return statement in their body. Note that you can also place return statements
in void methods. In this case, the return statement does not actually return something, but just
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exits the method. For example, if you want to exit out of the sit method before sitting down, you
can change this method as follows:
void sit() {
if (isSitting)
return; // Exit out method if already sitting
isSitting = true;

This will especially come in handy for governing the control flow of your program. This aspect will
be discussed in detail in the next chapter.

Recall that methods can also take one or more arguments. Consider, for example, the following
method declarations:

»  void giveCookie (Cookie cookie) { /*...*/ }

»  void chaseDog(Dog dog) { /*...*/ }

»  void lickPerson (Person person, int nrLicks) { /*...*/ }
»  void giveNickNames (String[] nickNames) { /*...*/ }

»  void giveNickNames (String... nickNames) { /*...*/ }

The last example in this listing will look unfamiliar to you, and it uses a construct called varargs
(variable arguments). Basically, the last two methods are equivalent in the sense that the nickNames
variable will be available as an array of strings in the method body, for instance:

void giveNickNames (String... nickNames) {
System.out.println("You have given me "+nickNames.length+" names");
}

The way these two methods are called, however, differs. In the first case (String[] nickNames), the
method is called using an array of strings as an argument, as you’d expect:

String[] newNames = new String[] {"Puppers", "Droopy"};
myDog .giveNickNames (newNames) ;

In the second case, however (String... nickNames), you can just supply an arbitrary number of
strings (including none at all), like so:

myDog.giveNickNames ("Puppers", "Droopy");

// Or any other amount of strings:

myDog.giveNickNames ("Puppers", "Droopy", "Tissues", "Clifford");
myDog .giveNickNames () ;

Varargs can provide a handy way of avoiding having to pass an array explicitly. However, keep in
mind that the varargs argument (the one with the three dots, .. .) must always be the last method
argument, and only one varargs argument can be defined for a method. With arrays, on the other
hand, you are free to define any number of arguments in any order you want. To illustrate:

> method (String... s1): Allowed

>  method(String... sl, String s2): Not allowed
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»  method(String... sl1, int s2): Not allowed

>  method(String... sl, String... s2): Not allowed

»  method(String... sl, Dog... dogs): Not allowed

> method (String[] s1): Allowed

> method (String[] s1, String s2): Allowed

> method (String[] s1, Stringl] s2): Allowed

>  method(String[] sl1, Stringl] s2, Dogl] dogs): Allowed
> method (int i1, String[] s1, int i2): Allowed

> method (int i1, String[] sl1, String... s2): Allowed

>  method(int i1, String... sl, String[] s2): Not allowed

You don’t have to memorize this list (or these rules), as Eclipse will simply warn you when you
define a method incorrectly.

Class Methods

Just as you’ve seen for class variables, a class method, also denoted as a static method, is a method
that has been defined statically, meaning that this method is shared between all objects (instances)
belonging to the class. Again, as class methods belong to the class blueprint, it is not even necessary
to create objects to be able to use them.

Il illustrate this concept with another example from the realm of pets. This time, let’s define a cat
class as follows:

class Cat {
static String preferredFood() {
return "Fish";
}

Note the static modifier in front of the method declaration is similar to what you’ve seen with static
variables. preferredFood is defined as a blueprint method, returning the preferred food for all cats.
Just as for instance methods, it is possible to call class methods through an object:

Cat myCat = new Cat();
System.out.println("A cat's preferred food is: "+myCat.preferredFood()) ;

However, just as for class variables, this is not good practice, and Eclipse will warn you about such
behavior. Again, you should clearly indicate that you’re accessing a static method by using the
class name, instead of the object variable:

System.out.println("A cat's preferred food is: "+Cat.preferredFood()) ;

This also clearly illustrates that you do not have to create an object to use static methods.
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It is important to note that, since class methods operate on the class as a whole (as a blueprint), they
are not able to access instance variables. For example, the following is not allowed:

class Cat {
String name;

static void changeName () {
name = "ANONYMOUS CAT";

What you can do, however, is the following:

class Cat {
static String preferredFood = "fish";

static String getPreferredFood () {
return preferredFood;
}

static void setPreferredFood (String newFood) {
preferredFood = newFood;
}

And call this code as follows:

System.out.println("A cat's preferred food is: "+Cat.getPreferredFood()) ;
Cat.setPreferredFood ("milk") ;
System.out.println("A cat's preferred food is now: "+Cat.getPreferredFood()) ;

This last example illustrates the power of combining class variables with class methods, as they
allow you to create class-global variables that can be changed if necessary.

NOTE Again, you are seeing the concept of encapsulation in prac-

tice here. Whereas earlier you would have accessed the class variable
preferredFood by writing Cat .preferredFood directly, you now neatly use the
getPreferredFood and setPreferredFood methods to do so. Does this mean
you can no longer write Cat .preferredFood = “milk”? The answer is that—
for now—you can, but again, you will see later how you can effectively block
accessing instance variables directly, forcing the use of methods (and prevent-
ing tampering of variables outside their owning class).

Constructors

Constructors are special class methods that are used to initialize objects of that class. If you recall
the discussion on final variables, you might remember that you had—at the time—no way to create
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Book objects with an initial title that’s kept as a read-only variable (using final). You might also
recall that when you do the following:

Book myBook = new Book() ;

You are writing () as if you are invoking a method, because, in fact, you are—namely the construc-
tor method for the class. Constructor methods are defined similarly as instance methods, with the
following differences:

> Constructors bear the same name as the class in which they are defined.

> Constructors have no return type, not even void.

In all the classes you have seen so far, you will notice that you did not define a constructor method.
The reason for this is that Java will automatically assume a “blank” constructor when you do not
define one, meaning that defining a class like:

Class Book {
}

Is exactly the same as writing:

class Book {
Book () {

}
}

So far, this constructor does not really do much. What can they be used for? A constructor is
invoked each time you instantiate (that is, “construct”) a new object using the new keyword.
Most commonly, constructors will initialize default values for the object being created. To illus-
trate this, let’s return to the earlier issue: you aim to define a variable to hold the title of a book,
but you want to define this variable so it can be set only once. As such, the following solution
does not suffice:

class Book {
String title;
}

As there is nothing preventing multiple assignments to title in this case. You have seen that you can
use the final keyword like so:

class Book {
final String title = "Initial Title";
}

But of course, you would like to make the initial title user-specified and different for each book. The
previous solution does not allow you to write:

Book myBook = new Book () ;
myBook.title = "The Real Title";
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Finally, you have seen that you can remove the initialization of the variable to make it a so-called

blank final variable:

class Book {
final String title;
}

Recall, however, from our discussion regarding final variables that Java will complain about the fact
that the title instance variable might not be initialized, as you need to explicitly assign a value.
You have seen before that you can solve this by doing something like:

class Book {
final String title = "";
!

But again, we have no way to change the title variable to the title we actually want to give to a
particular book. That is, Java will complain about doing something like:

Book myBook = new Book() ;
myBook.title = "The Real Title";

This happens because we have already initialized the title variable to ", preventing it from being
changed again. So how do you deal with this problem? Well, by initializing final variables inside
your own constructor, like so:

class Book {
final String title;

Book () {
title = "Initial Title";
}

To supply a user-specific title, you now can just modify the constructor method so that it takes an
argument. Watch out when naming your constructor arguments. Remember that using local or
parameter variables with the same name as instance variables will take precedence. Hence, you
should modify the constructor like so:

class Book {
final String title;

Book (String t) {
title = t;
}

Now how do you call this constructor? Easily, by providing an argument when creating an object:
Book myBook = new Book("Title of the Book") ;
Note that you have seen how Java will assume the presence of a blank constructor taking

no arguments when you do not define one in the class. If you do define a constructor with
arguments—like you’ve just seen—the constructor taking no arguments will not be available
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any longer, unless you also explicitly define it. Meaning that for this example, you can no longer

write:
Book myBook = new Book ("Title of the Book"); // This works
Book myBook = new Book(); // This no longer works

You might be confused by the wording of “unless you also explicitly define it.” Is it possible
to define multiple constructor methods? Indeed it is; consider, for example, the following class
definition:

class Book {

}

final static int DEFAULT YEAR = 2014;
final String title;

final int releaseYear;

int copiesSold;

Book (String t) {
title = t;
releaseYear = DEFAULT YEAR;
// copiesSold will default to 0

}

Book (String t, int r)
title = t;
releaseYear = r;
// copiesSold will default to 0

Book (String t, int r, int s) {
title = t;
releaseYear = r;
copiesSold = s;

Given everything you’ve seen so far, you should be able to understand this class. Take some time to
figure out what is happening here, and make sure to note the following:

>

>

Three constructors are available for this class, each taking a different number of arguments.

One final static variable is acting as a constant that will be used as a default initializing value
in one of the constructors.

The two other blank final variables (non-static) need to be initialized by every constructor.

Constructors can also initialize nonfinal variables.

NOTE Using methods with the same name—but taking different arguments—
is provided by a feature called method overriding. As the name suggests, this
feature is not only available for constructors, but in fact for every method.
Method overriding provides advanced capabilities, so it's covered in-depth in
Chapter 8.
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You might be annoyed by the fact that some statements, such as title = t;, are duplicated across
different constructors, while in fact the constructors are forming a hierarchy. Luckily, it is possible
for constructors to call other constructors to perform a piece of the requested initialization, as the

following code snippet shows:

class Book {
final static int DEFAULT YEAR = 2014;
final String title;
final int releaseYear;
int copiesSold;

Book (String t)
// Call other constructor:
this(t, DEFAULT YEAR, 0);

}

Book (String t, int r)
// Call other constructor:
this(t, r, 0);

}

Book (String t, int r, int s) {
title = t;
releaseYear = r;
copiesSold = s;

Note the use of the keyword this here. I've briefly mentioned this keyword before when illustrat-
ing how you can use it to refer to the current object (this.title), but here it acts as a way to call
another constructor. Again, don’t worry if this is still a bit overwhelming, as the this keyword will
be revisited later. In fact, for now, I will avoid defining multiple constructors until you are ready to
move a step further, so that you will not run into the intricacies relating to defining more than one
constructor. So for now, just keep in mind that it is possible to create multiple constructors within a
class.

NOTE When you think about the concept of constructors—or if you're com-
ing from other programming languages such as C++—you might wonder if the
counterpart of destructors also exists. In Java, it does not, as the JVM itself will
keep an eye out for objects that are no longer accessible and should thus be
removed automatically. Consider for example:

Book myBook = new Book ("My first book") ;
myBook = new Book ("My second book") ;
myBook = null;

What happens with the "My first book" object stored in the myBook vari-
able once you assign the second book (a new object) to this variable? Since

continues
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continued

you have no way to refer to this object anymore (which is now floating around
nameless somewhere in the computer memory), the JVM will automatically
clean up this piece of memory (this is performed by a mechanism called gar-
bage collection) to remove (destroy) the object. The same happens when
assigning null to the variable with the second object. The variable now refers
to nothing, and the second object can also no longer be referenced, and is
thus removed as well.

Whenever the JVM cleans up objects in this manner, it will call a special built-in
method, finalize (), on them. Programmers can implement their own final-
ization method if they desire, which comes in handy when objects are utiliz-
ing resources that need to be cleanly closed when they are removed (think,

for example, about open network connections). In practice, however, there is
rarely a need to override the default behavior.

Again, you need to learn how to walk before you can run, so for now, just be
glad about the fact that Java takes care of these cleanup aspects for you. You
do not need to concern yourself with writing destructors.

The Main Method

Earlier in this chapter, you learned that there exists one special method used as an entry point to
actually execute (run) your program—the so-called main method.

The main method can be defined in any class, but is always defined as:

public static void main(String[] args) ({
}

Meaning that the main method:

> Is publicly accessible. (public is an access modifier. I have ignored access modifiers for now,
but for the main method, you have to define it.)

> Isastatic class method, as no objects exist yet when a program is started.
Returns nothing (void).
> Takes one argument, the arguments passed to the program.
Let’s have a closer look at the main method. Suppose you once more define a simple Book class to

look as follows:

class Book {
final String title;
final int releaseYear;
int copiesSold;
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Book (String t, int r)
title = t;
releaseYear = r;

}

void sell (int nrCopies) {
copiesSold += nrCopies;
}

int nrCopiesSold()
return copiesSold;
}

If you now want to create an actual program that can be executed, the simplest way to do so is by
creating a main method within this class, like so:

class Book {
final String title;
final int releaseYear;
int copiesSold;

Book (String t, int r)
title = t;
releaseYear = r;

}

void sell (int nrCopies) {
copiesSold += nrCopies;
}

int nrCopiesSold()
return copiesSold;
}

public static void main(String[] args)
Book firstBook = new Book ("First Book", 2004);
Book secondBook = new Book ("Another Book", 2014);
firstBook.sell (200) ;
System.out.println ("Number of copies sold of first book is now: "
+firstBook) ;
System.out.println("Title of the second book is: "+secondBook.title);

}

In general, however, it is not good practice to mix a main method with a class definition relating to
a real-world concept. As such, it is better to create a separate “controller” class to separate program
logic from class concepts, like so:

// File Book.java:

class Book {
final String title;
final int releaseYear;
int copiesSold;
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Book (String t, int r)
title = t;
releaseYear = r;

}

void sell (int nrCopies) {
copiesSold += nrCopies;
}

int nrCopiesSold() {
return copiesSold;
}

}

// File Program.java:
class Program {
public static void main(String[] args)
Book firstBook = new Book ("First Book", 2004) ;
Book secondBook = new Book ("Another Book", 2014) ;
firstBook.sell (200) ;
System.out.println("Number of copies sold of first book is now: "
+firstBook) ;

System.out.println("Title of the second book is: "+secondBook.title);

}

Some developers like to supply main methods in their class definitions in larger programs as a quick
way to test if the class is working correctly, without having to run the complete program and go
through a series of steps. This is fine, so long as you keep these “test” mains small and short, for
testing purposes only, and remember that there exist better ways to perform thorough code tests.
This remark does illustrate another aspect, though, namely the fact that a Java project can contain
multiple main methods. In fact, it’s possible to provide a main method in every class you define. So
how does Eclipse or Java know how to execute which one? To figure this out, you’ll return to the
very first example context you saw at the beginning of this chapter: the course administration pro-
gram. The following Try It Out will guide you from beginning to end to re-create the course admin-
istration example, using all of the knowledge you’ve gained so far.

;32 b @llh Course and Student Administration Revisited

Let’s revisit the course and student administration example you saw earlier, now applying all of the
knowledge you’ve gained so far.

1. It’s best to create a new project in Eclipse. Remember you can do so by navigating to File > New
and then selecting Java Project in Eclipse. A dialog window will open asking you to fill in a project
name, such as CourseAdministrationDoneWell. You can then press Finish to create the project.

2. Create the course.java class by right-clicking the src folder in the package explorer in Eclipse
and then selecting New » Class. Define this class as follows:

import java.util.HashSet;

class Course {
static int nextId = 0;
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final int id;

final String name;

final HashSet<Student> registeredStudents =
new HashSet<Student> () ;

Course (String n)
id = nextId;
nextId++;

name = n;

}

String getName ()
return name;

void registerStudent (Student s) {
registeredStudents.add(s) ;
}

void unregisterStudent (Student s) {
registeredStudents.remove (s) ;
}

HashSet<Student> registeredStudents ()
return registeredStudents;

int nrOfRegisteredStudents () {
return registeredStudents.size();
}

3. Similarly, create a student class with the following content:

class Student {
static int nextId = 0;

final int id;
final String firstName, lastName;

Student (String fn, String 1ln) {
id = nextId;
nextId++;

firstName = fn;
lastName = 1n;

}

String getFirstName () {
return firstName;

String getLastName () {
return lastName;
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void registerForCourse (Course c)
c.registerStudent (this) ;

void unregisterForCourse (Course c) {
c.unregisterStudent (this) ;

}
4. Create a Progranm class containing the main method:

class Program {
public static void main(String[] args)
p("Welcome to the course administration program") ;

p(uu);

p("Creating two courses...");
Course courseA = new Course("First Course");
Course courseB = new Course ("Second Course") ;

p("- courseA ID is: "+courseA.id);
p("- courseA name is: "+courseA.getName());
p("- courseB ID is: "+courseB.id);
p("- courseB name is: "+courseB.getName()) ;
p(

p("Creating two students...");
Student studentl = new Student ("Alice", "The Student");
Student student2 = new Student ("Bob", "McStudent") ;

p("- studentl ID is: "+studentl.id);

p("- studentl name is: "+studentl.getFirstName ()+", "+
studentl.getLastName () ) ;

p("- student2 ID is: "+student2.id);

p("- studentl name is: "+student2.getFirstName ()+", "+

student2.getLastName () ) ;
p("ll)’.

p("Registering for courses...");
studentl.registerForCourse (coursel) ;
studentl.registerForCourse (courseB) ;
courseA.registerStudent (student2) ;

p("- courseA number of students: "+courseA.nrOfRegisteredStudents());
p("- courseB number of students: "+courseB.nrOfRegisteredStudents());

}

static void p(String 1) {
System.out.println(l) ;
}

}

5. To run this program from Eclipse, make sure the Program class is open and the main method is
active (by putting your cursor inside the method body), and then press the Run button. Eclipse will
show you the name of the class that contains the main method that will be run.
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How It Works

Now take a look at how it works.
1. You’re creating two new Student and Course classes in a new Eclipse project.

2.  For the course class, note the use of the nextId variable to automatically use an incrementing coun-
ter to provide IDs for courses. This is a well-known pattern that you will see show up commonly in
Java code. Also note the use of the HashSet object. A HashSet is a set, storing a bunch of objects
(student objects, in this case). The Hashset class is built-in by default in Java, but to enable its use,
you first have to import it, hence the import statement before defining the class itself. Don’t concern
yourself too much with its usage for now, but make sure you understand the registerstudent and
unregisterStudent methods, which add and remove students to and from the set.

3. For the student class, you’re using the keyword this to pass the current student object (meaning
the object the method was called on) to the course object to register or unregister a student, as it is
the course object that keeps a list of registered students.

4. The progranm class contains the main method, and it creates two courses, gives some information
about them, creates two students, and registers them in the courses. The p method just serves as a
shorthand to avoid having to write System.out .println all the time.

5. You then run this program from Eclipse by invoking the main method in the Program class. Note
that it is possible at this point to create another class containing a main method and run that one in
Eclipse by just making sure the main method you want to run is open in the code editor.

ACCESS MODIFIERS

You might have noticed that this code uses coursea. id (directly accessing a vari-
able) and coursea.getName () (accessing a variable through a method) in the Try
It Out. In other examples, you read that it’s generally better to access variables
through methods whenever possible instead of directly accessing variables.

If it is generally recommended to go through methods, then why does Java allow
you to access courseA. id directly? The reason for this is due to the access modifier
being used. Classes, variables, and methods can all take access modifiers. In Java,
four access modifiers exist:

public: For classes, methods, and member variables (class or instance)
protected: Methods and member variables (class or instance) (not for classes)
no modifier: For classes, methods, and member variables (class or instance)
private: Methods and member variables (class or instance) (not for classes)

You have seen one of these (public) already, namely in the main method, where the
inclusion of this access modifier was mandatory:

public static void main(String[] args)

continues
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continued

For all the other classes, methods, and variables you’ve seen so far, however, I've
avoided talking about access modifiers and just supplied no modifier. So what do
these modifiers actually do? You will read an in-depth discussion about them in
Chapter 8, but for now, just be aware that access-level modifiers determine which
other classes can use the class, method, or variable the modifier relates to. When no
modifier is supplied, as with these examples, Java will make the class, method, or
variable accessible to the class itself (luckily, this should always be the case, other-
wise the method or variable would not be of much use), and also to classes living in
the same package. So far, you have not dealt with packages, so that each class you
created in Eclipse lives in the so-called “default package,” and each class can access
the variables from another class.

This default behavior goes against the encapsulation ideology of object-oriented
programming, and it is a little bit of a pity that this is chosen as the default behav-
ior in Java. For now, you can afford to be a little sloppy, but you will notice that
you start to encapsulate more and more data by wrapping methods around them
when you define classes, until you arrive at Chapter 7, where you will be introduced
to access modifiers for real—as to prevent direct variable access. One question you
might have at this point is whether it ever makes sense to make a member variable
directly accessible (by supplying no modifier or by making it public). The answer
is very rarely. In most cases, it pays off to keep data hidden within the object and
use methods as guards around it. Only for very simple “data structure” classes
(such as a Point class with x and y variables) is it okay to allow direct access.

The previous Try It Out mentioned that it is possible to add more than one main method to your
Java projects (although they should be contained in different classes, of course). You might be
wondering how Java decides which main method to run when running your programs directly
(without going through Eclipse). The answer is that Java will either rely on a special description
file, or on the users passing the class name they want to run the main method from explicitly.

If you’re interested in knowing more, you can explore the following Try It Out. The Try It Out
will also show you how to utilize the main method’s single string[] argument, which we’ve
ignored so far.

Working with Program Arguments

This exercise demonstrates how to use program arguments.

1. Create a new Eclipse project and add a single Program class with the following main method:

class Program {
public static void main(String[] args)
p("You have supplied "+args.length+" arguments...");
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for (int i = 0; i < args.length; i++) {
p ("Argument "+i+" equals: "+args[i]);
}

p(nn);
}

static void p(String 1) {
System.out.println(l);
}

When running this code from Eclipse, you will notice that the args variable is empty (the array has
a length of zero).

You’re going to create a so-called “runnable JAR” file. JAR stands for Java ARchive, which is
basically the same as a compressed folder (a ZIP file) containing compiled classes. A runnable
JAR file is a JAR file that can be executed. To execute it, right-click your project folder in Eclipse
and choose Export. Next, navigate to Java and select Runnable JAR File. A wizard will pop up
asking you to select a launch configuration and an export destination. In the launch configura-
tion, you can select the class Java should use to run the main method. In this case, select Program
- YOURPROJECT (of course, YOURPROJECT represents the name you’ve chosen). If this option does
not appear in the drop down, you might have forgotten to run the main method in Eclipse first
(see Step 2). As the export destination, you will create a JAR file somewhere in the desktop ( c:\
Users\USERNAME\Desktop\YOURPROJECT . jar, replacing USERNAME with your actual username).

Press Finish to create the runnable JAR, which should then appear on your desktop. Normally, it is
possible to just double-click this file to run it (like with normal programs), but since you have not
created a GUI application, you need to run this JAR from the command line. Open a command
window (run cmd.exe in Windows) and execute the following:

cd "C:\Users\USERNAME\Desktop\"
java -jar courseadministration.jar

You should get back the same output as the Eclipse console gave you earlier. Now let’s take a look
at the args variable. Keeping the command-line window open, execute the following:

java -jar courseadministration.jar Argumentl Argument 2 Argument-3 Argument 4

Take note of the output now. The program will report that you have supplied five arguments:
Argumentl,Argument_2,Argument—3,Argument,andAL'ThﬁinnnedkneblﬂKNNSyOuthatargu-
ments are just strings (hence the string array) coming from what you pass in the program call
(split based on spaces,  ©). What if you want to include a space in your argument? Then you just
enclose your arguments in double quotes, like so:

java -jar courseadministration.jar "first argument" "second argument"

The final question that remains is how Java knows which main method to run in a given JAR file.
This information is stored in a special META- INF folder inside the JAR file. This folder contains a
MANTFEST . MF file, which will in this case contain the following information (you can hunt down
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this file yourself by opening YOURPROJECT . jar in an archive manager, such as WinZIP, WinRAR,
or 7-Zip, but this is by no means required):
Manifest-Version: 1.0

Class-Path:
Main-Class: Program

Finally, if you want to run a main method from a JAR file not containing a MANIFEST . MF file (not
exported as a runnable JAR file in Eclipse) or want to run another main method, you can do so by
executing the following command:

java -classpath courseadministration.jar Program

How It Works

Now take a look at how it works.

1.

2.

When running programs from Eclipse, the args variable will be empty by default. It is also possible
to supply arguments to programs from Eclipse, but this is a bit involved and generally not required.

In the next steps, you create the runnable JAR. Eclipse will compile your classes, compress them,
and store them in the JAR file together with a MANTFEST . MF file.

Next, you run the program from the command line:

cd "C:\Users\USERNAME\Desktop\"
java -jar courseadministration.jar

You should get back the same output as the Eclipse console gave you earlier. The first command
(cd) navigates to the desktop directory where you saved your JAR. The second command (java)
calls Java and tells it to execute your JAR in the command line. JAR files can be distributed to
others and run on all platforms where a Java Runtime Environment (JRE) is available.

The next command does the same, but passes in some arguments from the command line to the
program:

java -jar courseadministration.jar Argumentl Argument 2 Argument-3 Argument 4

Why are arguments useful? In most cases—especially for command-line programs—they sup-

ply configuration parameters to the program at hand, for example, an argument can indicate the
filename that should be read in by a program, or an argument can specify an image-conversion
program indicating the desired quality of the resulting image, and so on. In most cases, however,
you will not need to use program arguments in day-to-day programming, as it is oftentimes easier
(and cleaner) to either let your program read in a configuration file (you will see how to deal with

file input and output in a later chapter) or create a GUI to provide configuration options to users
(GUIs will be dealt with later as well).

The next steps show how Java determines which main method to run from a JAR file, either by
using a MANTFEST. MF file (created by Eclipse), or by passing this manually:

java -classpath courseadministration.jar Program

This command will add your JAR file to the Java classpath (the locations in which Java will look
to find classes) and then supplies the class name (Program) from which to run the main method.
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Method Argument Passing

There is one final point I want to make in regard to the way parameter variables are passed to meth-
ods. Argument passing can be daunting and tricky in Java at first sight, so I’ve devoted a section to
this concept to get the point across.

To start the discussion, consider the following code:

class Test {
int a = 4;

static void increaselnt (int anInt) {
anInt++;

public static void main(Stringl[] args) {
Test t = new Test () ;
System.out.println("Instance var a is: "+t.a);
Test.increaseInt (t.a);
System.out.println("Instance var a is now: "+t.a);

What will this code output?

Instance var a is: 4
Instance var a is now: 4

Even though you have supplied the instance variable to the method, after the method finishes, the
value of this variable remains unchanged. This might lead you to believe that the anInt variable will
be considered as a copy of t.a. In programming jargon, this behavior is called “pass by value.”

This is easy enough to understand until you try the same trick with a non-primitive data type, such
as arrays:

class Test
int[] array = new int[]{1,2,3};

static void increaseFirstInt (int[] anIntArray) {
anIntArray [0] ++;

public static void main(String[] args)
Test t = new Test();
System.out.println("First element in array is: "+t.arrayl[0]);
Test.increaseFirstInt (t.array) ;
System.out.println("First element in array is now: "+t.array[0]);

The output given now? Completely different:

First element in array is: 1
First element in array is now: 2
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Is Java going haywire? Not really. . . Some sources might explain this behavior by telling you
that primitive types in Java are passed by value (as seen before), but all other types are passed
by reference, meaning that the argument variable will refer to the same location in memory as
the original variable, and thus, any changes you make in the argument variable will be reflected
in the original variable (as they both reference the same location). This explanation, however, is
wrong.

To see why, consider the following slight modification of this example:

class Test {
int[] array = new int[]{1,2,3};

static void increaseFirstInt (int[] anIntArray) {
anIntArray [0] ++;

static void changeIntArray(int[] anIntArray) {
anIntArray = new int[] {100,200,300};
}

public static void main(String[] args)
Test t = new Test();
System.out.println("First element in array is: "+t.arrayl[0]);
Test.increaseFirstInt (t.array) ;
System.out.println("First element in array is now: "+t.array[0]);
Test.changeIntArray (t.array) ;
System.out.println("First element in array is now: "+t.array[0]);

The output is probably different than what you would expect:

First element in array is: 1
First element in array is now: 2
First element in array is now: 2

If Java indeed passes non-primitive types by reference, the changeIntarray would effectively put a
new integer array in the same memory address the old array was stored in, and the final line of code
would output 100 instead of 2, but this is not what is happening here. The truth is that all argu-
ments in Java are passed by value. The key thing to understand as well, however, is that Java objects
are internally represented as a reference to a location in memory, and this reference is passed as a
value. That is, the memory address of objects is passed by value.

At first sight, it seems like this should make no difference, but it does in fact help to figure out what
is happening in this example. Step through the code line by line. First, you create a new variable,
called t, as such:

Test t = new Test();

Try not to think of this variable as containing all information and behavior stored in the Test
object (this helps you understand the difference between classes and objects, but is not the way

Java uses object variables), but just as a piece of paper holding an address in memory, as shown in
Figure 4-4.
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FIGURE 4-4

Next, you call the following method:

Test.increaseFirstInt (t.array) ;

t.array is also a non-primitive type, so once again, try to imagine this variable as a piece of paper
holding an address. When you write t .array, think of Java first going to the address in memory
written on the piece of paper for t, then retrieving the array variable there, which contains another
address pointing toward the location in memory where the actual data can be found. When you
write t.array [0], you would thus traverse two memory addresses to eventually find the actual inte-
ger data. Figure 4-5 shows a simplified view of the basic idea.

Testt int[] t.array
t.array[0]
23 24 ’ 25 26 27
t object array var/ array[0] array[1] array[2]

(general info, such = =1 ) =3

as length of 000025
following variable

addresses)

FIGURE 4-5

The address written on the t .array piece of paper is passed to the increaseFirstInt method by value
(1). This means that you do not pass the piece of paper itself, but instead take another sheet of paper,
write down the same address, and use that piece within the method (a copy of the address is made).
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However, when this method executes the following:

anIntArray[0] ++;

It will, of course, point to the same address in memory, as you have created a copy of the piece of
paper, but both contain the same address. This is why the changes are reflected in the member vari-
able, even though your second piece of paper (anIntArray) is thrown away once the method exits.
Figure 4-6 depicts this in the simplified view you’ve been following.

Test t int[] t.array anintArray

(A copy is made to pass
as method argument, but
contains same memory
address reference.)

23 24 25 26 27 28

t object array var array[0] array[1] array[2] | anintArray var
(general info, such = =1 =2 =3 = 000025
as length of 000025
following variable
addresses)

FIGURE 4-6

Now let’s take a look at what happens next:

Test.changeIntArray(t.array) ;

Again, there is the same reasoning. You do not pass the t.array piece of paper itself, but again
make a copy to pass to the changeIntArray method, which is named anIntarray. However, this
method calls:

anIntArray = new int[] {100,200,300};

Meaning that you create a new object and scribble down its address on the copied anIntArray
sheet of paper, overriding the old one, which is different from the one written in t .array. This
means that all the changes you then make to anIntArray will not be reflected in the member vari-
able (as the addresses differ). Even more, the object stored in the location referred to by anIntar-
ray will cease to exist when the method exits, as the piece of paper is discarded, and Java will
detect that the object living at that address can no longer be accessed through any variable, as
shown in Figure 4-7.
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Test t int[] t.array anintArray = new
int[] {100,200,300}
(Memory address
reference is overwritten.)
23 24 25 26 27 28 29 30 31
t object array var array[0] array[1] array[2] anintArr anintArr [ anintArray | anintArray
(general info, such = =1l =2 =3 ay var = ay[0] = ay[1] = ay[2] =
as length of 000025 000029 100 200 300
following variable
addresses)
FIGURE 4-7

NOTE Again, it's important to take special care when dealing with Strings.
Strings are a non-primitive type, meaning that you might try to write the fol-
lowing code:

class Test
String a = "a";

static void changeString(String s) {
s = "b" ;
}

public static void main(String[] args)
Test t = new Test();
System.out.println("a is: "+t.a);
Test.changeString(t.a) ;
System.out.println("a is now: "+t.a);

}

But see that the changes you make to the String are not reflected in the mem-
ber variable. The reason for this is simple. Remember that assigning (new) val-
ues to a String will always create a new string object. This code is thus equal
to writing:

class Test
String a = new String("a");

continues
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continued

static void changeString(String s) {
s = new String("b");
}

public static void main(String[] args)
Test t = new Test();
System.out.println("a is: "+t.a);
Test.changeString(t.a) ;
System.out.println("a is now: "+t.a);

}

As such, modifying the argument variable s will cause a new string object to
be created, which will also cause the address referenced to by that variable to
change, and be different from the original address in t . a.

One interesting remark to make in this context is about final variables. As you have seen, instance
variables and local variables can be declared as being final to prevent multiple initializations.
Parameter variables can also be final, meaning that it’s possible to write a method like so:

class Test {
void editNames (final String[] argNames) {
// Will not work due to final modifier:
// argNames = new Stringl[]{"Caesar"};

// This will work:
argNames [0] = "Caesar";

This completely corresponds with the definition of final variables as explained before, keeping in
mind that finalizing a variable is not the same as “freezing” it completely, but it does prevent new
initializations. However, since argNames will be discarded once the method is exited, why would
you even bother to declare a parameter variable as final? One particularly straightforward reason
is to prevent you from accidentally re-initializing the variable, to prevent you from overwriting the
address stored on a variable’s piece of paper with a new one. When you actually want methods to
directly modify an object, you in fact want to avoid creating a new object, as the address referenced
by the argument will then change and be discarded once you exit the method. Using final helps
prevent such mistakes.

This concludes the overview on beginning object-oriented programming in Java. You have covered
a lot of ground. You have seen how to define classes, with data being represented by instance and
class variables—final or not—and behavior being represented by instance and class methods. You
have also seen how to define class constructors, and read about the special main method to execute
your programs.
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The complete class definition “template” now looks like this:

class CLASSNAME {

//
//
//
//

//
//
//

//

FINAL CLASS VARIABLE DEFINITIONS
CLASS VARIABLE DEFINITIONS

FINAL INSTANCE VARIABLE DEFINITIONS
INSTANCE VARIABLE DEFINITIONS

CONSTRUCTOR METHOD DEFINITIONS
INSTANCE METHOD DEFINITIONS
CLASS METHOD DEFINITIONS

MAIN METHOD DEFINITION (OPTIONAL)

The final section of this chapter guides you through Java’s standard edition built-in classes and high-
lights some particularly useful ones that will return in many of the following chapters.

JAVA SE BUILT-IN CLASSES

Recall from the introduction to Java in Chapter 2 that there are multiple “editions” of Java. The most
widely used edition—the one used here as well—is aptly named Java SE, Standard Edition. This edi-
tion comes with class libraries containing a number of built-in classes that meet most of your needs
you will encounter while programming. One of them—the Hashset—was already briefly discussed in
the last Try It Out, as a simple way to keep a set of objects. This class is part of the so-called “collec-
tions” class library, which contains a number of other helpful “array alternatives” as well.

The following subsections provide a short tour through all of Java SE’s frequently used built-in
classes. I’ve organized them by their packages. I still need to discuss packages in-depth, but for now,
just think of them as a way to organize classes using a naming scheme that looks a bit like web
URLs. For example, both the Java Hashset and ArrayList classes are found in the package java.
util. Their full canonical names are java.util.HashSet and java.util.ArrayList, which is all
you need to know for now.

Classes in the java.lang Package

The java.lang package contains core classes related to the Java language, including:

>  java.lang.Object: Every class you define silently inherits all the behavior defined in this class.
This class contains methods such as equals (to perform object equality checks), clone (to make
a copy of an object), and tostring (to retrieve a textual representation of an object), which can
be overridden and customized by programmers. Chapter 8 will tell you more about this.

>  java.lang.Exception and all its subclasses: Classes representing errors. Chapter 6 talks
more about exceptions, errors, debugging, and testing.

>  java.lang.String, as well as wrapper classes for all primitive types (java.lang.Integer,

java.lang.Double, and so on).

>  java.lang.StringBuilder: An alternative class for dealing with strings that’s especially
helpful if you need to perform a lot of modifications to a String.


http:///

116

| CHAPTER4 MOVING TOWARD OBJECT-ORIENTED PROGRAMMING

>  java.lang.System: Class providing system operations.

>  java.lang.Math: Class providing methods to perform basic mathematics.

Other than this, this package also provides a number of classes to deal with complex Java aspects
such as reference management, reflection, and process spawning and control. All advanced concepts
which you can safely ignore for now.

The two classes that jump out, however, and that can be very useful are the Math and
StringBuilder classes.

Math contains two static constants (E, the base of natural logarithms, and p1, the ratio of the cir-
cumference of a circle to its diameter), as well as a number of methods—abs, max, min, ceil, floor,
sin, cos, tan, pow, and sqrt—to help out with mathematics when programming.

A2 hr etk Mathematics in Java

Here is a short exercise to begin using mathematics in Java.

1. Create a MathTester class in Eclipse with the following content:
class MathTester {
public static void main(String[] args)
double numl = 2.34;
double num2 = 1.56;
System.out.println(Math.max (numl, num2)) ;
System.out.println(Math.min (numl, num2));
System.out.println(Math.sqgrt (numl)) ;
System.out.println(Math.pow(numl, num2)) ;
}
}
2. Run the main method and observe the output.
How It Works
Now take a look at how it works.
1. The Math class contains a number of methods to help out with mathematics when programming.
Take your time to explore other methods using Eclipse’s context menu.
2.  Since the Math class belongs to the java.lang package, you do not need to write an import state-
ment but can use this class directly.
3. All of Math’s methods are static, meaning that you do not have to create a Math object to be able

to use its methods. This is a common pattern for “utility” classes in Java, which are classes con-
taining a set of helpful grouped methods that can be statically accessed.

The stringBuilder class represents a mutable sequence of characters, compared to a normal String that
represents an immutable sequence of characters (which is why Java creates a new string object every
time you modify a String). The following Try It Out shows where the stringBuilder can be useful.
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A4 iRelihe  StringBuilder versus String

Different classes can be used for working with strings. This exercise will help you differentiate two
common classes: String and StringBuilder.

1. Create a stringTester class in Eclipse with the following content:

class StringTester {
public static void main(String[] args) ({
String string = "";
long startTimel = System.currentTimeMillis();
for (int 1 = 0; i < 100000; i++) {
string += "a";
}

long endTimel = System.currentTimeMilli